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Warranty
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year from the date of shipment. If any such product proves defective during this warranty period, Tektronix, at its
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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

To Avoid Fire or Personal
Injury

Use Proper Power Cord. Use only the power cord specified for this product and
certified for the country of use.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

The inputs are not rated for connection to mains or Category II, III, or IV circuits.

Power Disconnect. The power switch disconnects the product from the power
source. See instructions for the location. Do not block the power switch; it must
remain accessible to the user at all times.

Power Disconnect. The power cord disconnects the product from the power source.
Do not block the power cord; it must remain accessible to the user at all times.

Do Not Operate Without Covers. Do not operate this product with covers or panels
removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this
product, have it inspected by qualified service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components
when power is present.

Use Proper Fuse. Use only the fuse type and rating specified for this product.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual’s installation instructions for
details on installing the product so it has proper ventilation.

Terms in this Manual These terms may appear in this manual:
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General Safety Summary

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.

DANGER indicates an injury hazard immediately accessible as you read
the marking.

WARNING indicates an injury hazard not immediately accessible as you
read the marking.

CAUTION indicates a hazard to property including the product.
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Preface

Preface
This manual contains the following sections:

Introduction briefly describes the generator and provides installation
instructions, option and accessory lists, repacking instructions, and power on
and off instructions.

Programming Information presents descriptions of all programming
commands and the syntax used in command descriptions. This section also
provides instructions for setting the network parameters for the Ethernet port.

Appendices provide product specifications, instructions for operating the
ReMux and Scheduler applications, defragging the hard disk, recovering the
system, and inspecting and cleaning the generator.

Related Documentation
The following related documentation for the instrument is available:

Item Purpose Location
RTX100B Series RF Signal Generators
Specifications and Performance Verification
Technical Reference Manual (077-0193-xx)

Provides complete product
specifications and a procedure
for verifying the operation of the
instrument.

RTX100B Series RF Signal Generators
Quick Start User Manual (071-2595-XX
English, 071-2596-xx Japanese)

Provides installation and high-level
operational overviews.

RTX100B Series RF Signal Generators
Technical Reference (077-0192-xx)

Provides in-depth operating
information.

RTX100B Series RF Signal Generators
Service Manual (077-0194-xx)

Optional manual supporting
module-level servicing of the
instrument.

MTX/RTX Release Notes (077-0195-xx)
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Terms Used in This Manual
This manual uses the following terms:

Stream: Generic term for transport streams and data streams of Non-TS
format (data format other than transport stream format).

S-TMCC (Single TMCC): Transport stream to which TMCC (Transmission
and Multiplexing Configuration Control) information is inserted into the 8
bytes in its Reed-Solomon code area (16 bytes). It is defined in the ISDB-S
(Integrated Services Digital Broadcasting-Satellite) system.

M-TMCC (Multi TMCC): Transport stream to which TMCC information
is inserted into the sync byte area, and having super frame structure. It is
defined in the ISDB-S system.

RTX130B (QAM & VSB RF Signal Generator) Generator references in
the document refer to the information that is specific to the RTX130B module.

RTX100B (ISDB-T RF Signal Generator) Generator references in the
document refer to the information that is specific to the RTX100B module.
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Introduction
The RTX130B QAM & VSB RF Signal Generator generates QAM and 8VSB
modulated signals that are compliant with the DVB-C/ITU-T J.83 Annex A/B/C
and ATSC standards. In addition to the RF signal output feature, the generator
records and plays MPEG-2 transport streams that are compliant with ATSC,
DVB, and ARIB standards.

The RTX100B ISDB-T RF Signal Generator converts a broadcast transport stream
into an RF signal and outputs it. In addition to the RF signal output feature, the
generator records and plays MPEG-2 transport streams that are compliant with
ATSC, DVB, and ARIB standards.

Common Features for Both
the RTX100B Generator

and the RTX130B
Generator

Hierarchy display of stored or captured transport streams

188, 204, 208 bytes packet size, S-TMCC, M-TMCC, nontransport stream,
and partial transport stream output formats

Real-time updating of stream parameters; continuity_counter, PCR/PTS/DTS,
TOT/TDT/STT, NPT, and Reed Solomon (ISDB-T only)

Continuous recording of captured streams

PCR jitter insertion

Triggered stream capture

Full remote control using Ethernet interface

Scheduler application for automated stream playout and record (Option SC
only)

IP, ASI, universal parallel/serial, IEEE1394/ASI, and SMPTE310M/ASI/SPI
interfaces available

Playout on one interface at a time, either IP or other interfaces

Two IP versions namely IPv4 and IPv6 are supported

Stream replication (IP) with some attributes of the stream incremented by a
certain value

Specific Features for
RTX100B Generator

RF modulated output of broadcast transport streams

UHF: 13 channel to 62 channel (473 MHz to 767 MHz)

Direct RF output of ASI input signals
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Specific Features for
RTX130B Generator

16/64/256QAM and 8VSB modulation formats

Modulation frequency range: 50 MHz to 860 MHz

44 MHz or 36 MHz IF output

Support the following standards:

DVB-C/ITU-T J.83 Annex A (Option M1)

ITU-T J.83 Annex B (Option M2)

ITU-T J.83 Annex C (Option M3)

ATSC (Option M4)

Windows Operations
All the functions of the generator are performed as an application on the Windows
XP operating system. If you connect the keyboard and the mouse provided with
the instrument to the front-panel USB connectors, you can operate the generator
with the same environment as a Windows PC.

Operation on the
Play/Record Screen

When you have connected a keyboard and a mouse to the instrument, you can use
them to make menu selections and parameter settings in the Play/Record screen.
These operations behave in the same manner as the other Windows applications.

Displaying the Windows
Screen (Desktop)

To display the Windows screen (Desktop), select Minimize or Exit from the
File menu in the Play screen or Record screen. When you click Minimize, the
generator window minimizes and the Windows XP desktop appears. When you
click Exit, the generator application exits and the Windows XP desktop appears.

File Operation There are no menu commands to manage file operations in the generator
application. Perform file operations such as copy, delete, or upload/download
on Windows. Refer to Windows XP Online Help or other documentation about
file operations.

The generator application is placed in the C:\ProgramFiles\Tektronix\Mpeg Player
folder. The sample transport stream files are placed on the D: drive (Volume D).

System Settings This manual describes only the settings for connecting to an Ethernet network.
Refer to the Windows XP Online Help or other documentation for information
about other system settings.
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Reference
The Reference section is divided into subsections that give you information on
how to use the menus, add jitters to PCRs, use the continuous recording feature,
and use the Preset File.

Using the Menus
This subsection describes the function of each selection that is available in the
menus. This section is divided into the following subsections:

Menus in the Play Screen describes all the menu commands and their features
available in the Play screen.

Menus in the Record Screen describes all the menu commands and their
features available in the Record screen.

Toolbar Buttons describes the toolbar buttons and their functions.

Refer to the RTX100B Series RF Signal Generator Quick Start User Manual for
information on how to operate the menus.

Menus in the Play Screen This subsection describes the menus available in the Play screen.

File Menu. The File menu in the Play screen contains commands for selecting
a stream file and for loading and saving a preset file. This menu also contains
commands to exit the generator application and the instrument. (See Table 1.)

Table 1: File menu commands (Play screen)
Command Description
Open Opens a stream file. When a file is selected, the generator

checks the packet size of the file. For a transport stream
file, the data is output in packets. If an incomplete packet is
included at the start or end of the file, that portion of the file is
not output. The available minimum data size is 104 KB.
When you select this command, the Select File dialog box
appears.
(See Figure 1.)

Load Preset Loads the specified preset file (*.set). When a preset file is
loaded, the current instrument settings are replaced by the
settings in the preset file.

Save Preset Saves the current instrument settings as a preset file.
RECORD Switches to the Record screen. The Record screen is

disabled for the IP interface.
Scheduler Starts the Scheduler application when the Option SC is

installed.
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Table 1: File menu commands (Play screen) (cont.)

Command Description
Minimize Minimizes the generator application window.
Exit Exits the generator application. The generator application

settings are saved.
Shutdown Exits the generator application and shuts down the generator

Series.

Select File Dialog Box. When you select the Open command from the File menu,
the Select File dialog box appears. (See Figure 1.)

Figure 1: Select File dialog box

You can perform the following functions in Select File dialog box:

Press the arrow buttons to select the desired file, and press the Enter button to
load the selected file.

Select Up One Level to move from the current directory to a directory one
level higher.

Click the “...” button at the upper right of the dialog box to select a file that
is not listed.

4 RTX100B Series RF Signal Generators



Reference

View Menu The View menu contains commands that control the display of the Toolbar and
the Status bar. (See Table 2.)

Table 2: View menu commands
Command Description
Toolbar Toggles the display of the Toolbar on and off

in the Play screen. A check mark precedes
the command in the menu when the Toolbar
is selected for display.

Status Bar Toggles the display of the Status bar on
and off in the Play screen. A check mark
precedes the command in the menu when
the Status bar is selected for display.

Play Menu The Play menu contains commands for defining output parameters such as packet
size, output clock rate, or output source. (See Table 3.)

Table 3: Play menu commands
Command Description
Interface Sets the interface to transmit and receive

Ethernet packets. You can select either IP or
QAM/VSB/DMB-T/ or ISDB-T/ISDTV/ASI

Packet Size Sets the packet size (in bytes) for the stream.
You can set the packet size to 188 (188 +
0), 204 (188 + 16), 208 (188 + 20) bytes, or
Non-TS.
These packet sizes can only be set for an
MPEG-2 transport stream. For an S-TMCC
or an M-TMCC transport stream, the packet
size is fixed to 204. For a Non-TS stream, the
packet size is fixed to Non-TS. In addition, if
you select 8VSB for an output signal format
in Option 07, the packet size is fixed to 188.
When you select Non-TS, the generator
deals with stream data in a byte unit (not a
packet unit) and outputs all of the data in a
file. If a transport stream contains any error,
you can output it by selecting Non-TS.

Clock Opens the Clock dialog box where you can
set the clock rate of the stream output. (See
Figure 2.)
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Table 3: Play menu commands (cont.)

Command Description
Update Sets whether to update parameters in the

stream when looped. You can select On
or Off. You cannot select On for a Non-TS
stream.
You can select which parameters in the
stream are updated using the Others dialog
box. (See Figure 7.)

Sync Sets the format of the PSYNC signal output
from the SPI In/Out connector. You can
select TS Packet, SF, or Non-TS. For TS
Packet, a single pulse signal is output at the
start of each packet. For SF, a single pulse is
output at the start of the SF appearing every
204 X 48 X 8 bytes. For Non-TS, the Set
Non-TS Sync dialog box appears, where you
can enable the PSYNC and DVALID signals.
(See Figure 3.)

PCR Initial Value Opens the PCR Initial Value dialog box
where you can set the initial value of
the program_clock_reference_base and
program_clock_reference_extension
parameters when the transport stream is
output. (See Figure 4.)

Source Selects the source for stream output. You
can select RAM or Disk.

Loop Sets whether the stream output is using
the looping method. You can select On or
Off. If you select On, the selected stream is
continuously output. If you select Off, the
selected stream is output once.

Start/Stop Opens the Start/Stop Position dialog box
where you can set the start and stop
positions of the stream, and initial start
position of the stream for loop output. (See
Figure 5.)

Auto Play Sets whether the transport stream is
automatically output using the last power-off
settings when you turn on the RTX100B
Series. You can select On or Off.
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Table 3: Play menu commands (cont.)

Command Description
Timer Play Opens the Timer Play/Record dialog box

where you can set the date and time used
to output a stream automatically. (See
Figure 6.)

Other Opens the Other dialog box where you
can set the standard used to display the
selected stream and display radix for the text
information. (See Figure 7.)

Clock Dialog Box. When you select the Clock command from the Play menu, the
Clock dialog box appears. (See Figure 2.)

Figure 2: Clock dialog

Clock Source: Sets the clock that will be used as the reference for the stream
output. You can select from the following settings:

Internal uses the internal clock of the generator as the clock reference.

Ext Ref allows you to input a signal on the Clock/Ref In connector for
use as the clock reference. When you select the button to the right of the
ExtRef box, the following External Reference dialog box appears.

10 MHz selects a 10 MHz signal on the Clock/Ref In connector.

27 MHz selects a 27 MHz signal on the Clock/Ref In connector.

ISDB-T IFFT Clock selects a signal corresponding to the IFFT
sample clock rate (8.126984 MHz) on the Clock/Ref In connector.
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Ext P Clk (external parallel clock) allows you to input a clock signal on
the Clock/Ref In connector for use as the parallel clock.

Ext S Clk (external serial clock) allows you to input a clock signal on the
Clock/Ref In connector for use as the serial clock.

Data Rate: Sets the clock rate for the transport stream output. You can enter
the clock rate using the following methods (the first method provides greater
clock-rate precision):

Enter values into the numerator and denominator text boxes. (See
Figure 2.) The generator will calculate the clock rate based on the ratio of
the numerator and denominator values.

Enter a value into the clock rate text box. The generator will calculate the
numerator and denominator values based on the clock rate.

NOTE. The IP data rate will be automatically calculated based on the available
TS data rate. IP Data Rate is calculated as follows:

IP Data Rate = (TS Data Rate × IP Packet Size) ⁄ Payload Size

When you use the Ext P Clk or Ext S Clk mode, set the clock rate to the same
value as the input clock signal. Also, when you use the Ext S Clk mode, you
cannot set the value more than 32 Mbps.

IP Data Rate: Sets the clock rate for the IP packet. In the IP mode, a change
in the IP data rate will impact the TS data rate and a change in the TS data
rate will impact the IP data rate. The packet length changes according to
the selected protocol.

NOTE. The TS data rate will be automatically calculated based on the available
IP data rate and consequently will influence the PCR/PTS/DTS update cycles.
TS Data Rate is calculated as follows:

TS Data Rate = (IP Data Rate × Payload Size) ⁄ IP Packet Size

When the IP data rate is more than 80 Mbps, a Recommended Settings dialog
box is displayed, asking you to modify the settings for optimal performance.

8 RTX100B Series RF Signal Generators



Reference

Fixed ES Rate: Sets whether the elementary stream rate is fixed. When it
is checked, the elementary stream rate is played at constant rate regardless
of the clock rate setting. If you fix the elementary stream rate, you cannot
set the output clock rate (Data Rate) to less than the data rate set when the
stream file was downloaded.

When Fixed ES Rate is selected, PCR/PTS/DTS Update Method in the Select
Update Item dialog box is set to Hardware automatically. (See page 3, Using
the Menus.)

Table 4: Relationship between Fixed ES Rate Setting and PCR Jitter
Fixed ES Rate: checked Fixed ES Rate: not checked

Update: Hardware PCR jitter meets the standard PCR jitter meets the standard
Update: Software PCR jitter meets the standard,

provided that the original file
does not contain any PCR jitter

Update: Off PCR Jitter occurs PCR, PTS/DTS discontinuity
occurs on loop points
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Default Rate: Displays the default clock rate and packet size, and then
changes the values. When you select this button, the following Default Clock
dialog box appears.

Default Data Rate: Overwrites the scanned bit rate value of the stream
file.

Since the default clock rate is calculated based on the PCRs in the
downloaded stream file, the value can be different from the original clock
rate. When the elementary stream rate is fixed (refer to the Fixed ES Rate
description), the instrument refers to the default clock rate. Therefore, if
the default clock rate is different from the original clock rate, you need
to set it to the appropriate value. If you change the value, the clock rate
value in the Data Rate dialog box is also changed.

Packet Size: Changes the default packet size when the selected stream
file is downloaded. If you change the value, the Packet Size setting in the
Play menu will also change.
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Set Non-TS Sync Dialog Box. When you select Non-TS from the Sync command
in the Play menu, the Set Non-TS Sync dialog box appears. (See Figure 3.)

Figure 3: Set Non-TS Sync dialog box

Psync Enable: Sets the status of the PSYNC signal output from the SPI
In/Out connector.

Interval: Enter the output period of the PSYNC signal in the range of 16 to
255 bytes. A value equal to or greater than the Width value can be entered in
the Interval field.

Dvalid Enable: Sets the status of the DVALID signal output from the SPI
In/Out connector.

Width: Enter the data width of the DVALID signal in the range of 16 to
255 bytes.

PCR Initial Value Dialog Box. When you select the PCR Initial Value command
from the Play menu, the PCR Initial Value dialog box appears. (See Figure 4.)

Figure 4: PCR Initial Value dialog box
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Base Value: Sets the initial value for the program_clock_reference_base
value. You can enter a value from 0 to 8589934591. The bracketed number
represents the number of bits for the program_clock_reference_base field.

Extension Value: Sets the initial value for the program_clock_reference_
extension value. You can enter a value from 0 to 299. The bracketed number
represents the number of bits for the program_clock_reference_extension
field.

Start/Stop Position Dialog Box. When you select the Start/Stop command from
the Play menu, the Start/Stop dialog box appears. (See Figure 5.)

Figure 5: Start/Stop Position dialog box
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Start: Sets the start position of the stream by time (h:m:s) or the number of
packets (the number of super frames for an M-TMCC file, or the number of
bytes for a Non-TS file). Based on the format selected from the Format filed,
you can either enter the value or move the slider to set the position.

Stop: Sets the stop position of the stream by time (h:m:s) or the number of
packets (the number of super frames for an M-TMCC file, or the number of
bytes for a Non-TS file). Based on the format selected from the Format field,
you can either enter the value or move the slider to set the position.

Initial: Sets the initial start position of the stream for loop output. You can
set the value by time (h:m:s) or the number of packets (the number of super
frames for an M-TMCC file, or the number of bytes for a Non-TS file). Based
on the format selected from the Format field, you can either enter the value or
move the slider to set the position.

Play: Shows the actual time or number of packets (the number of super
frames for an M-TMCC file, or the number of bytes for an Non-TS file) that is
calculated by the values of the Start and Stop text boxes.

Format: Specifies the way to set the start, stop, and initial positions of the
stream. For a transport stream file, you can select Time or Packets. For an
M-TMCC file, you can select Time or SF (super frame). For a Non-TS file,
you can select Time or Bytes.

For an ISDB-T file, the start packet is defined as the first-appearing packet
including an OFDM frame start flag after the specified start position. The stop
packet is defined as the packet before the last-appearing packet including an
OFDM frame start flag before the specified stop position. If the number of
OFDM frames between the start packet and stop packet is not an even number,
the packet in the last OFDM frame becomes the stop packet.

To set the start, stop, and initial positions, either use the slider or enter the values
directly in the text boxes. (See Figure 5.)
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Using the slider.

1. For the start and stop positions:

a. Press the Tab button repeatedly to select the slider.

b. Press the left (◄) or right (►) arrow button to move the slider to the place
you want to set the start position.

c. Press the Tab button repeatedly to select the Stop option button, and then
press the Num Pad/Select button. This moves the slider to the right end.

d. Repeat steps aand b to set the value for the Stop option.

e. Press the Enter button to enable the values.

2. For the initial start position for loop output:

a. Press the Tab button repeatedly to select the Initial check box, and then
press the Num Pad/Select button. A red arrow appears on the slider.

b. Press the Tab button repeatedly to select the red arrow.

c. Press the left (◄) or right (►) arrow button to move the slider to the place
you want to set the initial start position.

d. Press the Enter button to enable the value.

Using the text boxes.

1. Press the Tab button repeatedly to select the Start text box. If you set a time,
select one of the text boxes for setting the hour, minute, or second.

2. Press the Num Pad/Select button. The keypad appears.

3. Use the keypad to enter the value.

4. If you set a time, repeat step 1 through step 3 to set the hour, minute, and
second.

5. Use the same procedure given in step 1 through step 4 to set the value
in the Stop text box.

6. Press Enter to enable the values.

To reset all of the settings to the values when the dialog box was first displayed,
press the Tab button repeatedly to select the Reset button, and then press the
Num Pad/Select button.
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Timer Play/Record Dialog Box. When you select the Timer Play command from
the Play menu, the Timer Play/Record dialog box appears. (See Figure 6.)

Figure 6: Timer Play/Record dialog box

Start at: Sets the date and time when the stream output or record starts.

If a mouse is connected to the generator, you can display a calendar for setting
the date by clicking the▼ arrow button to the right of the date display.

When you press the Enter button after setting the date and time, a dialog
box showing the current date and time, and set date and time is displayed.
When the set date and time arrives, the dialog box closes and stream output or
stream record starts automatically.

If you want to cancel the operation, press the Enter, Cancel/Close, or Num
Pad/Select button. When the dialog box that prompts you to confirm that the
operation is displayed, press the Num Pad/Select or Enter button to execute
the operation.

Others Dialog Box. When you select the Other command from the Play menu, the
Others dialog box appears. (See Figure 7.)

Figure 7: Others dialog box
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Standard: Sets the standard used on the hierarchy-display screen. You can
select ARIB, ATSC, DVB, or MPEG-2. For a transport stream (ARIB, ATSC,
DVB, or MPEG-2), the standard is set to the previous setting as a default.
For an S-TMCC, M-TMCC, or ISDB-T transport stream, you need to select
ARIB for proper display.

Numeric: Sets the base value used to describe the component information in
the hierarchy display. You can select Decimal, Hex, or Octal.

Ext Play Start: Sets whether to start stream output using a trigger signal
applied to the Trig In/Out connector. You can select Off, Rise, or Fall. When
you select Rise, the stream output is started at the rising edge of the applied
trigger signal. When you select Fall, the stream output is started at the falling
edge of the applied trigger signal.

SPI Output Enable: Sets whether the signal output from the SPI In/Out
connector is enabled. Use this function to set the SPI In/Out connector to
input only and the Universal In/Out connector to output only when the
universal parallel/serial interface option is installed. If the Source command
in the Record menu is set to STD, the signal output from the SPI In/Out
connector is disabled even if you have enabled the SPI Output Enable.

Ext Trigger BNC: When you select this button, the following Ext Trigger
BNC dialog box appears.

BNC IN/OUT: Sets whether to use the rear-panel Trig In/Out connector
as a trigger signal input or a reference clock/ISDB-T frame clock signal
output. You can select Input or Output. For Input, the Trig In/Out
connector can be used to input an external trigger event. For Output, the
Trig In/Out connector can be used to output a 27 MHz reference clock or
an ISDB-T frame pulse signal. Use the Selection list box to select which
signal is output from the connector.
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BNC OUT property: Selects the output signal from the Trig In/Out
connector when BNC IN/OUT is set to Output. You can select 27 MHz or
ISDB-T Frame Pulse. If you select 27 MHz, a 27 MHz reference clock
signal is output from the Trig In/Out connector. Use this option to check
the clock frequency accuracy. If you select ISDB-T Frame Pulse, an
ISDB-T frame pulse signal is output from the Trig In/Out connector.

ISDB-T Frame Pulse Delay Sets the delay for the start packet pulse of
the ISDB-T frame in 1-parallel clock of the SPI output. You can set the
value from 0 to 15.

TDT/TOT or STT: When you select this button, the following TDT/TOT
dialog box appears. The name changes to the standard that is selected in the
Standard list box: TDT/TOT for ARIB or DVB, and STT for ATSC. Use
this dialog box to change the initial date and time of the TDT (Time and
Data Table), TOT (Time Offset Table), or STT (System Time Table) in the
selected stream.

The button is disabled when MPEG-2 is selected in the Standard list box.

Original: Uses the original (default) value that is already defined in the
selected stream.

OS (Windows XP) Time: Uses the clock/calendar of the operating system
(Windows XP) to set the initial value. When you select this option, the
date and time of all the TDTs, TOTs, or STTs in the selected stream are
locked to the clock/calendar of the operating system.

User Define: Uses a user-defined value to set the initial value. When you
select this option, the list boxes for setting the initial date and time of the
TDT, TOT, or STT are available.
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ISDB/P-TS: When you select this button, the following ISDB/P-TS dialog
box appears.

Data Rate Auto Convert (Play Mode): Determines whether the clock
rate is set automatically when the ISDB-TSB file is loaded. When
selected, the clock rate is automatically set to (2048/1701) x 27 MHz
and the elementary stream rate becomes constant regardless of the Fixed
ES Rate setting.

Loop by ISDB-T Frame (Play Mode): When selected, outputs the
ISDB-T transport stream in OFDM frames when looped. When cleared,
the ISDB-T transport stream is looped in packets.

Treat as Partial TS (Play Mode): When selected, sets the output to a
stream file consisting of a 192-byte packet as a partial transport stream.
When cleared, the stream is output in Non-TS format.

Update: When you click Update, the following Select Update Item dialog
box appears. Use this dialog box to select which parameters in a stream are
updated when looped.

Continuity Counter: When selected, sets whether to update the
continuity_counter.
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PCR/PTS/DTS: Sets whether to update PCR (Program Clock Reference),
PTS (Presentation Time Stamp), and DTS (Decoding Time-Stamp).

Update Method: Specify the method to update PCR/PTS/DTS. The optional
interface supports both Software or Hardware update methods but the IP
interface supports only the software method.

Hardware: PCR/PTS/DTS are updated using the counter values of the
27 MHz clock on the output board. Since data output and PCRs are
completely locked, the continuity of PCRs is maintained at the loop point
even when playing long stream loops. However, timing errors occur in
PTS/DTS.

Software: PCR/PTS/DTS are updated by adding the actual looping time
(defined by the start and stop positions) to the stream every time it is
looped. However, if there are no timing errors in PTS/DTS, it is difficult
to maintain the continuity of PCRs at the loop point because the update
is not synchronized with the 27 MHz clock on the output board. Since
this method is used to update NPT, if you enable the NPT option, the
Software is selected automatically.

TDT/TOT/STT: Sets whether to update TDT (Time & Data Table), TOT
(Time Offset Table), and STT (System Time Table).

The NPT check box is available only when PCR/PTS/DTS is enabled and the
Update Method is set to Software. When selected, PCR/PTS/DTS is enabled
and the Update Method is set to Software. In addition, the Fixed ES Rate
option in the Clock dialog box is disabled.

NPT: Sets whether to update NPT (Normal Play Time; STC_Reference field
in NPT Reference Descripter defined by ISO/IEC 18318-6).

Reed Solomon (ISDB-T only): Sets whether to update Reed-Solomon codes
in an ISDB-T transport stream.

ISDB-T/ISDTV/ASI Menu The ISDB-T/ISDTV/ASI menu contains commands for setting the parameter for
the RF modulated output of a broadcast transport stream and an ASI output format.

Table 5: ISDB-T/ISDTV/ASI menu commands (Play screen)
Command Description
ASI Format Sets the output format of the ASI signal. You can select Byte or

Packet. For Byte, valid data is output using a burst transmission mode.
For Packet, valid data is output in each transport stream packet.

RF Standard Sets the standard for the RF signal. You can select ISDB-T or ISDTV.
RF Parameter Sets the parameter for the RF modulated output of the broadcast

transport stream.

When you select this command, the ISDB-T or ISDTV Parameter
dialog box appears.
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ISDB-T/ISDTV RF Parameter Dialog Box. When you select the RF Parameter
command from the ISDB-T/ISDTV/ASI menu, the RF Parameter dialog box
appears depending on the selected RF standard (ISDB-T or ISDTV).

Center Frequency: Sets the center frequency (UHF channel number) for the
RF modulated output. For ISDB-T standard, the channels range from 13 to 62
and for ISDTV standard the channels range from 14 to 69.

QAM/VSB Menu The QAM/VSB menu contains commands for setting the parameter for the RF
modulated output of a transport stream and an ASI output format.

Table 6: QAM/VSB menu commands (Play screen)
Command Description
BNC Port Sets the signal format output from the ASI/SMPTE Output connector.

You can select ASI or 310M 8VSB (SMPTE310M signal with data
rate of 8 VSB).

Through Out Sets whether the signal supplied to the ASI/SMPTE Input connector is
output from the ASI/SMPTE Output connector when a stream is not
output. You can select On or Off.

ASI Format Sets the output format of the ASI signal. You can select Byte or
Packet. For Byte, valid data is output using a burst transmission mode.
For Packet, valid data is output in each transport stream packet.

RF Output Sets whether to output an RF signal from the RF Output connector.
You can select On or Off. When you select On, the outputs from the
ASI/SMPTE Output and SPI In/Out connectors stop. Also, the clock
rate is fixed to the rate that is calculated from the symbol rate and
RF parameters.

RF Power Level Sets teh output level of the RF signal. When you select this command
the RF Power Level dialog box appears.

Modulation Sets the parameter for the RF modulated output of the transport
stream.
When you select this command, the Modulation dialog box appears.
(See page 21, Modulation Dialog Box.)
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Table 6: QAM/VSB menu commands (Play screen) (cont.)

Command Description
Noise Generation Sets the amount of Gaussian noise to be added to the RF output.

When you select this command the Noise Generation dialog box
appears.

Calibration This command is not for users of generator. This command is used
only by factory personnel to calibrate the instrument.

Modulation Dialog Box. When you select the Modulation command from the
QAM/VSB menu, the Modulation dialog box appears. If RF Output in the
QAM/VSB menu is set to Off, you cannot set the parameters in the dialog box.

Standard: Sets the RF modulation standard. The available selections depend
on the installed modulation options. The various standards available are J83
Annex A, J83 Annex B, J83 Annex C, ATSC, and DTMB.

If the ITU-T J.83 Annex C modulation option is installed in the instrument,
you can select J83 Annex C and J83 Annex C-JCTEA. J83 Annex C-JCTEA
is a modulation scheme that is defined by JCTEA STD-002.

Modulation: Sets the modulation mode. The available selections depend on
the standard selected in the Standard list box.

For J83 Annex A: 16 QAM, 64 QAM, or 256 QAM

For J83 Annex B: 64 QAM or 256 QAM

For J83 Annex C and J83 Annex C-JCTEA: 64 QAM

For ATSC: 8VSB
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Symbol Rate: Sets the symbol rate. The available values depend on the
standard selected from the Standard list box.

For J83 Annex A: 1.0 Msps to 6.956522 Msps (IF output), 5.0 Msps to
6.956522 Msps (RF output)

For J83 Annex B: 5.056941 Msps (64QAM), 5.360537 Msps (256QAM)

For J83 Annex C: 1.0 Msps to 5.3097 Msps (IF output), 5.0 Msps to
5.3097 Msps (RF output)

For J83 Annex C-JCTEA: 5.274 Msps

For ATSC: 10.762237 Msps

For DTMB: 7.560000 Msps

Interleaving [Level, (I,J)]: Sets the operating mode of interleaving (Level 1
or Level 2) and interleaving parameters I and J when the selected standard
is J83 Annex B.

RF Center Frequency: Sets the center frequency of the RF signal. You can
set the value from 50 MHz to 860 MHz in 12.5 kHz steps.

Output: Selects the signal output from the RF Out and IF Out connectors.

RF: An RF signal is output from the RF Out connector.

IF (44 MHz): A 44 MHz IF signal is output from the IF Out connector.

IF Reversed (44 MHz): A 44 MHz IF signal with reversed spectrum is
output from the IF Out connector.

IF (36 MHz): A 36 MHz IF signal is output from the IF Out connector.

IF Reversed (36 MHz): A 36 MHz IF signal with reversed spectrum is
output from the IF Out connector.
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IP Menu The IP Playout is capable of transmitting TS streams on both IPv4 and IPv6
network. Select the IP option from the Play > Interface menu. A Recommended
Settings dialog box is displayed, which allows you to automatically configure the
settings for improved IP playout performance. (See Table 7.)

NOTE. The CPU is used 100 % when the MPEG Player plays in IP mode with
TS bit rate more than 10 Mbps. During this playout, duplex operation is not
possible, so TSCA cannot be run.

NOTE. Playing the MPEG Player at high bit rates in IP mode could saturate
the network.

Table 7: IP menu commands
Commands Description
Configuration Configures the IP interface and the IP version. You can set the packet

size, device name, protocol, ports, and the transmission mode of the
interface.

Parametric Settings Sets the player process priority, transmitter thread priority, burst mode
parameters, low jitter mode, and jitter parameters.

Error Insertion Inserts errors like packet loss, checksum, and sequence errors in the
transmitted stream.

Error Generation Manually generates errors like packet loss, checksum, and sequence
in the transmitted stream.
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Table 7: IP menu commands (cont.)

Commands Description
Statistics Displays details about parameter names, current stream values, and

the history of the previous transmission.
TTS Settings Enables whether to play out a TS file as a TTS file by prefixing a 4byte

time stamp to each TS packet.

Configuration. When you select Configuration from the IP menu, the IP Playout
Configuration dialog box is displayed. (See Figure 8.) and (See Figure 9.)

Figure 8: IP Configuration for IPv4
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Figure 9: IP Configuration for IPv6

This dialog box allows you to configure the following settings:

Configuration name: Allows you to enter or select a configuration name
from the drop-down list. The configuration will include all the settings
of the Configuration dialog box, Advanced Protocol Settings, and Stream
Replication Settings. This list can store up to ten configuration names. The
default value is blank.

IP Version: Allows you to select the IP version (IPv4, IPv6) for the IP
playout. IPv4 is set as the default value.

Protocol: Allows you to set the protocol (UDP, RTP) for the IP playout.
RTP is set as the default value.

Device Name: Allows you to select the device for the IP playout. The Device
Name lists all the active Network Interface Cards (NIC) in the system based
on the selected IP version. The first interface card that has a valid IP address
assigned to it is always automatically selected as the default value for both
IPv4 and IPv6 versions.

Source IP Address: Sets the source IP address for the IP playout. The first
valid IP address of the selected device will be set as the default. A customized
value can be selected only if a different source address is first set in the
Advanced Protocol Settings dialog box.

Based on the selected IP version, the source addresses will be listed in the
drop-down list.

Source Port: Allows you to set the source port for the IP playout. The port
value ranges from 0 to 65535. The default value for UDP and RTP protocol
is 16384.
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Transmission Mode: Allows you to set the transmission mode of the
protocol. Unicast and Multicast transmission modes are supported by both IP
versions. Broadcast transmission mode is supported only by the IPv4 version.
Multicast is set as the default value for both the versions.

Destination IP Address: Sets the destination IP address for the IP playout.
239.1.1.1 is set as the default value for IPv4 and ff0e::1 is set as the default
value for IPv6. Depending on the selected transmission mode, the system
validates the entry based on the following rules:

Unicast Range: Any IP address that does not fall into the Multicast or
the Broadcast range is the Unicast address. This range holds good only
for IPv4 version.

Multicast Range: 224.0.0.0 to 239.255.255.255.255 for IPv4 and
FFxx:y:y:y:y:y:y:y (where x is 0 to F and Y is 0000 to FFFF) for IPv6.

Broadcast Range: The Network or node portion of an IP address will be
set to “1”s or “0”s for IPv4 version.

Destination Port: Allows you to set the destination port for the IP playout.
The port value ranges from 0 to 65535. 16384 is set as the default value.

Enable VLAN: Allows you to enable the VLAN headers in the protocol
headers of an IP packet as per the 802.1Q standard. VLAN ID identifies the
VLAN that ranges from 0 to 4095. When you click OK with VLAN enabled
on the IP Playout Configuration dialog box, a Recommended Settings dialog
box is displayed asking you to do the required settings for using VLAN.
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Advanced Settings: Click Advanced Settings to view or customize the
protocol settings of active protocols in the current configuration. As per the
IP version selected, the IPv4 and IPv6 layer attributes are displayed in the
Settings screen. The RTP layer attributes are displayed only for RTP protocol
selection. If VLAN is enabled, the Advanced Settings dialog box displays
all the VLAN attributes under 802.1Q VLAN Layer header. (See page 125,
Settings for VLAN.) The protocol headers of Advanced Protocol Settings can
be customized but are not validated.

The parameters displayed in the Advanced Protocol Settings dialog box are as
follows:

Ethernet Layer: Destination Mac Address, Source Mac Address, Protocol

802.1Q VLAN Layer: Tag Protocol Identifier, Priority Levels, Canonical
Format Indicator, VLAN Identifier

IPv4 Layer: Version (read only), Header Length (read only), Type Of
Service, Total Length (read only), Time To Live, Protocol, Source IP
Address, Destination IP Address

IPv6 Layer: Version (read only), Traffic Class, Flow Label, Payload
Length (read only), Next Header, Hop Limit, Source IP Address,
Destination IP Address

UDP Layer: Source Port, Destination Port, Length (read only)

RTP Layer: Version (read only), Payload Type, Sequence Number, SSRC

Figure 10: Advanced Protocol Settings for IPv4
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Figure 11: Advanced Protocol Settings for IPv6

The Header Name and Default Value are read-only options. The protocol
headers displayed are limited to headers common to all packets except for
the RTP Sequence Number. The Current Value attributes of all the protocol
layers that are specified at packet creation can be customized. The customized
valid values are displayed in lavender and the customized invalid values
are displayed in pink. If any of the attributes are customized, the status bar
displays an icon during playout.

The Reset To Defaults button resets the customized values of the active
(selected) IP version to the default values.

NOTE. A condition where multicast is selected as the transmission mode and a
unicast destination address is entered in the Advanced Protocol Settings dialog
box will not be validated.

NOTE. If the destination IP address is changed in the Advanced Protocol Settings
dialog box, the application will not check for the accessibility of the address.
A change in the source and the destination IP address will not change the source
and the destination MAC address of the Advanced Screen Settings.

Stream Replication Settings: Click Stream Replication Settings to set the
number of replicated streams and customize the attributes accordingly.

As per the selected IP version, the IPv4 and IPv6 layer attributes are displayed
in the Stream Replication Settings screen. The RTP layer attributes are
displayed only for RTP protocol selection. If VLAN is enabled, the Stream
Replication Settings dialog box displays only the VLAN identifier. (See
page 125, Settings for VLAN.)
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You can specify the increment value for the following attributes:

Ethernet Layer: Destination Mac Address, Source Mac Address, Protocol

802.1Q VLAN Layer: VLAN Identifier

IPv4 Layer: Type Of Service, Time To Live, Protocol, Source IP Address,
Destination IP Address

IPv6 Layer: Traffic Class, Flow Label, Next Header, Hop Limit, Source IP
Address, Destination IP Address

UDP Layer: Source Port, Destination Port

RTP Layer: Payload Type, SSRC

Figure 12: Stream Replication Settings for IPv4

Figure 13: Stream Replication Settings for IPv6
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Stream Replication Settings are used to replicate the streams n times with
certain attributes of the stream incremented by a value within the n replicated
streams. You can enter the number of replications in the Number of
replicated streams text box.

The dialog box lists the attributes which can be incremented by entering a
number in the Increment Value column. All attributes except for MACs and
IP addresses accept an integer. The customized valid values are displayed in
lavender and customized invalid values are displayed in pink.

The Reset to Defaults button resets the increment values of the active
(selected) IP version to the default values. Whenever the stream replication is
active, an icon is displayed in the status bar during playout.

Allow TS Fragmentation: Controls the fragmentation of the transport stream
packets. If this option is selected, the IP packet can have fragmented transport
stream packets (last or first TS packet of an IP packet). When Allow TS
fragmentation is selected, both IP Packet size and Number of TS packets
option are enabled. Allow TS Fragmentation is not selected by default.

Allow IP Fragmentation: Controls the fragmentation of the IP packets for
IPv4 version only. This option is applicable to packet sizes which are greater
than the MTU size (typically 1500 bytes). If this option is selected, the IP
packets will be fragmented during transmission else they will be retained with
the same size. When IP fragmentation is selected, the maximum packet size is
16128 bytes. If the IP packet size is more than 1500 bytes, a Recommended
Settings dialog box is displayed asking you to do the required settings for
optimal performance.
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IP Packet Size: Allows you to set the size of the IP packet for playout.
This option is enabled only when Allow TS fragmentation is selected. The
maximum size of the IP packet for IPv6 version is 16128 bytes and for IPv4
version is 1500 bytes.

The IP packet size includes the headers and hence the payload size is
calculated at runtime using the following equation:

IP Packet = Payload Size + Header Size

For IPv4 version, the header size is 54 (58 with VLAN enabled) for RTP and
42 (46 with VLAN enabled) for UDP. For IPv6 version, the header size is 74
(78 with VLAN enabled) for RTP and 62 (66 with VLAN enabled) for UDP.

Number of TS Packets: Allows you to enter the number (integers) of TS
packets that needs to be embedded into an IP packet. Seven is set as the
default value. The maximum value of the number of TS packets depends on
the maximum allowed IP packet size and the minimum value is 1.

A read only text field showing the IP packet size is displayed next to this
option. The IP packet size will be calculated automatically and displayed in
bytes. Based on the number of TS packets, the IP packet size is calculated
using the following equation:

IP Packet = Payload Size + Header Size

where payload size is calculated as follows:

Payload Size = Number of TS Packets × TS Packet Size

Store Settings: Creates or updates the entire configuration settings including
the Advanced Protocol Settings and Stream Replication Settings. All these
settings will be stored in a name that is listed in the Configuration Name
drop-down list.

Delete Settings: Deletes the selected configuration settings from the
Configuration Name drop-down list and displays the next configuration.
If there are no more configurations stored in the list, the values in the
configuration dialog box will be reset to the default values.

Reset to Defaults: Resets the selected configuration settings, Advanced
Protocol Settings, and Stream Replication Settings to the default values. It
clears the selected configuration name also.
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Parametric Settings. When you select Parametric Settings from the IP menu, the
Parametric Settings dialog box is displayed as shown.

When you click OK with Low Jitter Mode selected, a Recommended Settings
dialog box is displayed asking you to do the required settings for optimal
performance. Refer to the Recommended Settings for MPEG Player in IP Mode
section for additional information. (See page 119.)
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The Parametric Settings dialog box allows you to set the following parameters:

Burst Mode: Allows you to transmit the stream in the form of bursts. The
player does not support Burst in stream replication mode.

Burst Period: You can set the time during which the packets will be
transmitted in the burst mode. Burst period is set as the default.

Burst Size: You can set the burst size which determines the number of
packets being transmitted in every burst.

Jitter: Configures jitter during the IP playout.

Low Jitter Mode: This mode is selected when you want the jitter to be
very low. Low Jitter Mode text will be displayed instead of the progress
bar and the elapsed time in the status indicator. The Statistics dialog box
will be disabled for this mode.

Figure 14: Low Jitter Mode Status Indicator

Jitter Distribution: Inserts jitter during IP playout. The player does not
support jitter insertion in stream replication mode. The overall bit rate is
not affected by the inserted jitter.

There are four types of jitter distribution namely Fixed, Laplacian,
Gaussian, and Sinusoidal. Fixed is set as the default distribution. When
Fixed is selected, a Duration text box is displayed where you can enter
the jitter in microseconds. When Laplacian, Gaussian, or Sinusoidal is
selected, a slider is displayed which can be moved to set the jitter as a
percentage of the interpacket time. The interpacket gap will follow the
selected jitter distribution.
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Error Insertion. When you select Error Insertion from the IP menu, the Error
Insertion dialog box is displayed. (See Figure 15.)

Figure 15: Error Insertion

This dialog box allows you to insert errors during playout. For UDP playout, the
error insertions are limited to packet drop and checksum errors.

Enable Error Insertion: Enables error insertion. The errors can be inserted
in sequential or random order. Random is set as the default insertion order.
All error insertions are specified as X errors per Y packets.

Sequential: The errors are inserted in sequential packets, that is for every
Y packets the first X packets have errors inserted in them.

Random: The errors are inserted in random packets, that is for every Y
packets X random packets have errors inserted in them. Random mode
is set as the default.

Packet Loss: Inserts packet loss in random or sequential order. The packets
are dropped at a frequency you specify. The rate can be specified as X packets
within Y packets.

Checksum Error: Inserts checksum error. The checksum error can be
inserted in the UDP layer of both IPv4 and IPv6 versions but only in IP layer
of IPv4 version. The CRC errors are generated in packets at a frequency you
specify. The rate can be specified as X packets within Y packets.

Sequence Error: Inserts packet sequence errors. This option is enabled only
if RTP protocol is selected in the IP configuration Playout dialog box. The
packets will be reordered at a specified frequency.

You can enter the number of packets after which you want the reordering to
happen in the Packets Apart text box. The rate can be specified as X packets
per Y packets reordered after every Z number of packets.
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Error Generation. When you select Error Generation (enabled only during
playout) from the IP menu, the Error Generation dialog box appears. (See
Figure 16.)

Figure 16: Error Generation

This dialog box allows you to insert the following errors manually in real time:

Generate Packet Loss: Drops an IP packet during the IP playout. The number
of packets dropped will be equal to the number of times you click the button.

Generate IP Checksum Error: Generates checksum errors manually in
the IP layer (IPv4 version).

Generate UDP Checksum Error: Generates checksum errors manually
in the UDP layer.

Generate Sequence Error: Generates sequence error manually. When you
click this button the packet will be sent after x number of packets where x is a
number between 1 and 100.
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Statistics. When you select Statistics from the IP menu, the Statistics dialog
box is displayed.

Figure 17: Statistics

The player displays the current and historic statistics of IP parameters, TS
parameters, and errors. These statistics are cleared at the start of the next play,
when a new file is opened, or when the player is restarted. In Low Jit mode the
Statistics option is disabled and when the player switches back to the normal
mode it displays the statistics of the previous TS packet that was played out.

Current: Displays the instantaneous statistics of parameters at that time.
Once the play starts, this dialog box is refreshed every second.

IP Parameters: The current bit rate, percentage variation of this current bit
rate from the nominal (set) bit rate, number of IP packets transmitted, and the
IP packet size used for the playout are all displayed. The jitter value which
reflects the insertions performed at run time is also displayed.

TS Parameters The TS bit rate, TS packet size, and the number of TS packets
of the currently played MPEG file are displayed. When TTS Playout settings
is enabled, the packet size displays the actual packet size (188 bytes) along
with the extra 4-byte time stamp. If the player is in the NonTS mode, all the
statistics will display NonTS playout.
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Errors The number of packets dropped, packet loss rate, sequential errors,
UDP checksum errors, and IP checksum errors are all displayed.

Value (per stream): When stream replication is enabled, the Current
tab displays the Value column. (See Figure 17.) This column gives the
value of each parameter per stream.

Total Value (in n streams): When stream replication is enabled, the
Current tab displays the Total Value column. (See Figure 17.) This column
gives the total value of each parameter for the set number of streams. Here
n is equal to the sum of the replicated streams and the actual stream.

Historic: Displays the minimum, maximum, and average value of parameters
(IP, TS) for the current play. When stream replication is enabled, the Historic
tab signifies that the statistics displayed is per flow.

IP Parameters: The current bit rate, percentage variation of this current
bit rate from the nominal (set) bit rate, and the jitter value are displayed.

TS Parameters: The bit rate and the percentage variation from this bit
rate are displayed.

Timestamped TS Playout Settings. When you select TTS Settings from the IP
menu, the TTS Settings dialog box is displayed. The TTS Settings option is only
supported by IP mode.

Figure 18: Timestamped TS Playout Settings
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When TTS is enabled, each packet (188 bytes) of TS file is prefixed by a 4-byte
time stamp and converted into a TTS stream. If the TS packet size is more than
188 bytes (192, 204, 208), the extra bytes following the 188th byte are truncated
and 4-bytes of time stamp will be transmitted along with it. For a partial TS
file with the TTS settings selected (with Preserve timestamp not selected), the
submenus namely the Update mode, Clock dialog box, and the PCR initial value
of the Play menu are all enabled.

Preserve timestamps if the file already has them: By selecting this option,
you can preserve the time stamps of the TTS file if it already exists or add
4-bytes of time stamp to the TS packet.

Enable TTS Jitter: By selecting this option, you can insert jitter to the time
stamps that gets appended to the TS packets.

Pattern: You can select the distribution of jitter that is inserted to time stamp
from the Pattern list. The various patterns listed are Sine, Pulse, Triangle,
Square, Saw, Random, and Offset. Sine is set as the default pattern.

Period: You can set the period for the time stamp as number of packets.
Based on the selected pattern, the Period text box is enabled or disabled. 100
packets is set as default period value.

Amplitude: You can enter the amplitude of the time stamp in the Amplitude
text box. Based on the selected pattern the Amplitude text box is enabled or
disabled. 0.00 ns is set as the default amplitude.

Pulse Width: You can set the pulse width as the number of packets. Based
on the selected pattern, the Pulse width is enabled or disabled. 50 packets is
the default pulse width.

In the TTS mode, the Packet size option of the Play menu is disabled with 188
bytes selected. When the TTS mode is selected, the status bar displays TTS mode
as the standard with 192 packet size.

The displayed IP bit rate changes because there will be four extra bytes that is
added to each TS packet. When TTS Playout settings is enabled, the packet size
in the Statistics screen displays the actual packet size (188 bytes) with the four
time-stamped bytes.
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Utility Menu The Utility menu contains commands to set the parameters for remote control
with the Ethernet interface and to display the system information such as software
and hardware versions. (See Table 8.)

Table 8: Utility menu commands
Command Description
Communication Opens the Communication dialog box where you can set the port

number needed to remotely control the generator over an Ethernet
network and the terminator used to communicate with a controller.
(See Figure 19.)

Status Opens the Status dialog box where you can check general system
information including the software and hardware versions.

Communication Dialog Box. When you select the Communication command from
the Utility menu, the Communication dialog box appears. (See Figure 19.)

Figure 19: Communication dialog box

Port Number: Sets the port number needed to remotely control the generator
over an Ethernet network. You can set the value from 1024 to 65535.

Terminator Tx: Sets the terminator used when the generator sends
information to a controller. You can select LF (linefeed), CR (carriage return),
CRLF (carriage return and linefeed), or LFCR (linefeed and carriage return).

Terminator Rx: Sets the terminator used when the generator receives
commands from a controller. You can select LF (linefeed) or CR (carriage
return).
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Status Dialog Box. When you select the Status command from the Utility menu,
the Status dialog box appears.

This dialog box shows the version of the generator application and hardware
version of the main and installed interface modules.
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Menus in the Record
Screen

This subsection describes the menus in the Record screen.

NOTE. The IP interface mode does not support the Record function, so the Record
option is disabled for IP.

File Menu The File menu in the Record screen contains commands for setting the save mode
and for saving and loading a preset file. This menu also contains commands for
exiting the generator application and for shutting down of the instrument. (See
Table 9.)

Table 9: File menu commands (Record screen)
Command Description
Save Specifies the file name used when you save stream data. When you

select this command, the Save as dialog box appears. By default, the
current date (yymmdd) is used as a file name.

Save Mode Sets the save mode when you save stream data. You can select
Over Write or New File. In the Over Write mode, the existing file
is overwritten by the new file with the name specified in the Save
command whenever you save a stream data. In the New File mode, a
new file is created whenever you save a stream file. The file name is
the name specified by the Save commands + # (1,2,3,4...).

Load Preset Loads the specified preset file (*.set). When a preset file is loaded, the
current instrument settings are replaced by the preset file’s settings.

Save Preset Saves the current instrument settings as a preset file.
PLAY Switches to the Play screen.
Scheduler Starts the Scheduler application when Option SC is installed.
Minimize Minimizes the generator application window.
Exit Quits the generator application. The generator application settings

are saved.
Shutdown Quits the generator application and shuts down the generator.

View Menu The View menu contains commands that control the display of the Toolbar and
Status bar. The View menu in the Record screen is the same as the View menu in
the Play screen. (See Table 2 on page 5.)
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Record Menu The Record menu contains commands for setting the input interface, record size,
trigger position, and target source. (See Table 10.)

Table 10: Record menu commands
Command Description
Source Sets the interface used to input a stream data. You can select SPI

(standard) or the name of the interface option currently installed
(Univ I/F, ASI, ASI/1394, or ASI/310M). For SPI, use the SPI In/Out
connector.

Target Opens the Target Dialog box where you can set the record size, trigger
position, and target source to record the input stream. (See Figure 20.)

Timer Record Opens the Timer Play/Record dialog box where you can set the time
used to record the input stream automatically. (See Figure 6.)

Other Opens the Others dialog box where you can set the standard used
to display the input stream, display radix for the text information, and
external trigger status. (See Figure 7.)

Target Dialog Box. When you select the Target command from the Record menu,
the Target dialog box appears. (See Figure 20.)

Figure 20: Target dialog box
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Record Size: Sets the recording time (h:m:s) or file size (MB) to record the
input stream. Use the Format list box to select the method to set the record
size.

The amount of free space available for the RAM or hard disk is displayed
below the data size text box. You cannot set the record size beyond this value.

Use theWithout Limit check box to record the input stream to the full free
space in the hard disk or RAM. When it is checked, the available recording
time and data size are automatically set. In addition, when the check box is
enabled, the Continuous Recording check box becomes disabled.

NOTE. When you set the pretrigger portion, the same free space as the record
size is required.

A list box in the Record Size field is available to select the record target (RAM
or hard disk) that is used to record the input stream.

Trigger Position: Sets the trigger position used to record the input stream.
You can set the trigger position by specifying the time (h:m:s) or the file
size (MB).

Continuous Recording: Sets whether to enable Continuous Recording. With
Continuous Recording, you can record multiple stream files continuously
on the hard disk.

When selected, the Continuous Recording box (to the right of the check box)
becomes available. Use this box to set the number of files after which to stop
Continuous Recording. After the specified number of files are created, stream
capture stops automatically. You can set the value from 2 to 32767.

When this option is selected, the Without Limit check box is disabled.

Ignore Dvalid: Sets whether the generator ignores the DVALID signal
from the selected interface or not when a stream data is acquired. When it
is checked, the generator ignores the DVALID signal, and the stream data is
acquired according to the internal clock signal. This option is not available
for the ASI interface option.

Format: Specifies how to set the record size and trigger position. You can
select Time or File Size.
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Others Dialog Box. When you select the Other command from the Record menu,
the Others dialog box appears. (See Figure 21.)

Figure 21: Others dialog box

Standard: Sets the standard used to display the input stream. You can select
ARIB, ATSC, DVB, or MPEG-2.

Numeric: Sets the base value used to describe the component information in
the hierarchy display. You can select Decimal, Hex, or Octal.

Ext Record Start: Sets whether or not to start input stream record using a
trigger signal applied to the Trig In/Out connector. You can select Off, Rise,
or Fall. When you select Rise, the input stream record is started at the rising
edge of the applied trigger signal. When you select Fall, the input stream
record is started at the falling edge of the applied trigger signal.

When you use the external trigger signal with the pretrigger portion defined to
record the input stream, the generator acquires pretrigger data when a valid
trigger signal occurs and waits for the trigger. When a valid trigger signal
occurs again, the generator acquires posttrigger data and creates a stream file.

Ext Trigger BNC: This item is common to the Play screen.
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QAM/VSB Menu (RTX130B
Generator)

The QAM/VSB menu contains commands for setting the parameters for the RF
modulated output of an input transport stream and selecting the reference clock
for the RF modulated output. This menu is available only when ASI is selected
from the Source command in the Record menu. (See Table 11.)

Table 11: QAM/VSB menu command (Record screen)
Command Description
BNC Portt Sets the signal format applied to the ASI/SMPTE Output connector.

You can select ASI or 310M 8VSB (SMPTE310M signal with data
rate of 8 VSB).

Through Out Sets whether the signal supplied to the ASI/SMPTE Input connector is
output from the ASI/SMPTE Output connector when a stream is not
output. You can select On or Off.

RF Output Sets whether to modulate and output a signal that is applied to the
ASI/SMPTE Input connector. You can select On or Off.

Modulation Sets the parameter for the RF modulated output of the transport
stream.
When you select this command, the Modulation dialog box appears.
The dialog box is same as the Modulation dialog box displayed in the
Play screen. (See page 21, Modulation Dialog Box.)

RF Clock Source Opens the RF Clock Source dialog box where you can set the
reference clock for the RF modulated output of the transport stream
applied to the ASI/SMPTE Input connector.
(See page 45, RF Clock Source Dialog Box.)

RF Clock Source Dialog Box. When you select the RF Clock Source command
from the RF/ASI/310M menu, the RF Clock Source dialog box appears.

(See Figure 22 on page 45.)

Figure 22: RF Clock Source dialog box
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Async: Uses the internal clock, which is not synchronized with the clock that
is created by an ASI or SMPTE310M signal, for real-time modulation.

In this mode, the input transport stream clock is not synchronized with the
symbol rate. The transport stream rate that is calculated by the symbol rate
and the modulation parameters that are synchronized with the actual transport
stream signal by inserting null packets. In this case, PCR jitter of maximum
1 packet is generated.

NOTE. If the bit rate of the input transport stream is higher than the calculated bit
rate, a non-modulated signal is output.

Ext Ref: Uses a signal applied to the Clock/Ref In connector as the reference
signal. When you select the button to the right of the ExtRef button, the
following External Reference dialog box appears. This button is available only
when J.83 Annex C-JCTEA or ATSC is selected as a modulation standard.

10 MHz Selects a 10 MHz signal on the Clock/Ref In connector.

27 MHz Selects a 27 MHz signal on the Clock/Ref In connector.

Press the TAB button repeatedly to select an option button, and then press the
arrow buttons to select one of the options.

NOTE. If the input transport stream and external reference signal are not
synchronized, a non-modulated signal is output.
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ISDB-T/ISDTV/ASI Menu
(RTX100B Generator)

The ISDB-T/ISDTV/ASI menu contains commands for setting the parameters for
the RF modulated output of an input broadcast transport stream and selecting the
reference clock for the RF modulated output. This menu is available only when
ASI is selected from the Source command in the Record menu.

Table 12: ISDB-T/ISDTV/ASI menu command (Record screen)
Command Description
RF Standard Sets the standard for the RF signal. You can

select ISDB-T or ISDTV.
RF Parameter Opens the ISDB-T RF Parameter dialog box

where you can set the parameter for the RF
modulated output (ISDB-T or ISDTV) of the
broadcast transport stream applied to the
ASI In connector.

RF Clock Source Opens the ISDB-T Clock Source dialog box
where you can set the reference clock for
the RF modulated output of the broadcast
transport stream applied to the ASI In
connector.

ISDB-T/ISDTV RF Parameter Dialog Box. When you select the RF Parameter
command from the ISDB-T/ISDTV/ASI menu, the RF Parameter dialog box
appears as per the selected RF standard. This dialog box is same as the ISDB-T
Parameter dialog box displayed in the Play screen.

Center Frequency: Sets the center frequency (UHF channel number) for the
RF modulated output. For ISDB-T standard the channels range from 13 to 62
and for ISDTV standard the channels range from 14 to 69.

ISDB-T Clock Source Dialog Box. When you select the ISDB-T Clock Source
command from the ISDB-T/ISDTV/ASI menu, the ISDB-T Clock Source dialog
box appears.

ASI Input: Uses an ASI signal applied to the ASI In connector as the
reference signal.

Ext Ref: Uses a signal applied to the Clock/Ref In connector as the reference
signal. When you select the button to the right of the ExtRef button, the
following External Reference dialog box appears:

10 MHz: Selects a 10 MHz signal on the Clock/Ref In connector.

27 MHz: Selects a 27 MHz signal on the Clock/Ref In connector.

ISDB-T IFFT Clock: Selects a signal corresponding to the IFFT sample clock
rate (8.126984 MHz) on the Clock/Ref In connector.
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Utility Menu The Utility menu contains commands for displaying the system information such
as software and hardware versions. The Utility menu in the Record screen is the
same as that of the Play screen. (See Table 8.)

Hierarchy Display
The generator displays the selected transport stream using a hierarchy structure.
This section describes the hierarchy display and defines each icon you might
encounter in the display.

Overview of the Hierarchy
Display

The generator uses icons displayed in a hierarchical structure to show the
interrelationship of transport stream components. Additional information about
each stream component such as PID and Table ID numbers is displayed next
to each icon.

The “+” symbol displayed to the left of some icons indicates that the item includes
lower-level transport stream components that are not displayed. The symbol
changes to “–” when the lower level components are displayed. To expand the
hierarchy, select the desired upper-level icon and press the right control button. To
collapse the selected upper-level icon press the left control button.

When a transport stream contains more items than will display on the screen at
one time, a scroll bar appears at the right of the screen.

The icon cursor is used to select individual transport stream components as
represented by the icons. The icon cursor is displayed as a red square (border)
surrounding a hierarchy icon. Use the arrow buttons to move the icon cursor
through the hierarchy. The hierarchy display scrolls (if applicable) when the Icon
cursor reaches the top or bottom of the displayed portion of the hierarchy.
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When the menus are enabled, the icon cursor is disabled. Press the front-panel
Menu button to toggle control between the Icon cursor and the menus.

Hierarchy Display Icons The hierarchy display contains icons. The specific icons you may encounter
depend on the format of the transport stream, as shown in the following four
tables. The text next to each icon describes each transport stream component.

(See Table 13 on page 49.)

Table 13: Icons used for MPEG-2, ARIB, DVB, and ATSC formats
Icon Element type

ISDB-T
Broadcast transport stream that is defined ARIB
STD-B31.
S-TMCC
Transport stream into which TMCC information is
inserted into 8 bytes in its Reed-Solomon area
(16 bytes).
M-TMCC
Transport streamin to which TMCC information is
inserted into its sync byte area, and having super
frame structure.
Non-TS
Data stream other than transport stream format.

Transport Stream (TS)
This icon represents all transport stream packets
that make up the stream.
Program Association Table (PAT)
One or more transport packets with a PID value
and table_id value of 0x00.
Transport Stream Description Table (TSDT)
One or more transport packets with a PID value of
0x02 and a table_id value of 0x03.
Network Information Table (NIT)
One or more transport packets with a PID value
specified by the network_PID in the PAT.
Conditional Access Table (CAT)
One or more transport packets with a PID value of
0x01 and a table_id value of 0x0001.
Program Map Table (PMT)
One or more transport packets with a PID value
specified by the program_map_PID in the PAT and
a table_id value of 0x02.
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Table 13: Icons used for MPEG-2, ARIB, DVB, and ATSC formats (cont.)

Icon Element type
Program Clock Reference (PCR)
One or more transport packets with a PID value
specified by the PCR_PID in the PMT and a
PCR_flag value of 1.
Video elementary stream
One or more transport packets with a PID value
specified by the elementary_PID in the PMT and a
stream_type value of 0x01 or 0x02.
A lock symbol appears in the icon when the
transport_scrambling_control value is set to 01.
H264 Video elementary stream
One or more transport packets with a PID value
specified by the elementary_PID in the PMT and a
stream_type value of 0x1B.
A lock symbol appears in the icon when the
transport_scrambling_control value is set to 01.
MPEG-4 Video elementary stream
One or more transport packets with a PID value
specified by the elementary_PID in the PMT and a
stream_type value of 0x10.
A lock symbol appears in the icon when the
transport_scrambling_control value is set to 01.
Audio elementary stream
One or more transport packets with a PID value
specified by the elementary_PID in the PMT and a
stream_type value of 0x03, 0x04, or 0x11.
A lock symbol appears in the icon when the
transport_scrambling_control value is set to 01.
Audio AAC, Audio AC3 (ATSC format)
One or more transport packets with a PID value
specified by the elementary_PID in the PMT and a
stream_type value of 0x0F or 0x81 (ATSC format).
A lock symbol appears in the icon when the
transport_scrambling_control value is set to 01.
Data stream
One or more transport packets with a PID value
specified by the elementary_PID in the PMT and a
stream_type value of other than 0x01-0x05, 0x08,
and 0x0F (in ATSC format, 0x81).
A lock symbol appears in the icon when the
transport_scrambling_control value is set to 01.
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Table 13: Icons used for MPEG-2, ARIB, DVB, and ATSC formats (cont.)

Icon Element type
Private Section
One or more transport packets with a PID value
specified by the elementary_PID in the PMT and a
stream_type value of 0x05.
A lock symbol appears in the icon when the
transport_scrambling_control value is set to 01.
Digital Storage Media Command and Control
(DSM-CC)
One or more transport packets with a PID value
specified by the elementary_PID in the PMT and a
stream_type value of 0x08.
A lock symbol appears in the icon when the
transport_scrambling_control value is set to 01.
Entitlement Control Message (ECM)
One or more transport packets with a PID value
specified by the CA_PID of the CA_descriptor in
the PMT, a payload_start_unit_indicator value of
1, and the payload does not start 000001 (section)
or the payload starts 000001 (PES).
Entitlement Management Message (EMM)
One or more transport packets with a PID value
specified by the CA_PID of the CA_descriptor in
the CAT, a payload_start_unit_indicator value of 1,
and the payload does not start 000001 (section) or
the payload starts 000001 (PES).
GHOST
One or more transport packets with a PID value
not specified in the PSI or Private Section PID file
when the transport stream is downloaded.
NULL
One or more transport packets with a PID value
of 0x1FFF.
GARBAGE
One or more transport packets in the section-data
structure at the beginning of the section are not
complete.
Adaptation Field Error (ADFERR)
One or more transport packets with an
adaptation_field_control value of 0x00.
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Table 14: Icons specific to DVB format
Icon Element type

Service Description Table (SDT)
One or more transport packets with a PID value of 0x0011 and a table_id value
of 0x42.
Bouquet Association Table (BAT)
One or more transport packets with a PID value of 0x0011 and a table_id value
of 0x4A.
Event Information Table (EIT)
One or more transport packets with a PID value of 0x0012 and a table_id value
of 0x4E-0x6F.
Running Status Table (RST)
One or more transport packets with a PID value of 0x0013 and a table_id value
of 0x4E-0x71.
Stuffing Table (ST)
One or more transport packets with a PID value of 0x0010-0x0013 and a
table_id value of 0x72.
Discontinuity Information Table (DIT)
One or more transport packets with a PID value of 0x1E and a table_id value
of 0x7E.
Selection Information Table (SIT)
One or more transport packets with a PID value of 0x1F and a table_id value
of 0x7F.
Time and Data Table (TDT)
One or more transport packets with a PID value of 0x0014 and a table_id value
of 0x72.
Time Offset Table (TOT)
One or more transport packets with a PID value of 0x0014 and a table_id value
of 0x73.
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Table 15: Icons specific to ARIB format
Icon Element type

Service Description Table (SDT)
One or more transport packets with a PID value of 0x0011 and a table_id value
of 0x42.
Bouquet Association Table (BAT)
One or more transport packets with a PID value of 0x0011 and a table_id value
of 0x4A.
Event Information Table (EIT)
One or more transport packets with a PID value of 0x0012 and a table_id value
of 0x4E-0x6F.
Running Status Table (RST)
One or more transport packets with a PID value of 0x0013 and a table_id value
of 0x4E-0x71.
Stuffing Table (ST)
One or more transport packets with a PID value of 0x0010-0x0013 and a
table_id value of 0x72.
Discontinuity Information Table (DIT)
One or more transport packets with a PID value of 0x1E and a table_id value
of 0x7E.
Selection Information Table (SIT)
One or more transport packets with a PID value of 0x1F and a table_id value
of 0x7F.
Local event Information Table (LIT)
One or more transport packets with a PID value of 0x0020 and a table_id
value of 0xD0. One or more transport packets with a PID value specified by
the elementary_PID in the PMT and a table_id value of 0xD0 when a stream
type value is 0x05.
Event Relation Table (ERT)
One or more transport packets with a PID value of 0x0021 and a table_id
value of 0xD1. One or more transport packets with a PID value specified by
the elementary_PID in the PMT and a table_id value of 0xD1 when a stream
type value is 0x05.
Index Transmission Table (ITT)
One or more transport packets with a PID value specified by the elementary_PID
in the PMT and a table_id value of 0xD2.
Partial Content Announcement Table (PCAT)
One or more transport packets with a PID value of 0x22 and a table_id value
of 0xC2.
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Table 15: Icons specific to ARIB format (cont.)

Icon Element type
Software Download Trigger Table (SDTT)
One or more transport packets with a PID value of 0x23 and a table_id value
of 0xC3.
Download Control Table (DCT)
One or more transport packets with a PID value of 0x17 and a table_id value
of 0xC0.
DownLoad Table (DLT)
One or more transport packets with a PID value specified by the DL_PID in the
DCT and a stream_type value of 0xC1.
A lock symbol appears in the icon when the transport_scrambling_control value
is set to 01.
Broadcaster Information Table (BIT)
One or more transport packets with a PID value of 0x24 and a table_id value
of 0xC4.
Network Board Information Table (NBIT)
One or more transport packets with a PID value of 0x25 and a table_id value
of 0xC5 or 0xC6.
Linked Description Table (LDT)
One or more transport packets with a PID value of 0x25 and a table_id value
of 0xC7.
Time and Data Table (TDT)
One or more transport packets with a PID value of 0x0014 and a table_id value
of 0x72.
Time Offset Table (TOT)
One or more transport packets with a PID value of 0x0014 and a table_id value
of 0x73.
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Table 16: Icons specific to ATSC format
Icon Element type

Master Guide Table (MGT)
One or more transport packets with a PID value of 0x1FFB and a table_id value
of 0xC7.
Terrestrial Virtual Channel Table (TVCT)
One or more transport packets with a PID value of 0x1FFB and a table_id value
of 0xC8.
Cable Virtual Channel Table (CVCT)
One or more transport packets with a PID value of 0x1FFB and a table_id value
of 0xC9.
Rating Region Table (RRT)
One or more transport packets with a PID value of 0x1FFB and a table_id value
of 0xCA.
Event Information Table (EIT)
One or more transport packets with a PID value specified by the table_type_PID
in the MGT and a table_id value of 0xCB.
Channel Extended Text Table (CETT)
One or more transport packets with a PID value of 0x1FFB and a table_id value
of 0xC8.
Event Extended Text Table (EETT)
One or more transport packets with a PID value of 0x1FFB and a table_id value
of 0xC9.
Program Identifier Table (PIT)
One or more transport packets with a PID value specified by the elementary_PID
in the PMT and a table_id value of 0xD0 when a stream_type value is 0x85.
System Time Table (STT)
One or more transport packets with a PID value of 0x1FFB and a table_id value
of 0xCD.

Icon Text and Dialog Box To the right of each icon, the generator displays text that describes each transport
stream component. In addition, for the PCR icon, you can display a dialog box to
change the parameters for the component.

This subsection describes the text information for each icon type and the dialog
box available for the PCR icon.

ISDB-T Icon The following text information is displayed for the ISDB-T icon:

“xxx.rmx”: Shows the file name.

Packets: Shows the total number of packets in the broadcast transport stream.

RTX100B Series RF Signal Generators 55



Reference

S-TMCC Icon The following text information is displayed for the M-TMCC icon:

“xxx.trp”: Shows the file name.

SF: Shows the number of super frames.

M-TMCC Icon The following text information is displayed for the M-TMCC icon:

“xxx.trp”: Shows the file name.

SF: Shows the number of super frames.

Non-TS Icon The following text information is displayed for the Non Transport Stream
(Non-TS) icon:

“xxx.xx”: Shows the file name.

FileSize: Shows the file size in bytes.

Transport Stream (TS) Icon The following text information is displayed for the Transport Stream (TS) icon:

“xxx.trp”: Shows the file name of the transport stream.

Packets: Shows the total number of packets in the transport stream.

When this icon is used with the S-TMCC or M-TMCC icon, the following text
information is displayed:

TSID: Shows the ID number for the transport stream.

TC8PSK/xx, BPSK/xx, or QPSK/xx: Shows the modulation system and the
number of contract slots (xx).

Program Association Table
(PAT) Icon

The following text information is displayed for the Program Association Table
(PAT) icon:

PID: Shows the PID value of the PAT.

TblID: Shows the table_id value of the PAT.

TSID: Shows the transport_stream_id value of the PAT.

Prg: Shows the number of programs contained in the transport stream.

Transport Stream
Description Table (TSDT)

Icon

The following text information is displayed for the Transport Stream Description
Table (TSDT) icon:

PID: Shows the PID value of the TSDT.

TblID: Shows the table_id value of the TSDT.
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Network Information Table
(NIT) Icon

The following text information is displayed for the Network Information Table
(NIT) icon:

PID: Shows the PID value of the NIT.

TblID: Shows the table_id value of the NIT.

Conditional Access Table
(CAT) Icon

The following text information is displayed for the Conditional Access Table
(CAT) icon:

PID: Shows the PID value of the CAT.

TblID: Shows the table_id value of the CAT.

Program Map Table (PMT)
Icon

The following text information is displayed for the Program Map Table (PMT)
icon:

PID: Shows the PID value of the PMT.

TblID: Shows the table_id value of the PMT.

PrgNo: Shows the program number associated with the PMT.

Program Clock Reference
(PCR) Icon

The following text information is displayed for the Program Clock Reference
(PCR) icon:

PID: Shows the PID value of the PCR.

PCR Inaccuracy Dialog Box. If you press the Num Pad/Select button when the
PCR icon is selected, the PCR Inaccuracy dialog box appears. (See Figure 23.)
This dialog box allows you to add jitter to the program_clock_reference_base
value and the program_clock_reference_extension value.

The PCR Inaccuracy dialog box contains four parameters that you can use to
specify the jitter. (See Table 17.)
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Figure 23: PCR Inaccuracy dialog box

Table 17: PCR Inaccuracy dialog box parameters
Parameter Description
Pattern Selects the waveform type of the waveform used to add jitter. You can

select Sine, Square, Triangle, Pulse, Sawtooth, Random, or Offset.
Period Sets the period of the waveform used to add jitter. You can set the

value from 5 to 3000 packets in 1 packet steps.
Amplitude Sets the amplitude of the waveform used to add jitter. You can set the

value from 0/27 MHz to 135000000/27 MHz (0 s to 5 s).
Pulse Width Sets the pulse width of the waveform used to add jitter. You can set

the value from 1 to (period–1) packet(s) in 1 packet step. This Pulse
Width parameter is available only when the Pattern parameter is set
to Pulse.

Video Elementary Stream
(VIDEO) Icon

The following text information is displayed for the video elementary stream
(VIDEO) icon:

PID: Shows the PID value of the video elementary stream.

StrmTyp: Shows the type of the video elementary stream (0x01 or 0x02).

VIDEO_H264 Icon The following text information is displayed for the H264 video elementary stream
(VIDEO_H264) icon:

PID: Shows the PID value of the H264 video elementary stream.

StrmTyp: Shows the type of the H264 video elementary stream (0x1B).
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VIDEO_MP4 Icon The following text information is displayed for the MPEG-4 video elementary
stream (VIDEO_MP4) icon:

PID: Shows the PID value of the MPEG-4 video elementary stream.

StrmTyp: Shows the type of the MPEG-4 video elementary stream (0x10).

Audio Elementary Stream
(AUDIO) Icon

The following text information is displayed for the audio elementary stream
(AUDIO) icon:

PID: Shows the PID value of the audio elementary stream.

StrmTyp: Shows the type of the audio elementary stream (0x03 or 0x04).

AUDIO_AAC and
AUDIO_AC3 Icons

The following text information is displayed for the AUDIO_AAC and ADIO_AC3
(ATSC only) icons:

PID: Shows the PID value of the audio elementary stream.

StrmTyp: Shows the type of the audio elementary stream (0x0F or 0x81).

Data Stream (DATA) Icon The following text information is displayed for the data stream (DATA) icon:

PID: Shows the PID value of the data stream.
StrmTyp: Shows the type of the data stream.

Private Section
(DATA_SECT) Icon

The following text information is displayed for the private section (DATA_SECT)
icon:

PID: Shows the PID value of the private section.

TblID: Shows the table_id value of the private section.

StrmTyp: Shows the type of the private section.

DSM_CC Icon The following text information is displayed for the digital storage media command
and control (DSM_CC) icon:

PID: Shows the PID value of the data DSM-CC.

StrmTyp: Shows the type of the DSM-CC.

Entitlement Control
Message (ECM) Icon

The following text information is displayed for the Entitlement Control Message
(ECM) icon:

PID: Shows the PID value of the ECM.
TblID: Shows the table_id value of the ECM.
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Entitlement Management
Message (EMM) Icon

The following text information is displayed for the Entitlement Management
Message (EMM) icon:

PID: Shows the PID value of the EMM.

TblID: Shows the table_id value of the EMM.

GHOST Icon PID: Shows the PID value of the GHOST.

Adaptation Field Error
(ADFERR) Icon

The following text information is displayed for the Adaptation Field Error
(ADFERR) icon:

PID: Shows the PID value of the ADFERR.

NULL Icon The following text information is displayed for the NULL icon:

PID: Shows the PID value of the NULL.

GARBAGE Icon The following text information is displayed for the GARBAGE icon:

PID: Shows the PID value of the GARBAGE.

SDT, BAT, EIT, RST, ST, DIT,
SIT, LIT, ERT, ITT, PCAT,

SDTT, DCT, DLT, BIT, NBIT,
and LDT Icons

The following text information is displayed for the Service Description Table
(SDT), Bouquet Association Table (BAT), Event Information Table (EIT),
Running Status Table (RST), Stuffing Table (ST), Discontinuity Information
Table (DIT), Selection Information Table (SIT), Local event Information Table
(LIT), Event Relation Table (ERT), Index Transmission Table (ITT), Partial
Content Announcement Table (PCAT), Software Download Trigger Table
(SDTT), Download Control Table (DCT), DownLoad Table (DLT), Broadcaster
Information Table (BIT), Network Board Information Table (NBIT), and Linked
Description Table (LDT) icons:

PID: Shows the PID value of the SDT, BAT, EIT, RST, ST, DIT, SIT, LIT,
ERT, ITT, PCAT, SDTT, DCT, DLT, BIT, NBIT, or LDT.

TblID: Shows the table_id value of the SDT, BAT, EIT, RST, ST, DIT, SIT,
LIT, ERT, ITT, PCAT, SDTT, DCT, DLT, BIT, NBIT, or LDT.

TDT and TOT Icons The following text information is displayed for the Time and Data Table (TDT)
and Time Offset Table (TOT) icons:

PID: Shows the PID value of the TDT or TOT.

TblID: Shows the table_id value of the TDT or TOT.
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MGT and PIT Icons The following text information is displayed for the Master Guide Table (MGT)
and Program Identifier Table (PIT) icons:

PID: Shows the PID value of the MGT or PIT.

TblID: Shows the table_id value of the MGT or PIT.

TVCT, CVCT, RRT, EIT,
CETT, and EETT Icons

The following text information is displayed for the Terrestrial Virtual Channel
Table (TVCT), Cable Virtual Channel Table (CVCT), Rating Region Table (RRT),
Event Information Table (EIT), Channel Extended Text Table (CETT), and Event
Extended Text Table (EETT) icons:

PID: Shows the PID value of the TVCT, CVCT, RRT, EIT, CETT, or EETT.

TblID: Shows the table_id value of the TVCT, CVCT, RRT, EIT, CETT, or
EETT.

TblType: Shows the table_type value of the TVCT, CVCT, RRT, EIT, CETT,
or EETT.

System Time Table (STT)
Icon

The following text information is displayed for the System Time Table (STT) icon:

PID: Shows the PID value of the STT.

TblID: Shows the table_id value of the STT.
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Programming Information
This section contains information on the Standard Commands for Programmable
Instruments (SCPI) and IEEE 488.2 Common Commands you can use to program
your generator.

Syntax
This section contains information on the Standard Commands for Programmable
Instruments (SCPI) and IEEE 488.2 Common Commands you can use to program
your generator.

SCPI Commands and
Queries

SCPI is a standard created by a consortium that provides guidelines for remote
programming of instruments. These guidelines provide a consistent programming
environment for instrument control and data transfer. This environment uses
defined programming messages, instrument responses, and data format across all
SCPI instruments, regardless of the manufacturer. The generator uses a command
language based on the SCPI standard.

The SCPI language is based on a hierarchical or tree structure that represents a
subsystem. The top level of the tree is the root node; it is followed by one or
more lower-level nodes. (See Figure 24.)

Figure 24: Example of SCPI subsystem hierarchy tree

You can create commands and queries from these subsystem hierarchy trees.
Commands specify actions for the instrument to perform. Queries return
measurement data and information about parameter settings.

Creating Commands SCPI commands are created by stringing together the nodes of a subsystem
hierarchy and separating each node by a colon.

In Figure 342, RECord is the root node and TARGet, TYPE, SIZE, and TIME are
lower-level nodes. To create a SCPI command, start with the root node RECord
and move down the tree structure adding nodes until you reach the end of a
branch. Most commands and some queries have parameters; you must include a
value for these parameters. If you specify a parameter value that is out of range,
the parameter will be set to a default value.
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For example, RECord:TARGet:TYPE DISK is a valid SCPI command created
from the hierarchy tree in this example.

Creating Queries To create a query, start at the root node of a tree structure, move down to the end
of a branch, and add a question mark. RECord:TARGet:TYPE? is an example of
a valid SCPI query using the hierarchy tree. (See Figure 24.)

Parameter Types Every parameter in the command and query descriptions is of a specified type.
The parameters are enclosed in brackets, such as <pattern>. The parameter type is
listed after the parameter and is enclosed in parentheses, for example, (discrete).
Some parameter types are defined specifically for the generator command set and
some are defined by ANSI/IEEE 488.2-1987. (See Table 18.)

Table 18: Parameter types used in syntax descriptions
Parameter type Description Example
binary Binary numbers #B0110
arbitrary block 1 A specified length of

arbitrary data
#512234xxxxx . . . where
5 indicates that the following
5 digits (12234) specify the
length of the data in bytes;
xxxxx ... indicates the data

boolean Boolean numbers or values ON or 1, OFF or 0
discrete A list of specific value MIN, MAX, UP, DOWN
hexadecimal Hexadecimal numbers (0-9,

A, B, C, D, E, F)
#HAA, #H1

NR1 2, 3 numeric Integers 0, 1, 15, -1
NR2 2 numeric Decimal numbers 1.2, 3.141516, -6.5
NR3 2 numeric Floating point numbers 3.1415E-9, -16.1E5
NRf 2 numeric Flexible decimal number

that may be type NR1, NR2,
or NR3

See NR1, NR2, NR3
examples

string 4 Alphanumeric characters
(must be within quotation
marks)

“Testing 1,2,3”

1 Defined in ANSI/IEEE 488.2 as “Definite Length Arbitrary Block Response Data.”
2 An ANSI/IEEE 488.2-1992-defined parameter type.
3 Some commands and queries will accept a hexadecimal value even though the parameter type is defined as NR1.
4 Defined in ANSI/IEEE 488.2 as “String Response Data.”

Abbreviating Commands,
Queries, and Parameters

You can abbreviate most SCPI commands, queries, and parameters to an accepted
short form. This manual shows these short forms as a combination of upper and
lower case letters. The upper case letters indicate the accepted short form of a
command. You can create a short form by using only the upper case letters. (See
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Figure 25.) The accepted short form and the long form are equivalent and request
the same action of the instrument.

Figure 25: Example of abbreviating a command

Chaining Commands and
Queries

You can chain several commands or queries together into a single message. To
create a chained message, first create a command or query, add a semicolon (;),
and then add more commands or queries and semicolons until you are done. If the
command following a semicolon is a root node, precede it with a colon (:). The
following figure illustrates a chained message consisting of several commands
and queries. The single chained message should end in a command or query, not a
semicolon. Responses to any queries in your message are separated by semicolons.

Figure 26: Example of chaining commands and queries

If a command has the same root and lower-level nodes as the previous command,
you can omit these nodes. For example, the second command has the same root
node (REC) and lower level node (TARG) as the first command, so these nodes
can be omitted. (See Figure 27.)
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Figure 27: Example of omitting root and lower-level nodes in a chained message

General Rules Here are three general rules for using SCPI commands, queries, and parameters:

You can use single (‘ ’) or double (“ ”) quotation marks for quoted strings, but
you cannot use both types of quotation marks for the same string.

correct: “This string uses quotation marks correctly.”

correct: ‘This string also uses quotation marks correctly.’

incorrect: “This string does not use quotation marks correctly.’

You can use upper case, lower case, or a mixture of both cases for all
commands, queries, and parameters.

RECORD:TARGET:TRIGGER:POSITION 50

is the same as

record::position target:trigger50

and

RECORD:target:trigger:POSITION 50

NOTE. Literal strings (quoted) are case sensitive. For example: file names.

No embedded spaces are allowed between or within nodes.

correct: RECORD:TARGET:TRIGGER:POSITION 50

incorrect: RECORD: TARGET: TRIGGER: POSI TION 50

IEEE 488.2 Common
Commands

Description. ANSI/IEEE Standard 488.2 defines the codes, formats, protocols,
and usage of common commands and queries used on the interface between the
controller and the instruments. The generator complies with this standard.

Command and Query Structure. The syntax for an IEEE 488.2 common command
is an asterisk (*) followed by a command and, optionally, a space and parameter
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value. The syntax for an IEEE 488.2 common query is an asterisk (*) followed
by a query and a question mark. All of the common commands and queries are
listed in the last part of the Syntax and Commands section. The following are
examples of common commands:

*ESE 16

*CLS

The following are examples of common queries:

*ESR?

*IDN?

Backus-Naur Form Definition. This manual may describe commands and queries
using the Backus-Naur Form (BNF) notation. (See Table 19.)

Table 19: BNF symbols and meanings
Symbol Meaning
< > Defined element
: := Is defined as
| Exclusive OR
{ } Group; one element is required
[ ] Optional; can be omitted
. . . Previous element(s) may be repeated
( ) Comment

Remote Commands
This section describes the remote command set that is used in the generator. The
commands for the generator are divided into the following six groups:

Common commands

DISPLAY commands

MASS MEMORY commands

PLAY commands

RECORD commands

SYSTEM commands

This section also contains commands that are used to control the optional interface
cards.

You can connect and set up the generator for remote operation through the LAN
port on the rear panel.
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Common Commands The Common commands have a “*” prefix and address of all the instruments
that support IEEE 488.2.

Table 20: Common command description
Variable Description
*CLS Clears SESR (Standard Event Status Register), the SBR

(Status Byte Register), and Event Queue, which are used in the
instrument status and event reporting system.

*ESE Sets the bits of the ESER (Event Status Enable Register) used
in the status and events reporting system.

*ESE? Returns the contents of the ESER.
*ESR? Returns the contents of SESR (Standard Event Status Register)

used in the status and events reporting system.
*IDN? Returns the ID information of the instrument. The ID information

contains manufacturer, model, firmware version, hardware
version, and FPGA code version.

*LRN? Returns the current instrument settings.
*OPC Causes bit 0 in the SESR (Standard Event Status Register)

to be set, and the operation complete message to be issued,
when all pending operations are finished. This command is only
available just after the :PLAY:STARt or :RECord:STARt

command is executed.
*OPT? Waits until all pending operations are finished and returns a

“1” ASCII character. This query is only available just after the
:PLAY:STARt or :RECord:STARt command is executed.

*OPC? Returns the installed interface option.
*RST Resets the instrument to the factory default state. This command

has the same effect when the :SYSTem:PRESet and *CLS
commands are executed successively.

*SRE Sets the bits of the SRER (Service Request Enable Register).
*SRE? Returns the contents of SRER
*STB? Returns the value of the SBR (Status Byte Register). Bit 6 of the

SBR is read as a MSS (Master Status Summary) bit.
*TRG Generates a trigger event.
*TST? Performs the self test and returns its result. The generator Series

always returns 1.
*WAI Wait-to-continue command. This command is not necessary

because the generator Series handles commands sequentially.
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DISPLAY Commands Use these commands to select a display format of the base value in the hierarchy
display.

Variable name Valid values Description
:DISPlay:VIEW:FORMat HEXadecimal|DECimal|OCTal

The choices are HEXadecimal,
DECimal, and OCTal. The
default value is HEXadecimal.

Sets the base value used to describe the
component information in the hierarchy display.

:DISPlay:VIEW:FORMat? Returns the current display format of the base
value in the hierarchy display.

MASS MEMORY
Commands

Use these commands to perform file related operations such as changing and
moving a directory, and loading and saving a preset.

Variable name Valid values Description
:MMEMory:CATalog? [<directory_path>]

The query response is as follows:
<used _bytes>, <available_bytes>,
“<file_name>, <directory_flag>,
<file_size>, <date>,<time>”...

Lists the files in the specified directory.

:MMEMory:CDIRectory[:DATA] [<directory_path>] Changes the current directory for data files.
<directory_path> is a quoted string that defines the
directory path. The default value is D:.

:MMEMory:CDIRectory[:DATA]? Returns the current directory for data files.
:MMEMory:CDIRectory:STATe <directory_path>

<directory_path> is a quoted string
that defines the directory path. The
default value is D:.

Changes the current directory for setting files.

:MMEMory:CDIRectory:STATe? Returns the current directory for setting files.
:MMEMory:LOAD:STATe <preset_name> Loads the specified preset. <preset_name> is a

quoted string that defines the preset name. This
command accepts the name of a previously saved
preset. Current instrument settings are overwritten
by this command.

:MMEMory:MDIRectory <directory_path> Creates a subdirectory. The command is invalid if a
directory with the specified name already exists.

:MMEMory:STORe:STATe <preset_name> Saves the instrument settings with the specified
preset name. <preset_name> is a quoted string
that defines the preset name.
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PLAY Commands Use these commands to set parameters related to the stream output. These include
packet size, output clock rate, data output source, and PCR jitter insertion.

Table 21: RTX100B and RTX130B common PLAY commands
Variable name Valid values Description
:PLAY:AUTOplay ON|OFF

You can use 1 or 0 instead of ON or
OFF. The default value is OFF.

Sets whether the selected stream is
automatically output using the last
power-off settings when you turn the
generator on.

:PLAY:AUTOplay? Returns the current auto play mode status.
:PLAY:PROGress? Returns the current percentage of progress

of the play.
:PLAY:CLOCk:DEFault:RATE <numeric_value>

You can set the rate from 0.001 MHz
to 250.0 MHz.
The default value is 56.61.

Sets the default clock rate that is
automatically set when the selected stream
file is downloaded. Since the clock rate
is calculated based on the PCRs in the
file, the value may be different from the
original clock rate. If this happens, you
can set the appropriate value by this
command. If you change the value, the
:PLAY:CLOCk:RATE command setting
will set to the same value.

:PLAY:CLOCk:DEFault:RATE? Returns the default clock rate that is
automatically set when the selected stream
file was downloaded.

:PLAY:CLOCk:DEFault:RATE

:RATIo

<numeric_value>,

<numeric_value>

You can set both values from 0 to
2000000000.
The default values are 629 for
the numerator and 300 for the
denominator.

Sets the default clock rate that is
automatically set when the selected stream
file is downloaded using a fraction. Since
the clock rate is calculated based on the
PCRs in the file, the value may be different
from the original clock rate. If this happens,
you can set the appropriate value by this
command. The first argument represents
a numerator and the second represents
a denominator. If you change the value,
the :PLAY:CLOCk:RATE:RATIo

command setting will set to the same value.
:PLAY:CLOCk:DEFault:RATE
:RATIo?

Returns the default clock rate that is
automatically set when the selected stream
file is downloaded using a fraction.

:PLAY:CLOCk:ESRAtefixed ON|OFF

You can use 1 or 0 instead of ON or
OFF. The default value is OFF.

Sets whether the elementary stream rate is
fixed. When you select ON, the elementary
stream rate becomes constant regardless
of the clock rate setting.
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Table 21: RTX100B and RTX130B common PLAY commands (cont.)

Variable name Valid values Description
:PLAY:CLOCk:ISDBT:CONVert ON|OFF

You can use 1 or 0 instead of ON or
OFF. The default value is ON.

Sets whether the clock rate is automatically
set when the data file for ISDB-TSB is
loaded. When you select ON, the clock
rate is automatically set to (2048/1701)
x 27 MHz and the elementary stream
rate becomes constant regardless of
the :PLAY:CLOCk:ESRAtefixed

command setting.
:PLAY:CLOCk:ISDBT:CONVert? Returns whether the clock rate is

automatically set when the data file for
ISDB-TSB is loaded.

:PLAY:CLOCk:ESRAtefixed? Returns the current elementary stream rate
status.

:PLAY:CLOCk:RATE <numeric_value>

You can set the rate from 0.001 MHz
to 250.0 MHz. The default value is
56.61.

Sets the clock rate for the stream output.

:PLAY:CLOCk:RATE? Returns the current clock rate for the
stream output.

:PLAY:CLOCk:RATE

:RATIo

<numeric_value>,

<numeric_value>

You can set both values from 0 to
2000000000. The default values are
629 for the numerator and 300 for the
denominator.

Sets the clock rate for the stream output
using a fraction. The first argument
represents a numerator and the second
represents a denominator.

:PLAY:CLOCk:RATE:RATIo? Returns the current clock rate for the
stream output using a fraction.
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Table 21: RTX100B and RTX130B common PLAY commands (cont.)

Variable name Valid values Description
:PLAY:CLOCk:SOURce INTernal|EXT10M

|EXT27M|EXTIfft

|EXTParallel|EXTSerial
The choices are:
INTernal: uses the internal clock.
EXT10M: uses a 10 MHz signal on the
Clock/Ref In connector.
EXT27M: uses a 27 MHz signal on the
Clock/Ref In connector.
EXTIfft: uses an IFFT sample
clock signal (8.126984 MHz) on the
Clock/Ref In connector.
EXTParallel: uses a clock signal
on the Clock/Ref In connector as a
parallel clock.
EXTSerial: uses a clock signal on the
Clock/Ref In connector as a serial
clock.

Sets which clock to use as the reference
for the stream output.

:PLAY:CLOCk:SOURce? Returns the current reference clock for the
stream output.

:PLAY:EXTernal RISE|FALL|OFF

The choices are RISE, FALL, and
OFF. When you select RISE, the
stream output is started at the rising
edge of the applied trigger signal.
When you select FALL, the stream
output is started at the falling edge of
the applied trigger signal. The default
value is OFF.

Sets whether to start stream output using
a trigger signal applied to the Trig In/Out
connector.

:PLAY:EXTernal? Returns whether to start stream output
using a trigger signal applied to the Trig
In/Out connector.

:PLAY:EXTTrigger:BNC INPUt|OUTPut

For INPUt, the connector can be used
to input an external trigger signal. For
OUTPut, the connector can be used to
output a 27 MHz reference clock or an
ISDB-T frame pulse signal. Use the
:PLAY:EXTTrigger:OUTPut:SELEct

command to select which signal is
output from the connector.
The default value is INPUt.

Sets whether to use the rear-panel Trig
In/Out connector as an input or an output.

:PLAY:EXTTrigger:BNC? Returns the current input/output status of
the Trig In/Out connector.
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Table 21: RTX100B and RTX130B common PLAY commands (cont.)

Variable name Valid values Description
:PLAY:EXTTrigger:OUTPut

:DELAy

<numeric_value>

You can set the value from 0 to 15.
The default value is 0.

Sets the amount of delay for the start
packet pulse of the ISDB-T frame in
1-parallel clocks of the SPI output.

:PLAY:EXTTrigger:OUTPut

:DELAy?
Returns the current delay for the start
packet pulse of the ISDB-T frame.

:PLAY:EXTTrigger:OUTPut

:SELEct

C27M|ISDBT

The choices are C27M and ISDBT.
For C27M, a 27 MHz reference clock
signal is output. For ISDBT, an ISDB-T
frame pulse signal is output. The
default value is C27M.

Selects which signal to output from
the Trig In/Out connector when the
:PLAY:EXTTrigger:BNC command is
set to OUTPut.

:PLAY:EXTTrigger:OUTPut:SELEct? Returns the current output signal selection
when the Trig In/Out connector is used as
an output.

:PLAY:LOAD:FILE <file_name> Returns the name of the file currently
loaded.

:PLAY:LOOP ON|OFF

The default value is ON.
Sets whether the selected stream is output
using the looping method. When you select
ON, the stream is continuously output.

:PLAY:LOOP? Returns the current output loop mode
status.

:PLAY:LOOP:ISDBT:FRAMe ON|OFF

You can use 1 or 0 instead of ON or
OFF. The default value is ON.

Sets whether to output an ISDB-T transport
stream in OFDM frames when looped.
When you select OFF, an ISDB-T transport
stream is looped in packets.

:PLAY:LOOP:ISDBT:FRAMe? Returns whether to output an ISDB-T
transport stream in OFDM frames when
looped.

:PLAY:PACKet 188|204|208|NONTs

The choices are 188, 204, 208, and
NONTs (Non-TS). The default value
is 188.

Sets the packet size for the selected stream
file.

:PLAY:PACKet? Returns the current packet size setting for
the selected stream file.

:PLAY:PCR:INITial <numeric_value>,

<numeric_value>

You can set the
program_clock_reference_base value
from 0 to 8589934591 and set the
program_clock_reference_extension
value from 0 to 299. The default
values for both are 0.

Sets the initial value of the
program_clock_reference_base and
program_clock_reference_extension
parameters.
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Table 21: RTX100B and RTX130B common PLAY commands (cont.)

Variable name Valid values Description
:PLAY:PCR:INITial? Returns the current initial value of the

program_clock_reference_base and
program_clock_reference_extension
parameters.

:PLAY:SPIOutput ON|OFF

You can use 1 or 0 instead of ON or
OFF. The default value is ON

Sets whether the signal output from the SPI
In/Out connector is enabled.

:PLAY:PCR:INACcuracy NONE|SINe|SQUare|TRIangle

|PULSe|SAW|RANDom|OFFSet

[<PID>,<amplitude>

[<period>[,<pulse_width>]]],

The ranges of each argument are as
follows:
PID: 0 to 8191
Amplitude: 0 to 135000000
Period: 5 to 3000
Pulse width: 1 to (period -1)

Sets the PCR jitter insertion. Use the first
argument to set the waveform type used
to add jitter. When NONE is selected, the
jitter insertion is disabled. Use the SINe,
SQUare, TRIangle, PULSe, and SAW
arguments to set the PID of the PCRs,
the amplitude of the waveform, the period
of the waveform, and pulse width of the
waveform. The pulse width is available
only when the waveform is set to PULSe.

:PLAY:PCR:INACcurracy? Returns the current PCR jitter insertion
settings.

:PLAY:S192F:PARTialts ON|OFF

You can use 1 or 0 instead of ON or
OFF. The default value is ON.

Sets whether to output a stream file
consisting of a 192-byte packet as a partial
transport stream. When you select OFF,
the stream is output in Non-TS format.

:PLAY:S192F:PARTialts? Returns whether to output a stream file
consisting of a 192-byte packet as a partial
transport stream.

:PLAY:SOURce RAM|DISK

The choices are RAM (system RAM)
and DISK (hard disk). The default
value is DISK.

Sets the source for stream output.

:PLAY:SOURce? Returns the current source setting for
stream output.

:PLAY:SPIOutput ON|OFF

You can use 1 or 0 instead of ON or
OFF. The default value is ON

Sets whether the signal output from the SPI
In/Out connector is enabled.

:PLAY:SPIOutput? Returns the current output status of the SPI
In/Out connector.

:PLAY:SSPOsition:INITial:ENABle ON|OFF

You can use 1 or 0 instead of ON or
OFF. The default value is OFF.

Sets whether to enable the initial start
position setting of the selected stream to
be looped.

:PLAY:SSPOsition:INITial:ENABle? Returns the current state of the initial start
position setting.
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Table 21: RTX100B and RTX130B common PLAY commands (cont.)

Variable name Valid values Description
:PLAY:SSPOsition:INITial

[:POSition]

<numeric_value> Sets the initial start position of the
selected stream to be looped by the
number of packets (the number of
super frames for an M-TMCC file, or
the number of bytes for a Non-TS
file). The setting range depends on the
:PLAY:SSPOsition[:POSition]

command settings. The default value is 0.
:PLAY:SSPOsition:INITial[:POSition]? Returns the current initial start position

of the selected stream by the number of
packets.

:PLAY:SSPOsition:INITial:TIME <string>

The default value is 00:00:00.
Sets the initial start position of the selected
stream to be looped by time (hh:mm:ss).
The setting range depends on the
:PLAY:SSPOsition:TIME command
settings.

:PLAY:SSPOsition:INITial:TIME? Returns the current initial start position of
the selected stream by time.

:PLAY:SSPOsition[:POSition] <numeric_value>,

<numeric_value>

You can set the positions from 0
to (available maximum value of the
selected stream file). The default
values for both are 0.

Sets the loop start and stop positions of
the selected stream to be looped by the
number of packets (the number of super
frames for M-TMCC file, or the number of
bytes for a Non-TS file). Specify the start
position in the first argument and specify
the stop position in the second argument.

:PLAY:SSPOsition[:POSition]? Returns the current loop start and stop
position settings of the selected stream by
the number of packets.

::PLAY:SSPOsition:INITial:TIME <string>,<string>

You can set the time from 0 to
(available maximum value of the
selected stream file). The default
values for both are 00:00:00.

Sets the loop start and stop positions of
the selected stream to be looped by time
(hh:mm:ss). Specify the start time in the
first argument and specify the stop time in
the second argument.

:PLAY:SSPOsition:TIME? Returns the current loop start and stop
position settings of the selected stream by
time (hh:mm:ss).

:PLAY:STANdard? The available responses are
MPEG, ARIB, ATSC, DVB, NONTs,
MTMCc, STMCc, or ISDBT. The
MTMCc, STMCc, and ISDBT
standards are checked only when the
:SYSTem:STANdard command is
set to ARIB

Returns the standard of the loaded stream
file.

:PLAY:STARt Starts outputting the selected stream.
There are no arguments.
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Table 21: RTX100B and RTX130B common PLAY commands (cont.)

Variable name Valid values Description
:PLAY:STOP Stops outputting the selected stream.

There are no arguments.
:PLAY:SYNC TSPAcket|SF|NONTs

For TSPAcket, a single pulse signal is
output at the start point of each packet.
For SF, a single pulse is output at the
start point of the SF appearing every
204x48x8 bytes. For NONTs, you
can set the output period and data
width of the PSYNC signal using the
:PLAY:SYNC:PSYNc:INTerval

command and
:PLAY:SYNC:PSYNc:WIDTh

commands. SF is available only
when MTMCc is returned by the
:PLAY:STANdard? query. The
default value is TSPAcket.

Sets the format of the PSYNC signal output
from the SPI In/Out connector.

:PLAY:SYNC? Returns the current format setting of the
PSYNC signal.

:PLAY:SYNC:DVALid:WIDTh NONE|<numeric_value>

You can set the width from 16 bytes
to 255 bytes.
The default value is 188.

Sets the status and data width of the
DVALID signal when NONTs is selected
in the :PLAY:SYNC command. When
you select NONE, the DVALID signal
is disabled. This value cannot be
set more than the value set by the
:PLAY:SYNC:PSYNC:INTerval
command.

:PLAY:SYNC:DVALid:WIDTh? Returns the current status and data width
of the DVALID signal.

:PLAY:SYNC:PSYNc:INTerval NONE|<numeric_value>

You can set the interval from 16 bytes
to 255 bytes. The default value is 188.

Sets the status and output period of the
PSYNC signal when NONTs is selected
in the :PLAY:SYNC command. When
you select NONE, the PSYNC signal
is disabled. This value must be set
equal to or greater than the value in
the :PLAY:SYNC:DVALid:WIDTh

command.
:PLAY:SYNC:PSYNc:INTerval? Returns the current status and output

period of the PSYNC signal.
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Table 21: RTX100B and RTX130B common PLAY commands (cont.)

Variable name Valid values Description
:PLAY:TIMEpacket:DEFine ,<numeric_value>,

<numeric_value>,

<numeric_value>,

<numeric_value>,

<numeric_value>,

<numeric_value>

The arguments are <year>,
<month>,<date>,<hour>,<minute>,and
<second>.You can set the values from
1900,3,1,0,0,0 to 2038,4,22,23,59,59
for the TDT and TOT and from
1980,1,6,0,0,0 to 2116,2,12,6,28,15
for the STT. The default values are
the current date and time.

Sets the initial values of the TDT, TOT,
or STT when USER is selected in the
:PLAY:TIMEpacket:MODE command.

:PLAY:TIMEpacket:DEFine? Returns the current data and time settings
of the TDT, TOT, or STT.

:PLAY:TIMEpacket:MODE ORIGinal|OS|USER

The choices are ORIGinal, SYSTem,
and USER. For ORIGinal, the
original (default) value defined
in the selected stream is used.
For OS, the clock/calendar of the
operating system is used. For
USER, you can set any value in the
:PLAY:TIMEpacket:DEFine

command. The default value is
ORIGinal.

Selects the reference time used to set the
initial value of the TDT, TOT, or STT when
the :PLAY:UPDAte command is set to
ON.

:PLAY:TIMEpacket:MODE? Returns the current reference time
selection used to set the initial value of the
TDT, TOT, or STT.

:PLAY:UPDAte ON|OFF

You can use 1 or 0 instead of ON or
OFF. The default value is ON.

Sets whether to update parameters in
a stream when looped. You can select
which parameters are updated using the
:PLAY:UPDAte:ITEM commands.

:PLAY:UPDAte? Returns the current update mode status.
:PLAY:UPDAte:ITEM:CC ON|OFF

You can use 1 or 0 instead of ON or
OFF. The default value is ON.

Sets whether to update continuity_counter
values when the :PLAY:UPDAte

command is set to ON.

:PLAY:UPDAte:ITEM:CC? Returns whether to update
continuity_counter values when the
:PLAY:UPDAte command is set to ON.
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Table 21: RTX100B and RTX130B common PLAY commands (cont.)

Variable name Valid values Description
:PLAY:UPDAte:ITEM:NPT ON|OFF

You can use 1 or 0 instead of ON or
OFF.
The default value is OFF.

Sets whether to update NPT values when
the :PLAY:UPDAte command is set
to ON. This command is only available
when the :PLAY:UPDAte:PCR

command is set to ON and the
:PLAY:UPDAte:ITEM:PCR:METHod

command is set to SOFTware.
:PLAY:UPDAte:ITEM:NPT? Returns whether to update NPT values

when the :PLAY:UPDAte command is
set to ON.

:PLAY:UPDAte:ITEM:PCR ON|OFF

You can use 1 or 0 instead of ON or
OFF. The default value is ON.

Sets whether to update PCR/PTS/DTS
values when the:PLAY:UPDAte
command is set to ON.

:PLAY:UPDAte:ITEM:PCR? Returns whether to update PCR/PTS/DTS
values when the :PLAY:UPDAte

command is set to ON.
:PLAY:UPDAte:ITEM:PCR:METHod HARDware|SOFTware

The choices are HARDware and
SOFTware. The default value is
HARDware.

Sets the method to update PCR/PTS/DTS
values.

:PLAY:UPDAte:ITEM:PCR:METHod? Returns the update method for
PCR/PTS/DTS values.

:PLAY:UPDAte:ITEM:REEDsolomon ON|OFF

You can use 1 or 0 instead of ON or
OFF. The default value is ON.

Sets whether to update Reed-Solomon
symbols in an ISDB-T transport stream
when the :PLAY:UPDAte command is
set to ON.

:PLAY:UPDAte:ITEM:REEDsolomon? Returns whether to update Reed-Solomon
symbols in an ISDB-T transport stream
when the :PLAY:UPDAte command is
set to ON.

:PLAY:UPDAte:ITEM:TIMEpacket ON|OFF

You can use 1 or 0 instead of ON or
OFF. The default value is ON.

Sets whether to update TDT/TOT/STT
values when the :PLAY:UPDAte

command is set to ON.

:PLAY:UPDAte:ITEM:TIMEpacket? Returns whether to update TDT/TOT/STT
values when the :PLAY:UPDAte

command is set to ON.
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Table 22: RTX100B-only PLAY commands
Variable Valid values
:PLAY:ISDBT:FREQuency:CHANnel <numeric_value>

You can set the channel from 13 to
62. The default value is 13.

Sets the center frequency (channel number)
for the RF modulated output of the broadcast
transport stream.

:PLAY:ISDTV:FREQuency:CHANnel? Returns the current center frequency
(channel number) setting for the ISDTV RF
modulated output of the broadcast transport
stream.

:PLAY:ISDBT:PLL:LOCKed? Returns the current lock status of the PLL
for the ISDBT RF modulated output. When
the PLL is locked to the clock source, 1 is
returned. When the PLL is not locked to the
clock source, 0 is returned.

:PLAY:ISDTV:PLL:LOCKed? Loads the specified stream file. <file_name>
is a quoted string that defines the file name.

Table 23: RTX130B– only PLAY commands
variable name Valid values Description
:PLAY:QAMVsb:INTerleave <numeric_value>. The default value is 1. Sets the operating mode and

modulation parameters (I and J) of
interleaving. You can set the value
from 0 to 13. (See Table 24.) This
command is only available when
the :PLAY:QAMVsb:STANdard
command is set to J83B and
:PLAY:QAMVsb:MODulation

command is set to M64Qam or
M256Qam.

:PLAY:QAMVsb:INTerleave:LEVEl? Returns the current operating mode
and modulation parameters of
interleaving.

:PLAY:QAMVsb:MODulation M16Qam|M64Qam

|M256Qam|M8Vsb

The available selections depend
on the standard that is selected by
the :PLAY:QAMVsb:STANdard

command. The default value is M8Vsb for
the ATSC standard and M64Qam for the
other standards.
The choices are M16Qam (16QAM),
M64Qam (64QAM), M256Qam (256QAM),
and M8Vsb (8VSB).

Sets the modulation mode.

:PLAY:QAMVsb:MODulation? Returns the current modulation mode
setting.
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Table 23: RTX130B– only PLAY commands (cont.)

variable name Valid values Description
:PLAY:QAMVsb:OUTPut:MODE RF|IF44M|IFR44M|

IF36M|IFR36M
The choices are RF (RF output), IF44M (44
MHz IF output), IFR44M (44 MHz IF output
that the spectrum is reversed), IF36M (36
MHz IF output), and IFR36M (36 MHz IF
output that the spectrum is reversed). The
default value is RF.

Sets the signal output from the RF Out
and IF Out connectors.

:PLAY:QAMVsb:OUTPut:MODE? Returns the current output status of the
RF Out and IF Out Connectors.

:PLAY:QAMVsb:PORT:THROughout ON|OFF

You can use 1 or 0 instead of ON or OFF.
The default value is ON.

Sets the throughout mode;
whether the signal applied to the
ASI/SMPTE Input connector is
output from the ASI/SMPTE Output
connector when a stream is not
output. This setting changes the
:RECord:QAMVsb:PORT:THROughout

command setting.
:PLAY:QAMVsb:PORT:THROughout? Returns the current throughout mode

status when a stream is not output.
:PLAY:QAMVsb:PORT:TYPE ASI|S310M

The choices are ASI and S310M
(SMPTE310M). The default value is ASI.

Sets which signal to output from the
ASI/SMPTE Output connector.

:PLAY:QAMVsb:PORT:TYPE? Returns the current output signal
selection.

:PLAY:QAMVsb:RF:FREQency <numeric_value>

You can set the value from 50.0 MHz to
860.0 MHz. The default value is 50.0 MHz.

Sets the center frequency of the RF
output signal.

:PLAY:QAMVsb:RF:FREQency? Returns the current center frequency
of the RF output signal.

:PLAY:QAMVsb:RF:LEVEl <numeric_value>

You can set the value from 45 dBmV to 58
dBmV. The default value is 45 dBmV.

Sets the RF signal output level.

:PLAY:QAMVsb:RF:LEVEl? Returns the current RF signal output
level.

:PLAY:QAMVsb:STANdard J83A|J83B|J83C|J83CJ|ATSC

The choices are J83A (DVB-C/ITU-T J.83
Annex A), J83B (ITU-T J.83 Annex B),
J83C (ITU-T J.83 Annex C), J83CJ (ITU-T
J.83 Annex C-JCTEC), and ATSC. The
available selections depend on the installed
options.

Sets the RF modulation standard.

:PLAY:QAMVsb:STANdard? Returns the current RF modulation
standard.
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Table 23: RTX130B– only PLAY commands (cont.)

variable name Valid values Description
:PLAY:QAMVsb:STANdard:CATalog? Lists the RF modulation standards that

are installed in the instrument.
:PLAY:QAMVsb:SYMBol:RATE <numeric_value>

You can set the value from 1.0 to 6.956532
Msps for J83A and from 1.0 to 5.274 for
J83C. The default value is 1.0 Msps.

Sets the symbol rate when the
:PLAY:QAMVsb:ATANdard
command is set to J83A or J83C.

:PLAY:QAMVsb:SYMBol:RATE? Returns the current symbol rate setting.

Table 24: RTX130B operating mode and modulation parameters
Setting value Operating mode and modulation parameters
0 Level 1: I=128 J=1
1 Level 2: I=128 J=1
2 Level 2: I=64 J=2
3 Level 2: I=32 J=4
4 Level 2: I=16 J=8
5 Level 2: I=8 J=16
6 Level 2: I=128 J=1
7 Level 2: I=128 J=2
8 Level 2: I=128 J=3
9 Level 2: I=128 J=4
10 Level 2: I=128 J=5
11 Level 2: I=128 J=6
12 Level 2: I=128 J=7
13 Level 2: I=128 J=8
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RECORD Commands Use these commands to set parameters related to the data record. These include
input interface, record size, and trigger position.

Variable name Valid values Description
:RECord:ACQuire:STARt Starts input stream acquisition. When

two or more record commands are
sent to the instrument successively,
the instrument stops stream acquisition
and then starts stream acquisition
for each command. Therefore, when
many commands are sent to the
instrument, it takes a long time to
complete all settings. If you send
the :RECord:ACQuire:STOP
command before sending
record commands and send the
:RECord:ACQuire:STARt

command after sending record
commands, you can shorten the setting
time.

:RECord:ACQuire:STOP Stops input stream acquisition. Refer
to the :RECord:ACQuire:STARt
command description on how to use this
command.

:RECord:PROGress? Returns the current percentage of
progress of the record.

:RECord:CLOCk:RATE? Returns the clock rate of the input stream
in MHz.

:RECord:EXTernal RISE|FALL|OFF

The choices are RISE, FALL, and
OFF. When you select RISE, the
input stream record is started at the
rising edge of the applied trigger
signal. When you select FALL, the
input stream record is started at the
falling edge of the applied trigger
signal. The default value is OFF.

Sets whether to start input stream record
using a trigger signal applied to the Trig
In/Out connector.

:RECord:EXTernal? Returns whether to start input stream
record using a trigger signal applied to
the Trig In/Out connector.

:RECord:SOURce SPI|ASI|UNIVersal|I1394I

|S310M|STANdard|OPTion

The choices are SPI, ASI,
UNIVersal, I1394I (IEEE1394),
S310M (SMPTE310M), STANdard
(same as SPI), and OPTion
(optional interface currently
installed). The default value is SPI.

Sets the interface used to capture a
stream data.
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Variable name Valid values Description
:RECord:SOURce? Returns the current interface used to

capture a stream data.
:RECord:STORe:FILE <file_name> Specifies the file name used when the

input stream is saved.
:RECord:STANdard? The available responses are

MPEG, ARIB, ATSC, DVB,
NONTs, MTMCc, STMCc, or
ISDBT. The MTMCc, STMCc, and
ISDBT standard are checked only
when the :SYSTem:STANdard
command is set to ARIB. When
the RECord:I1394I PARTialts
command is set to ON, the
response is P_TS.

Returns the current standard used to
display the input stream.

:RECord:STARt Starts recording the input stream.
:RECord:STOP Stops recording the input stream.
:RECord:STORe:FILE? Returns the current file name used when

the input stream is saved.
:RECord:STORe:MODE NEWfile|OVERwrite

The choices are NEWfile and
OVERwrite. For NEWfile, a new
file is created whenever you save
a stream file. The file name
is the name specified by the
:RECord:STORe:FILE command +
# (1, 2, 3, 4...). For OVERwrite, the
existing file is overwritten by the
new file with the name specified
in the :RECord:STORe:FILE
command. The default value is
OVERwrite.

Sets the save mode when the input
stream is saved.

:RECord:STORe:MODE? Returns the current save mode setting
when the input stream is saved.

:RECord:TARGet:IGNOredvalid ON|OFF

You can use 1 or 0 instead of ON
or OFF. The default value is OFF.

Sets whether the instrument ignores
the DVALID signal from the selected
interface when a stream data is acquired.
When you select ON, the instrument
ignores the DVALID signal, and the
stream data is acquired according to the
internal clock signal.

:RECord:TARGet:IGNOredvalid? Returns whether the instrument ignores
the DVALID signal from the selected
interface when a stream data is acquired.
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:RECord:TARGet:SIZE <numeric_value>

You can set the file size from 1 to
free space of the system RAM or
hard disk.
The default value is 50 MB.

Sets the file size to record the input
stream in MB. This setting changes the
:RECord:TARGet:TIME command
setting.

:RECord:TARGet:SIZE? Returns the current file size setting to
record the input stream.

:RECord:TARGet:TIME <string> The minimum value
of the setting range depends on
the clock rate of the input stream.
The maximum value of the setting
range depends on the free space
of the RAM or hard disk, or the
clock rate of the input stream.The
default value is 00:00:00.

Sets the recording time (hh:mm:ss)
to record the input stream.
This setting changes the
:RECord:TARGet:SIZE command
setting.

:RECord:TARGet:TIME? Returns the current recording time
(hh:mm:ss) to record the input stream.

:RECord:TARGet:TRIGger:CONTinuous ON|OFF

You can use 1 or 0 instead of ON
or OFF.

Turns Continuous Recording on or off.
When you select ON, you can record
multiple stream files continuously on the
hard disk. The default value is OFF.

:RECord:TARGet:TRIGger:CONTinuous? Returns the current Continuous
Recording state.

:RECord:TARGet:TRIGger:CONTinuous

:LIMit

<numeric_value>

You can set the value from 2 to
32767. The default value is 32767.

Sets the number of files to stop
continuous recording.

:RECord:TARGet:TRIGger:CONTinuous

:LIMit?
Returns the number of files to stop
Continuous Recording.

:RECord:TARGet:TRIGger:POSition <numeric_value>

You can set the trigger position
from 0% to 100%. The default
value is 0%.

Sets the trigger position used to record
the input stream.

:RECord:TARGet:TRIGger:POSition? Returns the current trigger position
setting.

:RECord:TARGet:TYPE RAM|DISK

The choices are RAM and DISK
(hard disk). The default value is
DISK.

Sets the record target used to record the
input stream.

:RECord:TARGet:TYPE? Returns the current record target used to
record the input stream.
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:RECord:TARGet:TRIGger:UNLImit ON|OFF

You can use 1 or 0 instead of ON
or OFF. The default value is OFF.

Sets whether to record the input stream
to the full free space in the hard disk or
RAM.

:RECord:TARGet:TRIGger:UNLImit? Returns whether to record the input
stream to the full free space in the hard
disk or RAM.

Table 25: RTX100B-only RECORD commands
Variable name Valid values Description
:RECord:ISDBT:CLOCk:SOURce ASI|EXT10M|EXT27M|EXTIfft

The choices are ASI, EXT10M (an external
10 MHz signal), EXT27M (an external 27
MHz signal), and EXTIfft (an external signal
equivalent to an IFFT sample clock rate).
The default value is ASI.

Sets the reference clock used
for the RF modulated output
of the broadcast transport
stream applied to the ASI In
connector. This setting changes
the :PLAY:CLOCk:SOURce

command setting.
:RECord:ISDBT:CLOCk:SOURce? Returns the current reference clock

used for the RF modulated output
of the broadcast transport stream
applied to the ASI In connector.

:RECord:ISDBT:FREQuency:CHANnel <numeric_value>

You can set from channel 13 to channel 62.
The default value is 13.

Sets the center frequency (channel
number) for the RF modulated
output of the broadcast transport
stream applied to the ASI In
connector. This setting changes the
:PLAY:ISDBT:FREQuency:CHANnel

command setting.
:RECord:ISDBT:FREQuency:CHANnel? Returns the current center frequency

(channel number) setting for the
ISDBT RF modulated output of the
broadcast transport stream that is
applied to the ASI In connector.

:RECord:ISDBT:PLL:LOCKed? Returns the current lock status of
the PLL for the ISDBT RF modulated
output. When the PLL is locked
to the clock source, 1 is returned.
When the PLL is not locked to the
clock source, 0 is returned.

:RECord:SOURce? Returns the current interface used
to capture a stream data.
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Table 25: RTX100B-only RECORD commands (cont.)

Variable name Valid values Description
:RECord:ISDBT:CLOCk:SOURce ASI|EXT10M|EXT27M|EXTIfft

The choices are
ASI,
EXT10M (an external 10 MHz signal),
EXT27M (an external 27 MHz signal),
and EXTIfft (an external signal equivalent to
an IFFT sample clock rate).
The default value is ASI.

Sets the reference clock used for
the ISDBT RF modulated output
of the broadcast transport stream
applied to the ASI In connector.
This command changes the
:PLAY:CLOCk:SOURce setting.

:RECord:ISDBT:CLOCk:SOURce? Returns the current reference clock
used for the ISDBT RF modulated
output of the broadcast transport
stream applied to the ASI In
connector.

:RECord:ISDBT:FREQuency:CHANnel <numeric_value>

You can set from channel 13 to channel 62.
The default value is 13.

Sets the center frequency (channel
number) for the RF modulated
output of the broadcast transport
stream applied to the ASI In
connector. This setting changes the
:PLAY:ISDBT:FREQuency:CHANnel

command setting.
:RECord:ISDBT:FREQuency:CHANnel?? Returns the current center frequency

(channel number) setting for the RF
modulated output of the broadcast
transport stream that is applied to
the ASI In connector.

:RECord:ISDBT:PLL:LOCKed? Returns the current lock status of the
PLL for the RF modulated output.
When the PLL is locked to the clock
source, 1 is returned. When the PLL
is not locked to the clock source, 0
is returned.

:RECord:PACKet? The available responses are 188, 204, 208,
or NONTs.

Returns the packet size of
the input stream. When the
:RECord:I1394I:PARTialts

command is set to ON, the response
is 192.
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Table 26: RTX130B-only RECORD commands
Variable name Valid values Description
:RECord:QAMVsb:CLOCk:SOURce ASYNc|EXT10M|EXT27M

The choices are ASYNc (the internal clock,
which is not synchronized with an ASI signal
or SMPTE310M signal), EXT10M (an external
10 MHz signal), and EXT27M (an external 27
MHz signal).
The default value is ASYNc.

Sets the reference signal
used for the RF modulated
output of the transport stream
applied to the ASI/SMPTE Input
connector. This setting changes
the :PLAY:CLOCk:SOURce
command setting.

:RECord:QAMVsb:CLOCk:SOURce? Returns the current reference
signal used for the RF modulated
output of the transport stream
applied to the ASI/SMPTE Input
connector.

:RECord:QAMVsb:PORT:THROughout ON|OFF

You can use 1 or 0 instead of ON or OFF.
The default value is ON.

Sets the throughout mode;
whether the signal applied
to the ASI/SMPTE Input
connector is output from the
ASI/SMPTE Output connector.
This setting changes the
:PLAY:QAMVsb:PORT:THROughout

command setting.
:RECord:QAMVsb:PORT:THROughout? Returns the current throughout

mode status.
:RECord:QAMVsb:PORT:TYPE ASI|S310M

The choices are ASI and S310M
(SMPTE310M). The default value is
ASI.

Sets the input signal expected
from the ASI/SMPTE Input
connector.

:RECord:QAMVsb:PORT:TYPE? Returns the current input signal
selection.

SYSTEM Commands Use these commands to set or query the system related functions.

Variable name Valid values Description
:SYSTem:COMMunicate:SOCKet:PORT <numeric_value>

You can set the value from 1024
to 65535. When you change
the value, the current network
connection is disconnected.

Sets the port number needed to remotely
control the instrument over an Ethernet
network.

:SYSTem:COMMunicate:SOCKet:PORT? Returns the current port number setting.
:SYSTem:COMMunicate:SOCKet:RXTERM CR|LF

The choices are CR (carriage
return) and LF (linefeed). The
default value is LF.

Sets the terminator used when the
generator receives commands from a
controller.
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Variable name Valid values Description
:SYSTem:COMMunicate:SOCKet:RXTERM? Returns the terminator used when the

RTX100B Series receives commands from
a controller.

:SYSTem:COMMunicate:SOCKet:TXTERM CR|LF|CRLF|LFC

The choices are CR (carriage
return), LF (linefeed), CRLF, and
LFCR. The default value is CRLF.

Sets the terminator used when the
generator sends information to a controller.

:SYSTem:COMMunicate:SOCKet:TXTERM? Returns the terminator used when the
generator sends information to a controller.

:SYSTem:ERRor[:NEXT]? Returns an error message from the
error/event queue. The response format is
as follows:

<error_code>,“<error_message>”
Another section of this manual describes
the error messages. (See page 112, Error
Messages and Codes.)

:SYSTem:KLOCk[:STATe] ON|OFF

You can use 1 or 0 instead of ON
or OFF. The default value is OFF.

Locks or unlocks the front-panel buttons
and mouse operation.

:SYSTem:KLOCk[:STATe]? Returns the current status of the lock
function.

:SYSTem:MODE PLAY|RECord

The choices are PLAY and RECord.
The default value is PLAY.

Sets the operation mode of the instrument.

:SYSTem:MODE? Returns the current operation mode of the
instrument.

:SYSTem:OPTions? Returns the option number, hardware
version, and code version of the installed
interface card.

:SYSTem:PRESet Resets the instrument to the factory default
settings.

:SYSTem:STANdard MPEG|ARIB|ATSC|DVB

The choices are MPEG, ARIB,
ATSC, and DVB. The default value
is ARIB.

Sets the standard used to display the input
stream.
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Variable name Valid values Description
:SYSTem:STANdard? Returns the current standard used to

display the input stream.
:SYSTem:STATus? The available responses are:

0: the instrument stops any
operations
1: the instrument is outputting
a data
2: the instrument is acquiring
a data
3: the instrument is recording
a data

Returns the current operation status of the
instrument.

Optional Commands This subsection describes the commands that are used to control the optional
interface cards. These are available only when the appropriate interface card
is installed into the generator.

Variable name Valid values Description
IP Interface: General Settings
:PLAY:IPAVailable? Returns whether the IP

interface is available.
:PLAY:IPENable ON|OFF

You can use 1 or 0 instead of ON
or OFF.

Enables the IP interface when
set to ON.

:PLAY:IPENable? Returrns whether the IP
interface is enabled.

:PLAY:OPCArdenbl ON|OFF

You can use 1 or 0 instead of ON
or OFF.

Enables the optional card when
set to ON.

:PLAY:OPCArdenbl? Returns whether the optional
card is enabled.

:PLAY:IP:PARAmeters:DEFAult Resets the configuration
settings to the default values.

IP Configuration Settings
:PLAY:IP:PARAmeters:IPLAyrver IPVFOUR|IPVSIX

The choices are IPVFOUR and
IPVSIX. The default value is
IPVFOUR.

Selects the IP player version
for the playout.

:PLAY:IP:PARAmeters:IPLAyrver? Returns the IP player version
of the playout.

:PLAY:IP:PARAmeters:DVCName? Returns the current device
name for the IP playout.
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Variable name Valid values Description
:PLAY:IP:PARAmeters:DVINdex <numeric_value>

You can set the index value from
0 to N–1 where N is the number of
available network interface cards.

Sets the index value of the
network interface card.

:PLAY:IP:PARAmeters:DVINdex? Returns the current index
value of the selected network
interface card.

:PLAY:IP:PARAmeters:TRANsmode UNICAST|MULTICAST|

BROADCAST

The choices are UNICAST,
MULTICAST, and BROADCAST.
The default value is MULTICAST.

Sets the transmission mode of
the protocol.

:PLAY:IP:PARAmeters:TRANsmode? Returns the current
transmission mode of the
protocol.

:PLAY:IP:PARAmeters:PACKetszmode IPPKSZMD|TSPKCTMD

The choices are IPPKSZMD and
TSPKCTMD. The default value is
TSPKCTMD.

Sets the packet size mode for
the IP playout.

:PLAY:IP:PARAmeters:PACKetszmode? Returns the current packet size
mode.

:PLAY:IP:PARAmeters:IPPKtsize <numeric_value>

You can set the IPv4 packet
size from 55–1500 bytes
(TS fragmentation) and from
55–16128 bytes (both TS and IP
fragmentation). The default value
is 1370 bytes.

Sets the size of the IP packet.

:PLAY:IP:PARAmeters:IPPKtsize? Returns the current size of the
IP packet.

:PLAY:IP:PARAmeters:TSPKtcount <numeric_value>

You can set the TS packets
from 1–7 (TS Fragmentation)
and from 1–85 (both TS and IP
fragmentation). The default value
is 7.

Sets the number of TS packets
that needs to be embedded into
an IP packet.

:PLAY:IP:PARAmeters:TSPKtcount? Returns the current number of
TS packets that is embedded
into an IP packet.

:PLAY:IP:PARAmeters:TSFRagment ON|OFF

You can use 1 or 0 instead of ON
or OFF. The default value is OFF.

Allows fragmentation of TS
packets. When set to ON, the
TS packets will be split across
the IP packets.

:PLAY:IP:PARAmeters:TSFRagment? Returns whether to allow
TS fragmentation across IP
packets.
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:PLAY:IP:PARAmeters:IPFRagment ON|OFF

You can use 1 or 0 instead of ON
or OFF. The default value is OFF.

Allows fragmentation of IP
packets. When set to ON, the
IP packets will be fragmented
else they will retain the same
size.

:PLAY:IP:PARAmeters:IPFRagment? Returns whether to allow
IP fragmentation during IP
playout.

:PLAY:IP:PARAmeters:BITRate <numeric_value>

You can set the values from 0.250
Mbps to 250.000 Mbps.

Sets the IP bit rate value for the
playout.

:PLAY:IP:PARAmeters:BITRate? Returns the current value of the
IP bit rate.

Protocol Settings
:PLAY:IP:PARAmeters:PRTOcol

:SETTings:MODE

UDP|RTP

The choices are UDP and RTP.
The default mode is RTP.

Sets the protocol mode for IP
playout.

:PLAY:IP:PARAmeters:PRTOcol

:SETTings:MODE?

Returns the current protocol
mode for IP playout.

:PLAY:IP:PARAmeters:PRTOcol

:SETTings:SRCIpadd

<IP address of the

instrument>

Sets the source IP address for
the IPv4 version of the playout.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:SRCIpadd?
Returns the current value of the
source IP address for the IPv4
version.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:DSTIpadd

<IP address of the

destination>

The default value is 239.1.1.1.

Sets the destination IP address
for the IPv4 version of the
playout.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:DSTIpadd?
Returns the current value of the
destination IP address for the
IPv4 version.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:SRC6ipadd

<IP address of the

instrument>

Sets the source IP address for
the IPv6 version of the playout.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:SRC6ipadd?
Returns the current value of the
source IP address for the IPv6
version.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:DST6ipadd

<IP address of the

destination>

Sets the destination IP address
for the IPv6 version of the
playout.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:DST6ipadd?
Returns the current value of the
destination IP address for the
IPv6 version.
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:PLAY:IP:PARAmeters:PRTOcol:

SETTings:SRCPort

<numeric_value>

You can set the source port value
from 0 to 65535. The default
value is 16384.

Sets the source port for the IP
playout.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:SRCPort?

Returns the current source port
value.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:DSTPort

<numeric_value>

You can set the destination port
value from 0 to 65535. The
default value is 16384.

Sets the destination port value.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:DSTPort?

Returns the current destination
port value.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:VLAN

ON|OFF

You can use 1 or 0 instead of ON
or OFF. The default value is OFF

Enables the VLAN settings.
When set to on, displays
the VLAN parameters in the
Advanced settings screen.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:VLAN?

Returns whether the VLAN
settings is enabled.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:VLNid

<numeric_value>

You can set the values from 0 to
4095. The default value is 1.

Sets the VLAN identification
number to allow the
identification of 4096 VLANs
that is basically used by the
802.1Q standard.

:PLAY:IP:PARAmeters:PRTOcol:

SETTings:VLNid?

Returns the current VLAN
identification number.

Protocol Settings-Advanced Settings
:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet:DESTmac

<string>

The choices are BYTE and
PACKet. For BYTE, valid data is
output using a burst transmission
mode. For PACKet, valid data is
output in each transport stream
packet. The default value is
PACKet.

Sets the output format of the
ASI signal.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet:DESTmac?

Returns the current destination
MAC address of the Ethernet
layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet:SRCEmac

<string> Sets the source MAC address
of the Ethernet layer, where
<string> is of the format
“xx:xx:xx:xx:xx:xx”.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet:SRCEmac?

Returns the current source
MAC address of the Ethernet
layer.
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:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet: PROTocol

<numeric_value>

You can set the values from 0 to
65535. The default value is 2048
which corresponds to IP.

Sets the value of the protocol
field in the Ethernet layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet:PROTocol?
Returns the current value of the
protocol field in the Ethernet
layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet:VLAN:TPID

<string>

You can set the values from 0
to FFFF. The default value is
0X8100.

Sets the TPID value of the
VLAN in the Ethernet layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet:VLAN:TPID?

Returns the current TPID value
of the VLAN.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet:

VLAN:PRIOrity

<numeric_value>

You can set the values from 0 to
7. The default value is 5.

Sets the priority level of the
VLAN in the Ethernet layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet:

VLAN:PRIOrity?

Returns the current priority
value of the VLAN.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet:VLAN:CFI

ON|OFF

The default value is OFF.
Sets the canonical format
indicator for the VLAN. When
set to on (1), non-canonical
MAC is selected.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet:VLAN:CFI?
Returns the current status of
the CFI.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet:VLAN:VID

<numeric_value>

The VID values can range from 0
to 4095. The default value is 1.

Sets the identification for the
VLAN.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:ETHErnet:VLAN:VID?

Returns the current VID value
of the VLAN.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IP:VERSion?

Returns the IP version.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IP:TOS

<numeric_value>

You can set the type of service
value from 0 to 255. The default
value is 0.

Sets the type of service
that indicates the desired
parameters. The parameters
are delay, throughput, and
reliability.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IP:TOS?
Returns the current type of
service.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IP:PROTocol

<numeric_value>

You can set the values from 0 to
255. The default value is 17 which
corresponds to UDP.

Sets the value of the protocol
field in the IP layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IP:PROTocol?
Returns the current value of the
protocol field.
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:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IP:SRCIpadd

<string> Sets the source IP address for
the IP layer, where <string> is of
the format “xx:xx:xx:xx:xx:xx”.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IP:SRCIpadd?

Returns the current source IP
address for the IP layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IP:DSTIpadd

<string> Sets the destination IP
address for the IP layer,
where <string> is of the format
“xx:xx:xx:xx:xx:xx”.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IP:DSTIpadd?

Returns the current destination
IP address for the IP layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IP:HEADerlngth?
Returns the current length of
the IP header.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IP:TOTAllngth?

Returns the current total length
of the IP packet.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IP:TTL

<numeric_value>

You can set the value from 0 to
255. The default value is 5.

Sets the value of Time to Live
in the IP layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IP:TTL?
Returns the current value of
Time to Live in the IP layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:UDP:SRCPort

<numeric_value>

You can set the value from 0
to 65535. The default value is
16384.

Sets the source port value of
the UDP layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:UDP:SRCPort?

Returns the current source port
value of the UDP layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:UDP:DSTPort

<numeric_value>

You can set the value from 0
to 65535. The default value is
16384.

Sets the destination port value
of the UDP layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:UDP:DSTPort?

Returns the current destination
port value of the UDP layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:UDP:LENgth?
Returns the current length of
the UDP packets.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:RTP:VERSion?
Returns the current version of
the RTP.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:RTP:SQNCnumber

<numeric_value>

You can set the value from 0 to
65535.

Sets the first value of the
sequence number field in RTP
header.

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:RTP:SQNCnumber?
Returns the first value of the
sequence number field.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:RTP:SSRC

<numeric_value>

You can set the value from 0 to
65535.

Sets the SSRC value for the
RTP layer.
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:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:RTP:SSRC?
Returns the SSRC value for the
RTP layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:RTP:PYLOadtype

<numeic_value>

You can set the value from 0 to
255. The default value is 33.

Sets the value of the payload
type for the RTP layer.

:PLAY:IP:PARAmeters:PRTOcol
:CUSTomize:HEADers:RTP:PYLOadtype?

Returns the current value of the
payload type for the RTP layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:VERSion?
Returns the version number of
the IPv6 protocol.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:TRFCcls

<numeric_value>

You can set the value from 0 to
255. The default value is 0.

Sets the value of the traffic
class for the IPv6 layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:TRFCcls?
Returns the current value of the
traffic class for the IPv6 layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:FLOWlbl

<numeric_value> Sets the value of the flow label
for the IPv6 layer. The default
value is 0.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:FLOWlbl?
Returns the current value of the
flow label for the IPv6 layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:PYLDlen?
Returns the current value of the
payload length.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:NXTHdr

<numeric_value>

You can set the values from 0 to
255. The default value is 17.

Sets the value of the next
header for the IPv6 layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:NXTHdr?
Returns the current value of the
next header for the IPv6 layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:HOPLimit

<numeric_value>

You can set the value from 0 to
255. The default value is 12.

Sets the value of the hop limit
for the IPv6 layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:HOPLimit?
Returns the current value of the
hop limit for the IPv6 layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:SRCIpadd

<numeric_value> Sets the source address of the
IPv6 layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:SRCIpadd?
Returns the source address of
the IPv6 layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:DSTIpadd

<numeric_value> Sets the destination address of
the IPv6 layer.

:PLAY:IP:PARAmeters:PRTOcol

:CUSTomize:HEADers:IPV6:DSTIpadd?

Returns the destination address
of the IPv6 layer.
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Protocol Settings-Stream Replication Settings
:PLAY:IP:PARAmeters:REPLication:COUNt <numeric_value>

You can set the value from 0 to
65535. The default value is 0.

Sets the number of replications
for a stream.

:PLAY:IP:PARAmeters:REPLication:COUNt? Returns the number of stream
replications.

:PLAY:IP:PARAmeters:REPLication

:INCRement:ETHErnet:SRCMac

<string> Sets the increment value for
the source MAC address,
where <string> is of the format
“xx:xx:xx:xx:xx:xx” and xx is
hexadecimal. The increments
for these addresses can be
specified for each node. The
value of the next node will be
rolled over when the value of
the incremented node reaches
the maximum.

:PLAY:IP:PARAmeters:REPLication

:INCRement:ETHErnet:SRCMac?

Returns the current increment
value of the source MAC
address.

:PLAY:IP:PARAmeters:REPLication

:INCRement:ETHErnet:DSTMac

<string> Sets the increment value for
the destination MAC address,
where <string> is of the format
“xx:xx:xx:xx:xx:xx” and xx is
hexadecimal. The increments
for these addresses can be
specified for each node. The
value of the next node will be
rolled over when the value of
the incremented node reaches
the maximum.

:PLAY:IP:PARAmeters:REPLication

:INCRement:ETHErnet:DSTMac?

Returns the current increment
value of the destination MAC
address.

:PLAY:IP:PARAmeters:REPLication

:INCRement:ETHErnet:EPROtocol

<numeric_value>

You can set the value from 0 to
65535.

Sets the increment value for
the Ethernet protocol.

:PLAY:IP:PARAmeters:REPLication

:INCRement:ETHErnet:EPROtocol?

Returns the current increment
value of the Ethernet protocol.

:PLAY:IP:PARAmeters:REPLication

:INCRement:ETHErnet:VLANid?

Returns the current
identification value of the
VLAN.

:PLAY:IP:PARAmeters:REPLication

:INCRement:ETHErnet:VLANid

<numeric_value> Sets the identification of the
VLAN. The values can range
from 0 to 4095.
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:PLAY:IP:PARAmeters:REPLication

:INCRement:IP:TOS

<numeric_value>

You can set the value from 0 to
255.

Sets the increment value for
the type of service of the IP
protocol.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IP:TOS?

Returns the current increment
value of the type of service.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IP:TTL

<numeric_value>

You can set the value from 0 to
255.

Sets the increment value for
time to live of the IP protocol.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IP:TTL?

Returns the current increment
value of the time to live
attribute.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IP:SRCIpadd

<string> Sets the increment value
for the source IP address,
where <string> is of the format
“xx:xx:xx:xx:xx:xx” and xx is
hexadecimal. The increments
for IP addresses can be
specified for each node. The
value of the next node will be
rolled over when the value of
the incremented node reaches
the maximum.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IP:SRCIpadd?

Returns the current increment
value of the source IP address.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IP:DSTIpadd

<string> Sets the increment value for
the destination IP address,
where <string> is of the format
“xx:xx:xx:xx:xx:xx” and xx is
hexadecimal. The increments
for IP addresses can be
specified for each node. The
value of the next node will be
rolled over when the value of
the incremented node reaches
the maximum.

: PLAY:IP:PARAmeters:REPLication

:INCRement:IP:DSTIpadd?

Returns the current increment
value of destination IP address.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IP:IPROtocol

<numeric_value> Sets the increment value for
the IP protocol. You can set the
value from 0 to 255.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IP:IPROtocol?

Returns the current increment
value of the IP protocol.

:PLAY:IP:PARAmeters:REPLication

:INCRement:UDP:SRCPort

<numeric_value>

You can set the value from 0 to
65535.

Sets the increment value for the
source port of the UDP layer.
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:PLAY:IP:PARAmeters:REPLication

:INCRement:UDP:SRCPort?

Returns the current increment
value of the source port.

:PLAY:IP:PARAmeters:REPLication

:INCRement:UDP:DSTPort

<numeric_value>

You can set the value from 0 to
65535.

Sets the increment value for
the destination port of the UDP
layer.

:PLAY:IP:PARAmeters:REPLication

:INCRement:UDP:DSTPort?

Returns the current increment
value of the destination port.

:PLAY:IP:PARAmeters:REPLication

:INCRement:RTP:PAYLoad

<numeric_value>

You can set the value from 0 to
127.

Sets the increment value for
the payload of the RTP layer.

:PLAY:IP:PARAmeters:REPLication

:INCRement:RTP:PAYLoad?

Returns the current increment
value of the payload.

:PLAY:IP:PARAmeters:REPLication

:INCRement:RTP:SSRC

<numeric_value>

You can set the value from 0 to
65535.

Sets the increment value for
the SSRC of the RTP layer.

:PLAY:IP:PARAmeters:REPLication

:INCRement:RTP:SSRC?

Returns the current increment
value of the SSRC.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IPV6:TRFCcls
You can set the value from 0 to
255. The default value is 0.

Sets the increment value for the
traffic class of the IPv6 layer.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IPV6:TRFCcls?

Returns the current increment
value of the traffic class.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IPV6:FLOWlbl
The default value is 0. Sets the increment value for

the flow label of the IPv6 layer.
:PLAY:IP:PARAmeters:REPLication

:INCRement:IPV6:FLOWlbl?

Returns the current increment
value of the flow label.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IPV6:NXTHdr
You can set the value from 0 to
255. The default value is 17.

Sets the increment value for the
next header of the IPv6 layer.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IPV6:NXTHdr?

Returns the current increment
value of the next header.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IPV6:HOPLimit
You can set the value from 0 to
255. The default value is 12.

Sets the increment value for
the hop limit of the IPv6 layer.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IPV6:HOPLimit?

Returns the current increment
value of the hop limit.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IPV6:SRCIpadd
Sets the increment value for
the source IPv6 address of the
IPv6 layer.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IPV6:SRCIpadd?

Returns the current increment
value of the source IPv6
address.

:PLAY:IP:PARAmeters:REPLication

:INCRement:IPV6:DSTIpadd
The default value is ff0e::1. Sets the increment value for

the destination IPv6 address of
the IPv6 layer.
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:PLAY:IP:PARAmeters:REPLication

:INCRement:IPV6:DSTIpadd?

Returns the current increment
value of the destination IPv6
address.

Error Insertion
:PLAY:IP:ERRIns:ENBLed ON|OFF

You can use 1 or 0 instead of ON
or OFF.

Enables error insertion in real
time when the value is set to
ON.

:PLAY:IP:ERRIns:ENBLed? Returns whether the error
insertion is enabled.

:PLAY:IP:ERRIns:PARAmeters:PLENbled ON|OFF

You can use 1 or 0 instead of ON
or OFF.

Enables packet loss when the
value is set to ON.

:PLAY:IP:ERRIns:PARAmeters:PLENbled? Returns whether the packet
loss is enabled.

:PLAY:IP:ERRIns:PARAmeters:PLVAlue <numeric_value>

You can set the value from 0 to
65535.

Sets the number of packets
that will be dropped.

:PLAY:IP:ERRIns:PARAmeters:PLVAlue? Returns the current number of
dropped packets.

:PLAY:IP:ERRIns:PARAmeters:PLRAnge <numeric_value>

You can set the value from 0 to
65535.

Sets the packet loss range.

:PLAY:IP:ERRIns:PARAmeters:PLRAnge? Returns the current packet loss
range.

:PLAY:IP:ERRIns:PARAmeters:SQEEnbled ON|OFF

You can use 1 or 0 instead of ON
or OFF.

Enables sequence error when
the value is set to ON.

:PLAY:IP:ERRIns:PARAmeters:SQEEnbled? Returns whether the sequence
error is enabled.

:PLAY:IP:ERRIns:PARAmeters:SQEValue <numeric_value>

You can set the value from 0 to
65535.

Sets the frequency value at
which the packets will be
reordered.

:PLAY:IP:ERRIns:PARAmeters:SQEValue? Returns the current frequency
value at which the packets are
reordered.

:PLAY:IP:ERRIns:PARAmeters:SQERange <numeric_value>

You can set the value from 0 to
65535.

Sets the sequence error range.

:PLAY:IP:ERRIns:PARAmeters:SQERange? Returns the current sequence
error range value.

:PLAY:IP:ERRIns:PARAmeters:SQEDistance <numeric_value>

You can set the value from 0 to
65535.

Sets the distance value after
which you want the reordering
to happen.
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:PLAY:IP:ERRIns:PARAmeters:SQEDistance? Returns the current distance

value.
:PLAY:IP:ERRIns:PARAmeters:CSEEnbled ON|OFF

You can use 1 or 0 instead of ON
or OFF.

Enables checksum error when
the value is set to ON.

:PLAY:IP:ERRIns:PARAmeters:CSEEnbled? Returns whether the checksum
error has been enabled.

:PLAY:IP:ERRIns:PARAmeters:CSEType IP|UDP Sets the checksum error type.
The choices are IP and UDP
layer.

:PLAY:IP:ERRIns:PARAmeters:CSEType? Returns the current value of the
checksum error type.

:PLAY:IP:ERRIns:PARAmeters:CSEValue <numeric_value>

You can set the value from 0 to
65535.

Sets the frequency value at
which the checksum error will
be inserted.

:PLAY:IP:ERRIns:PARAmeters:CSEValue? Returns the current frequency
value at which the checksum
errors are inserted.

:PLAY:IP:ERRIns:PARAmeters:CSERange <numeric_value>

You can set the value from 0 to
65535.

Sets the checksum error range.

:PLAY:IP:ERRIns:PARAmeters:CSERange? Returns the current checksum
error range value.

:PLAY:IP:ERRIns:PARAmeters:RANDomizerr ON|OFF

You can use 1 or 0 instead of ON
or OFF.

Sets the error insertion type.
When set to ON, the random
type is enabled.

:PLAY:IP:ERRIns:PARAmeters:RANDomizerr? Returns the current value of the
randomizer.

Error Generation
:PLAY:IP:ERRGen:GPKTlos Generates packet loss by

dropping one packet during the
IP playout.

:PLAY:IP:ERRGen:GSQNerr Generates sequence error
by re-sequencing a packet
with another packet within a
100packet boundary.

:PLAY:IP:ERRGen:GCHIperr Generates a checksum error in
the IP layer.

:PLAY:IP:ERRGen:GCHUdperr Generates a checksum error in
the UDP layer.

Statistics
:PLAY:IP:STATistics:IP:BIRAte? Returns the IP bit rate value for

the play.
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:PLAY:IP:STATistics:IP:BRVAriation? Returns the percentage of IP

bit rate variation from the set
bit rate.

:PLAY:IP:STATistics:IP:BITRAte:MIN? Returns the minimum IP bit rate
value for the play.

:PLAY:IP:STATistics:IP:BITRAte:MINVariation? Returns the minimum variation
value from the set bit rate value.

PLAY:IP:STATistics:IP:BITRAte:MAX? Returns the maximum IP bit
rate value for the play.

:PLAY:IP:STATistics:IP:BITRAte:MAXVariation? Returns the maximum IP bit
rate variation value from the set
bit rate value.

:PLAY:IP:STATistics:IP:BITRAte:AVG? Returns the average bit rate
value for the play.

:PLAY:IP:STATistics:IP:BITRAte:AVGVariation? Returns the average variation
value from the set bit rate value.

:PLAY:IP:STATistics:IP:JITer? Returns the jitter value for the
play.

:PLAY:IP:STATistics:IP:JITTer:MIN? Returns the minimum jitter
value for the play.

:PLAY:IP:STATistics:IP:JITTer:MAX? Returns the maximum jitter
value for the play.

:PLAY:IP:STATistics:IP:JITTer:AVG? Returns the average jitter value
for the play.

:PLAY:IP:STATistics:IP:PKTSize? Returns the IP packet size for
the play.

:PLAY:IP:STATistics:IP:PKTCount? Returns the IP packet count for
the play.

:PLAY:IP:STATistics:IP:BYTRansmited? Returns the number of IP bytes
transmitted during the play.

:PLAY:IP:STATistics:TS:BIRAte? Returns the TS bit rate value
for the play.

:PLAY:IP:STATistics:TS:BRVAriation? Returns the TS bit rate variation
value from the set bit rate value.

:PLAY:IP:STATistics:TS:BITRAte:MIN? Returns the minimum TS bit
rate value for the play.

:PLAY:IP:STATistics:TS:BITRAte:MINVariation? Returns the minimum TS bit
rate variation value from the set
bit rate value.

:PLAY:IP:STATistics:TS:BITRAte:MAX? Returns the maximum TS bit
rate value for the play.

:PLAY:IP:STATistics:TS:BITRAte:MAXVariation? Returns the maximum TS bit
rate variation value from the set
bit rate value.
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:PLAY:IP:STATistics:TS:BITRAte:AVG? Returns the average TS bit rate

value for the play.
:PLAY:IP:STATistics:TS:BITRAte:AVGVariation? Returns the average TS bit rate

variation value from the set bit
rate value.

:PLAY:IP:STATistics:TS:PKTSize? Returns the TS packet size for
the play.

:PLAY:IP:STATistics:TS:PKTCount? Returns the TS packet count
for the play.

:PLAY:IP:STATistics:ERROrs:PKTDropped? Returns the number of packets
dropped during the play.

:PLAY:IP:STATistics:ERROrs:SQNErrs? Returns the number of
sequence errors inserted
during the play.

:PLAY:IP:STATistics:ERROrs:CSIPerrs? Returns the number of IP
checksum errors inserted
during the play.

:PLAY:IP:STATistics:ERROrs:CSUDPerrs? Returns the number of UDP
checksum errors inserted
during the play.

:PLAY:IP:STATistics:REPLication

:IP:BIRAte?
Returns the total IP bit rate of
all the streams.

:PLAY:IP:STATistics:REPLication

:IP:PKTCount?

Returns the total IP packet
count of all the streams.

:PLAY:IP:STATistics:REPLication

:IP:BYTRansmited?

Returns the total bytes
transmitted in all the streams.

:PLAY:IP:STATistics:REPLication

:TS:BIRAte?
Returns the total TS bit rate of
all the streams.

:PLAY:IP:STATistics:REPLication

:TS:PKTCount?
Returns the total count of TS
packets of all the streams.

:PLAY:IP:STATistics:REPLication

:ERROrs:PKTDropped?

Returns the total packets
dropped of all the streams.

:PLAY:IP:STATistics:REPLication

:ERROrs:SQNErrs?
Returns the total number of
sequential errors of all the
streams.

:PLAY:IP:STATistics:REPLication

:ERROrs:CSIPerrs?
Returns the total number of
IP checksum errors of all the
streams.

:PLAY:IP:STATistics:REPLication

:ERROrs:CSUDPerrs?
Returns the total number of
UDP checksum errors of all the
streams.
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Other Settings
:PLAY:IP:OTHSttngs:PROCpriority NORMAL|ABOVE_NORMAL

|HIGHEST|REAL_TIME

The choices are NORMAL,
ABOVE_NORMAL, HIGHEST,
and REAL_TIME. The default
value is REAL_TIME.

Sets the process priority for the
player.

:PLAY:IP:OTHSttngs:THRPriority IDLE|BELOW_NORMAL

|NORMAL|ABOVE_NORMAL

|HIGHEST|REAL_TIMEThe
choices are IDLE,
BELOW_NORMAL, NORMAL,
ABOVE_NORMAL, HIGHEST,
and REAL_TIME.
The default value is NORMAL.

Sets the thread priority for the
player.

:PLAY:IP:OTHSttngs:THRPriority? Returns the current thread
priority value of the play.

Parametric Settings
:PLAY:IP:PRMEtric:BSTEnbled ON|OFF

You can use 1 or 0 instead of ON
or OFF.

Enables the burst mode when
the value is set to ON.

:PLAY:IP:PRMEtric:BSTEnbled? Returns whether the burst
mode has been enabled.

:PLAY:IP:PRMEtric:BSTType BURST_PERIOD|BURST_SIZE

The choices are BURST_PERIOD
and BURST_SIZE. The default is
BURST_PERIOD.

Sets the burst mode for the IP
playout.

:PLAY:IP:PRMEtric:BSTType? Returns the current value of the
burst mode.

:PLAY:IP:PRMEtric:BPERiod <numeric_value>
The value can range from 1 ms to
1000 ms.

Sets the burst period for the IP
playout.

:PLAY:IP:PRMEtric:BPERiod? Returns the current value of the
burst period.

:PLAY:IP:PRMEtric:BSIZE <numeric_value> Sets the burst size for the IP
playout. The values can range
from 1 to 65535.

:PLAY:IP:PRMEtric:BSIZE? Returns the current value of the
burst size.

:PLAY:IP:PRMEtric:JITEnbled ON|OFF

You can use 1 or 0 instead of ON
or OFF.

Enables jitter when the value is
set to ON.

:PLAY:IP:PRMEtric:JITEnbled? Returns whether the jitter has
been enabled.
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:PLAY:IP:PRMEtric:LOWJitmd ON|OFF

You can use 1 or 0 instead of ON
or OFF.

Enables the low jitter mode
when set to ON.

:PLAY:IP:PRMEtric:LOWJitmd? Returns whether the low jitter
mode has been enabled.

:PLAY:IP:PRMEtric:JITType LAPLACE|GAUSSIAN

|SINE|FIXED

The options are LAPLACE,
GAUSSIAN, SINE, and FIXED.
The default value is FIXED.

Sets the jitter type for IP
playout.

:PLAY:IP:PRMEtric:JITType? Returns the current jitter type
for IP playout.

:PLAY:IP:PRMEtric:JITPeriod <numeric_value>

You can set numeric value in
micro seconds for FIXED jitter
type and percentage value for all
the other jitter types.

Sets the jitter period value for
IP playout.

:PLAY:IP:ERRIns:PARAmeters:JITPeriod? Returns the current value of
jitter period for IP playout.

Timestamped TS Playout Settings
:PLAY:IP:TTSSttngs:TTSEnbled ON|OFF

You can use 1 or 0 instead of ON
or OFF. The default value is OFF.

Enables the timestamped TS
(TTS) settings for the playout
when set to ON.

:PLAY:IP:TTSSttngs:TTSEnbled? Returns whether the TTS
settings has been enabled for
the playout.

:PLAY:IP:TTSSttngs:PRSRvts ON|OFF

You can use 1 or 0 instead of ON
or OFF. The default value is to
OFF.

Enables the preservation of the
file that stores the TTS settings.

:PLAY:IP:TTSSttngs:PRSRvts? Returns whether the preserve
TTS settings option is enabled
for the player.

:PLAY:IP:TTSSttngs:TTSJitter:JTREnable ON|OFF

You can use 1 or 0 instead of ON
or OFF. The default value is OFF.

Enables the TTS jitter settings
for the playout.

:PLAY:IP:TTSSttngs:TTSJitter:JTREnable? Returns whether the TTS jitter
settings is enabled for the
playout.
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:PLAY:IP:TTSSttngs:TTSJitter:PATTern SINE|SQUARE

|TRIANGLE|PULSE

|SAW|RANDOM

|OFFSET

The various options are SINE,
SQUARE, TRIANGLE, PULSE,
SAW, RANDOM, and OFFSET.
The default option is SINE.

Sets the TTS jitter pattern for
the playout.

:PLAY:IP:TTSSttngs:TTSJitter:PATTern? Returns the TTS jitter pattern
of the playout.

:PLAY:IP:TTSSttngs:TTSJitter:PERIod <numeric_value>

You cannot set the period for
random and offset jitter patterns.
The default value is 0.

Sets the TTS jitter period for
the playout.

:PLAY:IP:TTSSttngs:TTSJitter:PERIod? Returns the TTS jitter period of
the playout.

:PLAY:IP:TTSSttngs:TTSJitter:AMPLitude <numeric_value>

You can set the amplitude for all
the jitter patterns. The default
value is 0.

Sets the TTS jitter amplitude
for the playout.

:PLAY:IP:TTSSttngs:TTSJitter:AMPLitude? Returns the TTS jitter amplitude
of the playout.

:PLAY:IP:TTSSttngs:TTSJitter:PLSWidth <numeric_value>

You can set the width of only pulse
pattern. The default value is 0.

Sets the TTS jitter pulse width
for the playout.

:PLAY:IP:TTSSttngs:TTSJitter:PLSWidth? Returns the TTS jitter pulse
width of the playout.
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Default Settings
The following table lists the default settings of the remote commands.

These default settings can be set by using the *RST command, except for the
:SYSTem:COMMunicate:SOCKet command settings.

Variable name Default settings
DISPLAY commands
:DISPlay:VIEW:FORMat HEXadecimal

PLAY commands
:PLAY:AUTOplay OFF (0)

:PLAY:CLOCk:DEFault:RATE 5.6610E+001

:PLAY:CLOCkDEFault:RATE:RATIo 629,300

:PLAY:CLOCk:ESRAtefixed OFF (O)

:PLAY:CLOCkISDBT:CONVert ON (1)

:PLAY:CLOCk:RATE 5.6610E+001

:PLAY:CLOCk:RATE:RATIO 0, 0

:PLAY:CLOCk:SOURce INTernal

:PLAY:EXTTrigger:BNC INPUt

:PLAY:EXTTrigger:OUTPut:DELAy 0

:PLAY:EXTTrigger:OUTPut:SELEct C27M

:PLAY:LOOP ON (1)

:PLAY:LOOP:ISDBT:FRAMe ON (1)

:PLAY:PACKet 188

:PLAY:PCR:INACcuracy NONE

:PLAY:PCR:INITial 0, 0

:PLAY:SOURce DISK

:PLAY:SPIOutput ON (1)

:PLAY:SSPOsition:INITial:ENABle ON (1)

:PLAY:SSPOsition:INITial[:POSition] 0

:PLAY:SSPOsition:INITial:TIME 00:00:00

:PLAY:SSPOsition[:POSition] 0, 0

:PLAY:SSPOsition:TIME 00:00:00, 00:00:00

:PLAY:SYNC TSPAcket

:PLAY:SYNC:DVALid:WIDTh NONE

:PLAY:SYNC:PSYNc:INTerval NONE

:PLAY:TIMEpacket:DEFine Current data and time
:PLAY:TIMEpacket:MODE ORIGinal

:PLAY:UPDAte ON (1)

:PLAY:ITEM:CC ON (1)
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:PLAY:ITEM:NPT OFF (1)

:PLAY:ITEM:PCR ON (1)

:PLAY:ITEM:PCR:METHod HARDware

:PLAY:ITEM:REEDsolomon ON (1)

:PLAY:ITEM:TIMEpacket ON (1)

PLAY Commands Specific to RTX130B Generator
:PLAY:QAMVsb:INTerleave 1

:PLAY:QAMVsb:MODulation M64Qam (M8Vsb for ATSC)

:PLAY:QAMVsb:OUTPut:MODE RF

:PLAY:QAMVsb:PORT:THROughout ON (1)

:PLAY:QAMVsb:PORT:TYPE ASI

:PLAY:QAMVsb:RF:FREQuency 50.0 MHz

:PLAY:QAMVsb:RF:LEVEl 45 dBm

:PLAY:QAMVsb:SYMBol:RATE 1.0

PLAY Commands Specific to RTX100B Generator
:PLAY:ISDBT:FREQuency:CHANnel

RECORD commands
:RECord:EXTernal OFF (0)

:RECord:ISDBT:CLOCk:SOURce ASI

:RECord:ISDBT:FREQuency:CHANnel 13

:RECord:SOURce SPI

:RECord:STORe:MODE OVERwrite

:RECord:TARGet:IGNOredvalid OFF (0)

:RECord:TARGet:SIZE 50 [MB}

:RECord:TARGet:TIME 00:00:00

:RECord:TARGet:TRIGger:CONTinuous OFF (0)

:RECord:TARGet:TRIGger:CONTinuous:LIMit 32767

:RECord:TARGet:TRIGger:POSition 0 [%]

:RECord:TARGet:TYPE DISK

:RECord:TARGet:UNLImit OFF (0)

SYSTEM commands
:SYSTem:COMMunicate:SOCKet:PORT 49152

:SYSTem:COMMunicate:SOCKet:RXTERM LF

:SYSTem:COMMunicate:SOCKet:TXTERM CRLF

:SYSTem:KLOCk[:STATe] OFF (0)

:SYSTem:MODE PLAY

:SYSTem:STANdard ARIB

:SYSTem:MODE PLAY

:SYSTem:STANdard ARIB
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Variable name Default settings
Optional commands
IP Interface: General Settings
:PLAY:IPENable OFF

:PLAY:OPCArdenbl ON (1)

:PLAY:IP:PARAmeters:DEFAult No parameters

PLAY:IP:PARAmeters: DVINdex 0

:PLAY:IP:PARAmeters:TRANsmode MULTICAST

:PLAY:IP:PARAmeters:PACKetszmode TSPKTZMODE

:PLAY:IP:PARAmeters:IPPKtsize 1370

:PLAY:IP:PARAmeters:TSPKtcount 7

:PLAY:IP:PARAmeters:TSFRagment OFF (0)

:PLAY:IP:PARAmeters:IPFRagment OFF (0)

:PLAY:IP:PARAmeters:BITRate 28.107902 Mbps

IP Interface: Protocol Settings
:PLAY:IP:PARAmeters:PRTOcol: SETTings:MODE RTP

:PLAY:IP:PARAmeters:PRTOcol: SETTings:SRCIpadd Automatically detected from the

active Network Interface Card

(NIC interface)

:PLAY:IP:PARAmeters:PRTOcol: SETTings:DSTIpadd 239.1.1.1

:PLAY:IP:PARAmeters:PRTOcol: SETTings:SRCPort 16384

:PLAY:IP:PARAmeters:PRTOcol: SETTings:DSTPort 16384

:PLAY:IP:PARAmeters:PRTOcol: SETTings:VLAN OFF

IP Interface: Protocol Settings: Advanced Screen Settings
:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:ETHErnet:DESTmac

01:00:5E:01:01:01

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:ETHErnet:SRCEmac

Automatically detected from the

active Network Interface Card

(NIC interface)

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:ETHErnet:PROTocol

2048

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:ETHErnet:VLAN:TPID

0X8100

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:ETHErnet:VLAN:PRIOrity

5

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:ETHErnet:VLAN:CFI

OFF (0)

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:ETHErnet:VLAN:VID

1

:PLAY:IP:PARAmeters:PRTOcol: CUSTomize:HEADers:IP:TOS 0

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:IP:PROTocol

17

108 RTX100B Series RF Signal Generators



Default Settings

Variable name Default settings
:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:IP:SRCIpadd

Automatically detected from the

active Network Interface Card

(NIC interface)

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:IP:DSTIpadd

239.1.1.1

:PLAY:IP:PARAmeters:PRTOcol: CUSTomize:HEADers:IP:TTL 5

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:UDP:SRCPort

16384

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:UDP:DSTPort

16384

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:RTP:SQNCnumber

Randomly generated

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:RTP:SSRC

Randomly generated

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:RTP:PYLOadtype

33

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:IPV6:VERSion

6

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:IPV6:TRFCcls

0

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:IPV6:FLOWlbl

0

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:IPV6:PYLDlen

1336

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:IPV6:NXTHdr

17

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:IPV6:HOPLimit

12

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:IPV6:SRCIpadd

Automatically detected from the

active Network Interface Card

(NIC interface)

:PLAY:IP:PARAmeters:PRTOcol:

CUSTomize:HEADers:IPV6:DSTIpadd

ff0e::1

IP Interface: Protocol Settings: Stream Replication Settings
:PLAY:IP:PARAmeters:REPLication:COUNt 0

:PLAY:IP:PARAmeters:REPLication:

INCRemet:ETHErnet:SRCMac

00:00:00:00:00:00

:PLAY:IP:PARAmeters:REPLication:

INCRement:ETHErnet:DSTMac

00:00:00:00:00:00

:PLAY:IP:PARAmeters:REPLication:

INCRement:ETHErnet:EPROtocol

0

:PLAY:IP:PARAmeters:REPLication:

INCRement:ETHErnet:VLANid

0

:RECord:I1394I:PARTialts ON (1)
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:PLAY:IP:PARAmeters:REPLication: INCRement:IP:TOS 0

:PLAY:IP:PARAmeters:REPLication: INCRement:IP:TTL 0

:PLAY:IP:PARAmeters:REPLication: INCRement:IP:SRCIpadd 0.0.0.0

:PLAY:IP:PARAmeters:REPLication: INCRement:IP:DSTIpadd 0.0.0.0

:PLAY:IP:PARAmeters:REPLication: INCRement:IP:IPROtocol 0

:PLAY:IP:PARAmeters:REPLication: INCRement:UDP:SRCPort 0

:PLAY:IP:PARAmeters:REPLication: INCRement:UDP:DSTPort 0

:PLAY:IP:PARAmeters:REPLication: INCRement:RTP:PAYLoad 0

:PLAY:IP:PARAmeters:REPLication: INCRement:RTP:SSRC 0

:PLAY:IP:PARAmeters:REPLication: INCRement:IPV6:TRFCcls 0

:PLAY:IP:PARAmeters:REPLication: INCRement:IPV6:FLOWlbl 0

:PLAY:IP:PARAmeters:REPLication: INCRement:IPV6:NXTHdr 0

:PLAY:IP:PARAmeters:REPLication: INCRement:IPV6:HOPLimit 0

:PLAY:IP:PARAmeters:REPLication: INCRement:IPV6:SRCIpadd 0:0:0:0:0:0:0:0

:PLAY:IP:PARAmeters:REPLication: INCRement:IPV6:DSTIpadd 0:0:0:0:0:0:0:0

IP:Error Insertion
:PLAY:IP:ERRIns:ENBLed OFF (0)

:PLAY:IP:ERRIns:PARAmeters:PLENbled OFF (0)

:PLAY:IP:ERRIns:PARAmeters:PLVAlue 1

:PLAY:IP:ERRIns:PARAmeters:PLRAnge 1000

:PLAY:IP:ERRIns:PARAmeters:SQEEnbled OFF (0)

:PLAY:IP:ERRIns:PARAmeters:SQEValue 1

:PLAY:IP:ERRIns:PARAmeters:SQERange 1000

:PLAY:IP:ERRIns:PARAmeters:SQEDistance 1

:PLAY:IP:ERRIns:PARAmeters:CSEEnbled OFF (0)

:PLAY:IP:ERRIns:PARAmeters:CSEType IP

:PLAY:IP:ERRIns:PARAmeters:CSEValue 1

:PLAY:IP:ERRIns:PARAmeters:CSERange 1000

:PLAY:IP:ERRIns:PARAmeters:RANDomizerr ON (1)

IP:Error Generation
:PLAY:IP:ERRGen:GPKTlos No parameters

:PLAY:IP:ERRGen:GSQNerr No parameters

:PLAY:IP:ERRGen:GCHIperr No parameters

:PLAY:IP:ERRGen:GCHUdperr No parameters

IP:Parametric Settings
:PLAY:IP:OTHSttngs:PROCpriority ABOVE_NORMAL

:PLAY:IP:OTHSttngs:THRPriority REAL_TIME

:PLAY:IP:PRMEtric:BSTEnbled OFF (0)
:PLAY:IP:PRMEtric:BSTType BURST PERIOD

:PLAY:IP:PRMEtric:BPERiod 2 MS
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:PLAY:IP:PRMEtric:BSIZe 10

:PLAY:IP:PRMEtric:JITEnbled OFF (0)

:PLAY:IP:PRMEtric:LOWJitmd OFF (0)

:PLAY:IP:PRMEtric:JITType FIXED

:PLAY:IP:PRMEtric:JITPeriod 1.000000 μs

IP:Timestamped TS Playout Settings
:PLAY:IP:TTSSttngs:TTSEnbled OFF (0)

:PLAY:IP:TTSSttngs:PRSRvts OFF (0)

:PLAY:IP:TTSSttngs:TTSJitter:JTREnable OFF (0)

:PLAY:IP:TTSSttngs:TTSJitter:PATTern SINE

:PLAY:IP:TTSSttngs:TTSJitter:PERIod 0

:PLAY:IP:TTSSttngs:TTSJitter:AMPLitude 0

:PLAY:IP:TTSSttngs:TTSJitter:PLSWidth 0
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Error Messages and Codes
This section lists the error messages and codes.

Error messages and codes can be obtained by using the query
:SYSTem:ERRor[:NEXT]?. These are returned in the following format:

<error_code>,"<error_message>"

Command Errors
Command errors are returned when there is a syntax error in the command.

Table 27: Command errors
Error code Error message
–100 command error
–101 invalid character
–102 syntax error
–103 invalid separator
–104 data type error
–105 GET not allowed
–108 parameter not allowed
–109 missing parameter
–110 command header error
–111 header separator error
–112 program mnemonic too long
–113 undefined header
–114 header suffix out of range
–120 numeric data error
–121 invalid character in numeric
–123 exponent too large
–124 too many digits
–128 numeric data not allowed
–130 suffix error
–131 invalid suffix
–134 suffix too long
–138 suffix not allowed
–140 character data error
–141 invalid character data
–144 character data too long
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Table 27: Command errors (cont.)

Error code Error message
–148 character data not allowed
–150 string data error
–151 invalid string data
–158 string data not allowed
–160 block data error
–161 invalid block data
–168 block data not allowed
–170 command expression error
–171 invalid expression
–178 expression data not allowed
–180 macro error
–181 invalid outside macro definition
–183 invalid inside macro definition
–184 macro parameter error

Execution Errors
These error codes are returned when an error is detected while a command is
being executed.

Table 28: Execution errors
Error code Error message
–200 execution error
–201 invalid while in local
–202 settings lost due to RTL
–210 trigger error
–211 trigger ignored
–212 arm ignored
–213 init ignored
–214 trigger deadlock
–215 arm deadlock
–220 parameter error
–221 settings conflict
–222 data out of range
–223 too much data
–224 illegal parameter value
–225 out of memory
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Table 28: Execution errors (cont.)

Error code Error message
–226 lists not same length
–230 data corrupt or stale
–231 data questionable
–240 hardware error
–241 hardware missing
–250 mass storage error
–251 missing mass storage
–252 missing media
–253 corrupt media
–254 media full
–255 directory full
–256 FileName not found
–257 FileName error
–258 media protected
–260 execution expression error
–261 math error in expression
–270 execution macro error
–271 macro syntax error
–272 macro execution error
–273 illegal macro label
–274 execution macro parameter error
–275 macro definition too long
–276 macro recursion error
–277 macro redefinition not allowed
–278 macro header not found
–280 program error
–281 cannot create program
–282 illegal program name
–283 illegal variable name
–284 program currently running
–285 program syntax error
–286 program runtime error
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Device Specific Errors
These error codes are returned when an internal instrument error is detected. This
type of error may indicate a hardware problem.

Table 29: Device specific errors
Error code Error message
–300 device specific error
–310 system error
–311 memory error
–312 PUD memory lost
–313 calibration memory lost
–314 save/recall memory lost
–315 configuration memory lost
–330 self test failed
–350 queue overflow

Query Errors
These error codes are returned in response to an unanswered query.

Table 30: Query errors
Error code Error message
–400 query error
–410 query interrupted
–420 query unterminated
–430 query deadlocked
–440 query unterminated after indefinite period
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Network Interface Specifications
The generator supports remote control using the Ethernet interface. This section
describes the generator network interface specifications.

The TCP/IP is used as the network protocol. The commands can be sent from the
application program through the socket interface of the TCP/IP. Also, the query
can be received through the interface.

Keep the following in mind while controlling the generator remotely with the
Ethernet interface.

The LF (linefeed) or CR (carriage return) code is needed at the end of
a message as a terminator. Use the Communication dialog box or the
:SYSTem:COMMunicate:SOCKet:RXTERM command to set which
terminator is used. (See Figure 19.)

The IEEE 488.1 standard (for instance Device Clear or Service Request)
is not supported.

The Message Exchange Control Protocol in the IEEE 488.2 is not supported.
However, the common commands such as *ESE and the event handling
features are supported.

The Indefinite format (the block start at #0) in the <ARBITRARY BLOCK
PROGRAM DATA> of the IEEE 488.2 is not supported.

Checking Remote Command Operation
To check remote command operation of the generator, perform the following steps:

1. Connect the generator to your PC using an Ethernet cable.

2. Click the Windows Start button and select Run from the start menu. The Run
dialog box appears as shown. (See Figure 28.)

Figure 28: Run dialog box
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3. In the Open text box, type telnet and then click OK. The Telnet window
appears. (See Figure 29.)

Figure 29: Telnet window

4. At the command line prompt, type set local_echo and press the Enter
key. This sets the local echo mode to on.

5. At the command line prompt, type open <host name> <port number>

and press the Enter key.

Where <host name> is a computer name of the generator to be connected
and <port number> is the port number set in the Communication dialog box
(default value: 49152).

6. At the command line prompt, type *IDN? and press the Enter key.

7. Check that the following ID information of the generator appears:

TEKTRONIX, RTX100B Series, Vx.xx, Hxx, Cxx
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Appendix A: Recommended Settings for MPEG Player in IP
Mode

This appendix lists the recommended settings that are required to improve the
performance of the MPEG player in IP mode.

NOTE. For optimum performance of the MPEG player, you can run the batch file
Optimum_Performance_Settings.bat. To reset the NIC settings to default, you
can run the batch file Reset_NIC_Settings.bat. The batch files are available at
C:\Program Files\Tektronix\MpegPlayer.

Settings for Intel(R) Pro/1000 MT Drivers
Perform the following steps to set the options for Intel/Pro 1000 MT drivers in
Category/Classic view:

1. Click Control Panel > Network and Internet Connections > Network
Connections in Category view or click Control Panel > Network
Connections in Classic view.

2. Select Intel(R) Pro/1000 MT Network Connection device and right-click to
select the Properties option.

3. Click Configure > Advanced to set the following options in the dialog box:

Adaptive Inter-Frame Spacing: Disabled

Flow Control: Off

Interrupt Moderation Rate: Off

Jumbo Frames: 16128

Link Speed and Duplex: Auto-negotiate 1000Mbps

Receive Descriptors: 2048
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Figure 30: Intel(R) PRO/1000 MT Network Connection Properties
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Settings for Playout Performance
Perform the following steps to set the options of Administrative tools for improved
performance during the Playout:

1. Click Control Panel > Administrative Tools > Services in Classic view.

2. SelectWindows Firewall/Internet Connection Sharing (ICS) to open the
dialog box. Stop the service and select Disabled from the Startup Mode list
to disable the startup.

Figure 31: Windows Firewall/Internet Connection Sharing (ICS)
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3. Select Automatic Updates to open the dialog box. Stop the service and select
Disabled from the Startup Mode list to disable the startup.

Figure 32: Automatic Updates Properties
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4. Select IIS admin to open the dialog box. Stop the service and select Disabled
from the Startup Mode list to disable the startup.

Figure 33: IIS Admin Properties
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Settings for Java Update
Perform the following steps to disable the automatic Java updates:

1. Click Control Panel > Java.

2. Select the Update tab and clear the Check for Updates Automatically check
box.

Figure 34: Java Control Panel

A Java warning message is displayed. Click Never Check to not check the
updates.

Figure 35: Java Update-Warning
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Settings for VLAN
Perform the following steps to set the options for VLAN:

1. Click Start > Run and type regedit. Press OK to display the Registry Editor
Window.

2. Browse to HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\
Control\Class\{4D36E972–E325–11CE-BFC1–08002BE10318}\00XX
where XX is the instance of the network adapter that you need to see tags
on. You can check by opening and viewing the driver descriptor value
(DriverDesc value should be Intel(R) PRO/1000 MT Network Connection).

Figure 36: Registry Editor

3. Right-click to select New > DWORD Value or select Edit > DWORD Value
option. Rename the option to MonitorModeEnabled.
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4. Double-click the DWORD Value to open the Edit DWORD Value dialog
box. Set the Value data to 1 and press OK.

Figure 37: Edit DWORD Value
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Appendix B: Using the ReMux Application
ReMux provides the capability to create a transport stream of super frame
structure defined in the ISDB-S system from an MPEG-2 transport stream.

This appendix describes the functions of the ReMux application and shows how
to create a transport stream of super frame structure.

NOTE. The ReMux application cannot handle files larger than 2 GB.

Starting and Exiting ReMux
The ReMux application is preinstalled on the generator. To start the ReMux
application, select Start >Programs >Tektronix >MPEG > ReMux from the
Windows desktop.

If you create a shortcut icon for the Remux application on the Windows desktop,
you can start the ReMux application by double-clicking the icon. Refer to the
Windows help for information about how to create a shortcut icon.

To exit (quit) the ReMux application, select File > Exit.
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Elements of the ReMux Window
The following figure and table describe the elements in the ReMux application
window.

Figure 38: ReMux application window

Table 31: Elements of the ReMux window
Element Description
Title bar The Title bar displays the name of the application and contains the

standard window-sizing boxes for Windows.
Menu bar The Menu bar displays the names of the six drop-down menus. (See

page 130, Using the ReMux Menus.)
Toolbar The toolbar provides shortcut buttons for many of the most often used

menu commands. (See Table 32.) Click a toolbar button to select the
corresponding command. You can toggle the toolbar display on and
off using the Toolbar command in the View drop-down menu.
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Table 31: Elements of the ReMux window (cont.)

Element Description
Welcome to ReMux
Application dialog
box

Use this dialog box to select the operation mode.

ReMux to M-TMCC TS: Create a transport stream of M-TMCC
structure from a transport stream.

ReMux to M-TMCC TS from S-TMCC TS: Create a transport
stream of M-TMCC structure from a transport stream of S-TMCC
structure.

Make S-TMCC TS: Creates a transport stream of S-TMCC
structure from a transport stream.

DeMux M-TMCC TS: De-multiplexes (separates) the original
transport stream from a transport stream of M-TMCC structure.

Open an existing Configuration File: Opens a stored
configuration file (.cfg).

Open your last edited File: Opens the file used last (configuration
file or transport stream file).

You can toggle the dialog box display on or off using the OPTION
dialog box.

Status bar The status bar displays a short explanation of the currently selected
command and information related to the operation. You can toggle
the status bar display on and off using the Status Bar command in
the View drop-down menu.

Table 32: Toolbar button descriptions
Icon Name Function

New Equivalent to the New command in the File menu.

Open Equivalent to the Open command in the File
menu.

Save Equivalent to the Save command in the File menu.

Add Equivalent to the Add command in the Edit menu.

Delete Equivalent to the Delete command in the Edit
menu.

First Equivalent to the First command in the Edit menu.

Previous Equivalent to the Previous command in the Edit
menu.
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Table 32: Toolbar button descriptions (cont.)

Icon Name Function
Next Equivalent to the Next command in the Edit menu.

Last Equivalent to the Last command in the Edit menu.

Execute Equivalent to the Execute command in the ReMux
menu.

ReMux to M-TMCC TS Equivalent to the Mode: ReMux to M-TMCC TS
command in the ReMux menu.

ReMux to M-TMCC TS
from S-TMCC TS

Equivalent to the Mode: ReMux to M-TMCC TS
from S-TMCC TS command in the ReMux menu.

Make S-TMCC TS Equivalent to the Mode: Make S-TMCC TS
command in the ReMux menu.

DeMux to M-TMCC TS Equivalent to the Mode: DeMux to M-TMCC TS
command in the ReMux menu.

Using the ReMux Menus
The Menu bar has six drop-down menus: File, Edit, View, ReMux, Window, and
Help. This section describes the function of each selection in these menus.

File Menu The File menu contains commands for managing file operations and for exiting
the ReMux application. (See Table 33.)

Table 33: ReMux File menu commands
Command Function
New Opens the Select Remux Mode dialog box where you can select the

mode to execute. (See page 131, Select Remux Mode Dialog Box.)
Open Opens a saved configuration file or a transport stream file of M-TMCC

structure. If you try to open other files, an error message appears.
Close Closes the active window.
Save Saves the active window settings to a configuration file.
Save as Saves the active window settings to the specified configuration file.
Exit Exits the ReMux application.
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Select Remux Mode Dialog Box. The Select Remux Mode dialog box appears after
you select the New command in the File menu. (See Figure 39.) Select one of the
ReMux modes, and then click the OK button.

Figure 39: Select Remux Mode dialog box

ReMux to M-TMCC TS: Creates a transport stream of M-TMCC structure
from a transport stream.

ReMux to M-TMCC TS from S-TMCC TS: Creates a transport stream of
M-TMCC structure from a transport stream of S-TMCC structure.

Make S-TMCC TS: Creates a transport stream of S-TMCC structure from a
transport stream.

Edit Menu The Edit menu contains commands that control TMCC information display and
add/delete TMCC information and transport stream. (See Table 34.)

Table 34: ReMux File menu commands
Command Function
Previous Displays the previous TMCC information.
Next Displays the next TMCC information.
First Displays the first TMCC information.
Last Displays the last TMCC information.
Add Adds TMCC information or a transport stream.
Delete Deletes TMCC information or a transport stream.
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ReMux Menu The ReMux menu contains commands that execute the selected operation, select a
ReMux mode, and select option settings. (See Table 35.)

Table 35: ReMux menu commands
Command Function
Execute Executes the ReMux or DeMux operation.
Mode Selects a ReMux mode. This command has the same function as the

New command in the File menu.
Option Opens the OPTION dialog box where you can set the TS ID of the

transport stream(s) inserted as a dummy and toggle the Welcome
dialog box display on or off. (See page 132, OPTION Dialog Box.)

OPTION Dialog Box. The OPTION dialog box appears after you select the Option
command in the ReMux menu. (See Figure 40.)

Figure 40: OPTION dialog box

In the dialog box, you can set the following parameters:

Dummy TSID: When you select ReMux to M-TMCC TS or ReMux to
M-TMCC TS from S-TMCC mode, if the number of slots of the transport
stream of M-TMCC structure is less than 48, dummy transport streams
are inserted automatically so that the number of slots is equal to 48. This
parameter sets the transport stream ID for all of them.

Show “Welcome” Window: Sets whether or not the Welcome to ReMux
Application dialog box appears when you start the ReMux application.

Window Menu The Window menu contains commands that control the appearance of the editing
windows and open the new window. (See Table 36.)

Table 36: ReMux Window menu commands
Command Function
New Window Opens the new window with the same settings as those of the active

window.
Cascade Arranges the editing windows so that they overlap each other.
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Table 36: ReMux Window menu commands (cont.)

Command Function
Tile Arranges the editing windows so that they do not overlap each other.
Arrange Icons When the editing windows are minimized, arranges their title bars.

View Menu The View menu contains commands that control the appearance of the ReMux
application window. (See Table 37.)

Table 37: ReMux View menu commands
Command Function
Toolbar Toggles the display of the Toolbar on and off in the application

window. A check mark precedes the command in the menu when the
Toolbar is selected for display.

Status Bar Toggles the display of the Status bar on and off in the application
window. A check mark precedes the command in the menu when the
Status bar is selected for display.

Help Menu The About ReMux command displays information including the ReMux software
version number and copyright information.

ReMux Tutorials
This subsection describes the basics of operating the ReMux application.

Make S-TMCC TS Mode This mode allows you to create a transport stream of S-TMCC structure from a
transport stream.
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This subsection describes the procedure to create a transport stream of S-TMCC
structure from a transport stream.

1. Select File > New or click the New button on the toolbar to open the Select
Remux Mode dialog box. (See Figure 39.)

2. SelectMake S-TMCC TS in the dialog box, and then click the OK button to
open the editing window for the Make S-TMCC TS mode. (See Figure 41.)

Figure 41: Editing window for the Make S-TMCC TS mode

The information displayed to the right of the TMCC icon has the following
meaning:

Selecting a Transport Stream File.

3. Select Edit > Add or click the + (Add) button on the toolbar to open the
Open dialog box.

4. In the dialog box, select a transport stream file, and click the Open button to
open the Edit TS Information dialog box. (See Figure 42.)
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Figure 42: Edit TS Information dialog box

In this dialog box, you can set the following parameters:

File: Specify the transport stream file that has to be converted to a
transport stream file of S-TMCC structure.

Data Rate: Specify the data rate of the transport stream. You cannot
set the value exceeding the data rate of the effective slots. If this value
is less than the data rate of the effective slot, the data rate is converted
by inserting null packets.

Contract Slots: Shows the number of contract slots. This value depends
on the number of slots set in the Modulation item.

Modulation: Specify the modulation system and the number of slots to be
assigned to HQ and LQ when performing hierarchical data transfer.

HQ: Specify the modulation system and the number of slots to be
assigned to HQ level.

LQ: Specify the modulation system and the number of slots to be
assigned to LQ level. This field is enabled only when the hierarchical
control descriptor exists in PMT.

TS ID: Specify the transport stream ID. This value is used to change the
ID value in TMCC, and the ID value in PAT is not changed.
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Initial Delay: Specify the number of delay packets (null packets) to be
inserted at the start of remultiplex. You can set the value in the range of
0 to 65535.

5. After you change the parameters, click the OK button to confirm the changes
and close the dialog box.

This displays a transport stream icon under the TMCC icon. (See Figure 43.)

Figure 43: Windows displaying a transport stream icon

The information displayed to the right of the transport stream icon has the
following meaning:
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Editing the TMCC Information for the Transport Stream.

6. Double-click the TMCC icon to open the Edit TMCC Information dialog box
to edit the TMCC information for the transport stream. (See Figure 44.)

Figure 44: Edit TMCC Information dialog box (S-TMCC)

In this dialog box, you can set the following parameters:

Transmitter/Receiver Control Information: Set the
transmission/receiving control information.

Switch On Control Signal: Set the start control signal to on (1) or
off (0).

Reserve: Set the reserve bit.

7. After you change the parameters, click the OK button to confirm the changes
and close the dialog box.

Creating a Transport Stream of S-TMCC Structure.

8. Select ReMux > Execute or click the► (Execute) button to open the Save
As dialog box.

9. In the dialog box, specify a file name and click the Save button.
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ReMux to M-TMCC TS from
S-TMCC TS Mode

This mode allows you to create a transport stream of M-TMCC structure from a
transport stream of S-TMCC structure.

This subsection describes the procedure to create a transport stream of M-TMCC
structure from a transport stream of S-TMCC structure.

1. Select File > New or click the New button on the toolbar to open the Select
Remux Mode dialog box. (See Figure 39.)

2. Select ReMux to M-TMCC TS from S-TMCC TS in the dialog box, and
click the OK button to open the editing window for the ReMux to M-TMCC
TS from S-TMCC TS mode. (See Figure 45.)

Figure 45: Editing window for the ReMux to M-TMCC TS from S-TMCC TS mode

Selecting a Transport Stream File.

3. Select Edit > Add or click the + (Add) button on the toolbar to open the
Open dialog box.

4. In the dialog box, select a transport stream file of S-TMCC structure, and click
the Open button to open the Edit TS Information dialog box. (See Figure 42.)

NOTE. If you select a transport stream file that does not have S-TMCC structure,
an error message appears.

5. In the dialog box, set the parameters, and click the OK button. This displays a
transport stream icon in the window.

Multiplexing Transport Streams. In the ReMux to M-TMCC TS from S-TMCC
TS mode, you can multiplex transport streams of S-TMCC structure until the
total number of slots reaches 48.
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6. Select Edit > Add or click the + (Add) button on the toolbar to open the
Open dialog box.

7. In the dialog box, select a transport stream file of S-TMCC structure, and click
the Open button to open the Edit TS Information dialog box. (See Figure 42.)

8. In the dialog box, set the parameters, and click the OK button.

This multiplexes the newly selected transport stream and the transport stream
icon is added in the window. (See Figure 46.)

Figure 46: Transport stream is multiplexed

9. If you want to multiplex more transport streams, repeat steps 3 through 8.
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Editing the TMCC Information for the Transport Stream.

10. Double-click the TMCC icon to open the Edit TMCC Information dialog box
to edit the TMCC information for the transport stream. (See Figure 47.)

Figure 47: Edit TMCC Information dialog box (M-TMCC)

In this dialog box, you can set the following parameters:

Order of Change: Set the TMCC change instruction. You can set the
value in the range of 0 to 31.

Transmitter/Receiver Control Information: Set the
transmission/receiving control information.

Switch On Control Signal: Set the control signal on (1) or off (0).

Up-Link Control: Enter the Up-Link Control value.

Extended Information: Set the extended information. When you set the
Flag (extension flag) item to 1, the Field item becomes active.

11. After you change the parameters, click the OK button to confirm the changes
and close the dialog box.
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Creating a Transport Stream of M-TMCC Structure.

12. Select ReMux > Execute or click the► (Execute) button to open the Save
As dialog box.

13. In the dialog box, specify a file name, and click the Save button.

If the number of slots of M-TMCC structure transport stream is less than 48,
one or more dummy streams are inserted so that the number of slots equal 48.
The transport stream has the ID value set in the OPTION dialog box and
TS8PSK is used as the modulation system. (See Figure 40.)

Multiplexing Transport Streams of M-TMCC Structure with Different TMCC
Information. In the ReMux to M-TMCC TS from S-TMCC TS mode, you can
multiplex a transport stream of M-TMCC structure with a transport stream of
M-TMCC structure having different TMCC information.

14. Click the TMCC icon of the M-TMCC stream created in step 13.

15. Select Edit > Add or click the + (Add) button on the toolbar to open the Add
TMCC dialog box. (See Figure 48.)

Figure 48: Add TMCC dialog box

In this dialog box, you can specify the transport stream to which the new TMCC
information is inserted if more than one transport stream is multiplexed.

This illustration shows the placement of the new TMCC information and the
transport stream 3 when they are multiplexed after the transport stream 1. The
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new TMCC information is inserted two frames before the location in which the
new transport stream is inserted.

16. In the Add TMCC dialog box, select a transport stream number, and click the
OK button to open the Edit TMCC Information dialog box. Edit the TMCC
information. (See Figure 47.)

17. After you change the parameters, click the OK button to confirm the changes
and close the dialog box.

This opens a new editing window with a TMCC icon displayed. In this case,
note the increase of the value indicating change instruction at the right side of
the TMCC icon. In addition, the First and Previous buttons on the toolbar
change to green indicating that a TMCC exists before this TMCC.

18. Repeat steps 3 through 5 to select a transport stream file.

19. Repeat steps 6 through 8 to multiplex the transport stream file.

20. If you want to further multiplex a transport stream(s) of M-TMCC structure
having different TMCC information, repeat steps 14 through 19.

Creating a Transport Stream of M-TMCC Structure.

21. Select ReMux > Execute or click the► (Execute) button to open the Save
As dialog box.

22. In the dialog box, specify a file name, and then click the Save button.

If the number of slots of the M-TMCC structure transport stream is less than
48, one or more dummy streams are inserted so that the number of slots equal
48. The transport stream thus inserted has the ID value set in the OPTION
dialog box. (See Figure 40 on page 132.)

ReMux to M-TMCC TS
Mode

This mode allows you to create a transport stream of M-TMCC structure from a
transport stream. In this mode, two Remux functions are simultaneously executed:
the Make S-TMCC TS and the ReMux to M-TMCC TS from S-TMCC TS mode.
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This subsection describes the procedure to create a transport stream of M-TMCC
structure from a transport stream.

1. Select File > New or click the New button on the toolbar to open the Select
Remux Mode dialog box. (See Figure 39.)

2. SelectReMux to M-TMCC in the dialog box, and then click theOK button to
open the edit window for the ReMux to M-TMCC TS mode. (See Figure 49.)

Figure 49: Editing window for the ReMux to M-TMCC TS mode

Selecting a Transport Stream File.

1. Select Edit > Add or click the + (Add) button on the toolbar to open the
Open dialog box.

2. In the dialog box, select a transport stream file, and click the Open button to
open the Edit TS Information dialog box. (See Figure 42 on page 135.)

3. In the dialog box, set the parameters, and click the OK button. This will
display a transport stream icon in the window.

Multiplexing Transport Streams. Perform steps 6 through 9 of the previous
procedure. (See page 138, Multiplexing Transport Streams.)

Editing the TMCC Information for M-TMCC. Perform steps 10 and 11 of the
previous procedure. (See page 140, Editing the TMCC Information for the
Transport Stream.)

Multiplexing Transport Streams of M-TMCC Structure with Different TMCC
Information. Perform steps 14 through 20 of the previous procedure. (See
page 141, Multiplexing Transport Streams of M-TMCC Structure with Different
TMCC Information.)
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Creating a Transport Stream of M-TMCC Structure. Perform steps 21 and 22 of the
previous procedure. (See page 142, Creating a Transport Stream of M-TMCC
Structure.)

DeMux M-TMCC TS Mode This mode allows you to demultiplex (separate) the original transport stream from
a transport stream of M-TMCC structure. The resulting demultiplexed transport
stream is converted to a bit rate packet form of 204 bytes.

This subsection describes the procedure to demultiplex the original transport
stream from a transport stream of M-TMCC structure.

1. Select ReMux > DeMux or click the DeMux M-TMCC TS button on the
toolbar to open the Open dialog box.

2. In the dialog box, select a transport stream file of M-TMCC structure, and
then click the Open button to open the editing window for the DeMux
M-TMCC TS mode. (See Figure 50.)

Figure 50: Editing window for the DeMux M-TMCC TS mode

NOTE. If you select a transport stream file that does not have M-TMCC structure,
an error message appears.

3. Select ReMux > Execute or click the► (Execute) button to open the
DEMUX dialog box. (See Figure 51.)
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Figure 51: DEMUX dialog box

In this dialog box, you can set the following parameters:

Select Folder: Specify the directory to which the demultiplexed transport
stream is to be saved.

TS: Select the transport stream(s) to be demultiplexed. Click the check
box at the front of the file name to select the file to be demultiplexed.
When you click the ... button to the right of the file name, the Save As
dialog box appears, where you can specify a file name and save the file.

4. After you select the directory and transport stream(s), click the OK button.
The transport stream(s) will be demultiplexed and saved to the directory.
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The Scheduler is a software application that provides scheduling capability for
the generator. The application enables you to create a schedule list of streams
for subsequent play or record.

This appendix describes the functions of the Scheduler application and how to
create a schedule list, play, and record streams within the list.

Starting and Exiting Scheduler
To start the Scheduler application on the generator, select File > Scheduler in the
Play or Record screen.

In the Play screen: Starts Scheduler in the schedule play mode. This mode
allows you to create a schedule list and play streams.

In the Record screen: Starts Scheduler in the schedule record mode. This
mode allows you to create a schedule list and record streams.

To exit (quit) the Scheduler application, select File > Exit or click the Close
button in the upper-right corner of the application window.

Elements of the Scheduler Application Window
The Scheduler application window contains a title bar, a menu bar, a toolbar, a
status/control panel, a schedule list, and a status bar. (See Figure 52.)
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Figure 52: Scheduler application window (schedule play mode)

Title Bar The title bar displays the file name of the currently selected schedule list and
the name of the application. It also contains the standard window-sizing boxes
for Windows.

Menu Bar The menu bar displays the names of the drop-down menus. (See page 150, Using
the Scheduler Menus.)

Toolbar The Toolbar provides shortcut buttons for many of the most often used menu
commands. Click a toolbar button to select the corresponding command. You can
toggle the toolbar display on and off using the Toolbar commands in the View
drop-down menu. (See Table 38.)

Table 38: Toolbar button descriptions
Icon Name Function

New Equivalent to the New command in the File menu.

Open Equivalent to the Open command in the File menu.

148 RTX100B Series RF Signal Generators



Appendix C: Using the Scheduler Application (Option SC Only)

Table 38: Toolbar button descriptions (cont.)

Icon Name Function
Save Equivalent to the Save command in the File menu.

Add Equivalent to the Add command in the Stream menu.

Delete Equivalent to the Delete command in the Stream menu.

Move up Equivalent to the Move Up command in the Stream
menu.

Move down Equivalent to the Move Down command in the Stream
menu.

Properties Equivalent to the Properties command in the Stream
menu.

Play Equivalent to the Play command in the Schedule menu.

Record Equivalent to the Record command in the Schedule
menu.

Execute Equivalent to the Execute command in the Schedule
menu.

Connect Equivalent to the Connect command in the Schedule
menu.

Status/Control Panel The status/control panel appears when you select the Execute command from the
Schedule menu or click the Execute button on the toolbar. This panel allows
you to set properties for the whole schedule list, and start/stop stream playout or
record. (See page 161, Status/Control Panel.)

Schedule List Lists the streams currently included in the schedule. The schedule list is composed
of the following items:

Schedule icon: The following icons are displayed in front of the file name:

Icon Description
This icon shows that no start time or triggered start has been specified for the
stream.

This icon shows that the start time has been specified for the stream.
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Icon Description
This icon shows that a triggered start has been specified for the stream.

These icons change depending on the Start Time option setting in the Play
Properties or the Record Properties dialog box. (See Figure 55 on page 156.)
(See Figure 57 on page 160.)

Filename: Shows the file name of the stream.

Packets: Shows the number of packets contained in the stream (For a Non-TS
stream, it shows the number of bytes). This item does not appear in the
schedule record mode.

Start time: Shows the start date/time for the stream.

End time: Shows the end date/time for the stream.

Duration: Shows the duration time of the stream.

To select a stream, click the stream name. Only one stream can be selected at a
time.

When you start playing or recording streams, the background of the schedule list
changes to gray, and the stream currently being played or recorded is highlighted.

Status Bar The status bar displays a short explanation of the currently selected command and
information related to the operation. You can toggle the status bar display on and
off using the Status Bar command in the View drop-down menu.

Using the Scheduler Menus
The Menu bar displays the names of the five pull-down menus. This section
describes the function of each selection in these menus.

File Menu The File menu contains commands for managing file operations and for exiting
the Scheduler application. (See Table 39.)

Table 39: File menu commands
Command Function
New Opens a new (blank) schedule.
Open Opens the Open dialog box where you can select a schedule list

file (*.sch).
Save Saves the currently selected schedule list.
Save As Opens the Save As dialog box where you can save the currently

selected schedule list.
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Table 39: File menu commands (cont.)

Command Function
1 xxx.sch
...
4 xxx.sch

Lists up to four of the most recently opened schedule list files. When
you select a file name, the schedule opens.

Exit Exits the application.

View Menu The View menu contains commands that control the appearance of the application
window. (See Table 40.)

Table 40: View menu commands
Command Function
Show message Opens the Show error message dialog box that lists all errors that

have occurred in the generator.
Toolbar Toggles the display of the Toolbar on and off in the application

window. A check mark precedes the command in the menu when
the toolbar is selected for display.

Status Bar Toggles the display of the Status bar on and off in the application
window. A check mark precedes the command in the menu when the
status bar is selected for display.

Schedule Menu The Schedule menu contains commands that control the remote connection to the
generator and changes between the play mode and record mode. (See Table 41.)

Table 41: Schedule menu commands
Command Function
Connect Opens the MTX/RTX Host Name dialog box. (See page 152,

MTX/RTX Host Name Dialog Box.)
Disconnect Closes the connection to the generator.
Play Sets the schedule play mode.
Record Sets the schedule record mode.
Settings Opens the Scheduler Settings dialog box. (See page 152, Scheduler

Settings Dialog Box.)
Execute Displays the status/control panel in the application window. (See

page 161, Status/Control Panel.)

RTX100B Series RF Signal Generators 151



Appendix C: Using the Scheduler Application (Option SC Only)

MTX/RTX Host Name Dialog Box. When you select the Connect command from the
Schedule menu, the MTX/RTX Host Name dialog box appears. (See Figure 53.)

Figure 53: MTX/RTX Host Name dialog box

You can select the host name generator to which the Scheduler is connected.

Scheduler Settings Dialog Box. When you select the Settings command from the
Schedule menu, the Scheduler Settings dialog box appears. (See Figure 54.)

Figure 54: Scheduler Settings dialog box

The Schedule Settings dialog box has three tabs: New Schedule, Add Stream,
and Miscellaneous.
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New Schedule tab

Continuous Time Stamping: Specify the parameters in the transport
stream that should be modified when looping a transport stream to simulate
continuous playout. After selecting the Enabled check box, select the
appropriate parameter(s) you intend to modify. The parameters are updated
by the system hardware (27 MHz clock).

Playout Packet Size: When you select the Auto playout packet size check
box, the default packet size displayed is derived from the first stream added to
the schedule list. However, if the first stream in the schedule list is a Non-TS
stream, the packet size of subsequent streams is set to 188 bytes.

If you clear the Auto playout packet size check box, the Set button becomes
available. When you click the Set button, the Set Custom Clock dialog box
appears. In this dialog box, you can set the appropriate packet size.

Default Data Rate: Set the default bit rate.

Packet Size: Set the default packet size. You can select 188, 204, and 208.

Playout Data Rate: Set the playout bit rate for the overall schedule.

Use automatic playout data rate: Uses the bit rate derived from the first
stream in the schedule list.

Manually specify a playout data rate: Uses a clock source and bit rate
that you specify. When you select this option, the Clk Source list box and
the Set button become available. Use the Clk Source list box to select a
clock source for the stream playout. You can select Internal, ExtRef 10M,
ExtRef 27 M, ExtRef IFFT, Ext P Clk, or Ext S Clk. When you click the
Set button, the Set Custom Clock dialog box appears. In this dialog box,
you can set the appropriate bit rate.

Seamless Play: Set whether the streams in the schedule list are played
continuously. Normally, stream output stops at every file, changing points if
each stream has different bit rate. When this option is checked, all the streams
are played using the same bit rate set by the Playout Bitrate options.
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NOTE. You cannot play a Non-TS or M-TMCC stream(s) using the Seamless
Play mode.

Before you play streams that have different packet sizes using the Seamless Play
mode, clear the Enabled check box in the Continuous Time Stamping field.

If you play streams that have different bit rates using the Seamless Play mode, the
Fixed ES Rate setting in the generator does not work properly.

Add Stream tab

Playout Properties: Set the default playout properties (bit rate and packet
size) to be used when a stream is added to a schedule list.

from Schedule: Uses the settings in the dialog box.

from Source: Uses the default bit rate and packet size derived from the
original stream.

Custom: Uses the custom bit rate and packet size set in the tab. When
you select this option, the Set Custom Clock dialog box appears.

Miscellaneous tab

Loop Mode: Set whether the schedule is run in the loop mode. When this
option is checked, the current schedule is restarted when it reaches the end
of the last stream.

NOTE. You cannot use the loop mode if the stream has a time or triggered start
specified in a schedule list.

Local lock out: Set whether the front-panel lockout function is enabled or
not. When it is checked, all front-panel buttons are disabled.

Port: Set the port number of the generator to which Scheduler is connected.
The default value is 49152.
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Stream Menu The Stream menu contains commands to add, delete, and move a stream in the
schedule list. It also contains the command to view and set the stream properties
of the currently selected stream. (See Table 42.)

Table 42: Stream menu commands
Command Function
Move up Moves the currently selected stream one position up in the schedule

list. If the stream is currently at the top of the list, this command
has no effect.

Move down Moves the currently selected stream one position down in the
schedule list. If the stream is currently at the bottom of the list, this
command has no effect.

Add For the schedule play mode: Opens the Open dialog box where
you can select a stream to be added to the schedule list.

For the schedule record mode: Opens the Save as dialog box
where you can specify a path and file name for the stream file to
be recorded. (See page 159, Save as Dialog Box.)

Delete Deletes the currently selected stream from the schedule list.
Properties For the schedule play mode: Opens the Play Properties dialog

box for the selected stream. (See page 156, Play Properties
Dialog Box.)

For the schedule record mode: Opens the Record Properties
dialog box for the selected stream. (See page 160, Record
Properties Dialog Box.)
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Play Properties Dialog Box. If Scheduler is set to the schedule play mode, when
you select the Properties command from the Stream menu, the Play Properties
dialog box appears. (See Figure 55.) This dialog box allows you to display the
properties for the selected stream, and set the start/stop position and the start time
of the stream. This dialog box can be displayed by selecting Properties from the
right-click menu or by double-clicking the stream name.

Figure 55: Play Properties dialog box

File: Shows the name and location of the stream.

Content: Shows the content of the stream.

File Size: Shows the file size of the stream in bytes.

Standard: Shows the standard of the stream (MPEG-2, ARIB, DVB,
ATSC, S-TMCC, M-TMCC, ISDB-T, or NON-TS).

Data Rate: Shows the bit rate derived from the PCRs in the stream.

Duration: Shows the duration of the stream.

Packet Size: Shows the packet size of the stream. For a Non-TS file,
a dash is displayed.

Total Packets: Shows the total number of the packets in the stream. For a
Non-TS file, a dash is displayed.
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Start/Stop Position: Set the start and stop positions of the stream. When
you click the Set button, the Start/Stop Position dialog box allows you to set
the start/stop position.

Start: Set the start position of the stream by the number of packets (the
number of super frames for an M-TMCC file, or the number of bytes for
a Non-TS file).

Stop: Set the stop position of the stream by the number of packets (the
number of super frames for an M-TMCC file, or the number of bytes for
a Non-TS file).

Play: Shows the actual number of packets (the number of super frames
for an M-TMCC file, or the number of bytes for a Non-TS file) that is
calculated using the Start and Stop values.

Format: Shows the unit of the start and stop positions of the stream.
It shows Packets for a transport stream file, SF (super frame) for an
M-TMCC file, and Bytes for a Non-TS file.

For an ISDB-T file, the start packet is defined as the first-appearing packet
including an OFDM frame start flag after the specified start position.
The stop packet is defined as the packet before the last-appearing packet
including an OFDM frame start flag before the specified stop position. At
this time, if the number of OFDM frames between the start packet and
stop packet is not an even number, the packet in the last OFDM frame
becomes the stop packet.

First, specify the format for the setting in the Format list box at the bottom
of the dialog box. Click the Start or Stop option button, and set the number
of packets or time using the slider. You can directly enter the desired
values in the text boxes.

Start Time: Specify the time at which the stream will start to play within a
schedule. If the Seamless Play option is selected in the Schedule Settings
dialog box, this field is disabled.
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NOTE. If the trigger does not occur within a specified time, the subsequent stream
will be played out.

NONE: The stream is integrated into the schedule and obeys the overall
timing of the schedule. It will follow on from the previous stream without
a break in the playout bit stream.

Trigger Rise: The stream playout starts on the rising edge (low to high
transition) of the trigger signal applied to the Trig In/Out connector.
When you select this option, the spin boxes used to set date and time
are available.

Trigger Fall: The stream playout starts on the falling edge (high to low
transition) of the trigger signal applied to the Trig In/Out connector.
When you select this option, the spin boxes used to set date and time
are available.

TIME: The stream playout starts at an absolute time. When you select
this option, spin boxes to set date and time become available.

Playout Properties: Set the playout bit rate and packet size of the stream.
If the Seamless Play option is selected in the Schedule Settings dialog box,
this field is disabled.

from Schedule: Uses the values from the Schedule Settings dialog box.
(See Figure 54.)

from Source: Uses the original bit rate and packet size of the stream.

Custom: Uses the bit rate and packet size specified in the Play Properties
dialog box. When you select this option, the Set button becomes available.
Click the Set button, and then set the appropriate bit rate and packet size
in the resulting Set Custom Clock dialog box.
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Save as Dialog Box. If the Scheduler is set to the schedule record mode, when
you select the Add command from the Stream menu, the Save as dialog box
appears. (See Figure 56.)

Figure 56: Save as dialog box

Use this dialog box to do the following:

1. Select the appropriate drive and directory for the stream file you are going
to record.

2. Specify a file name for the stream. You can use the default file name that is
automatically displayed in the File name text box. Do not use the following
characters in a file name: \ / : , ; * ? ” < > |.

3. Click the Save button to add the stream file to a schedule list.

When you click the Save button, the Record Properties dialog box appears.
(See page 160, Record Properties Dialog Box.)
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Record Properties Dialog Box. If Scheduler is set to the schedule record mode,
when you select the Add command from the Stream menu and click the Save
button on the Save as dialog box, the Record Properties dialog box appears. (See
Figure 57.) This dialog box allows you to set the start time, record time, and stop
time for the stream to be recorded. This dialog box can be displayed by selecting
Properties from the right-click menu, the Stream menu, or by double-clicking
the stream name.

Figure 57: Record Properties dialog box

File: Shows the directory path and file name for the stream to be recorded.

Start Time: Specifies the time at which a stream will start to record. The
choices are:

NONE: The stream is integrated into the schedule and obeys the overall
timing of the schedule. It will follow on from the previous stream without
a break.

Trigger Rise: The stream record starts on the rising edge (low to high
transition) of the trigger signal applied to the Trig In/Out connector. When
you select this option, spin boxes to set date and time become available.

Trigger Fall: The stream record starts on the falling edge (high to low
transition) of the trigger signal applied to the Trig In/Out connector. When
you select this option, spin boxes to set date and time become available.

NOTE. If the trigger does not occur within a specified time, the subsequent
stream will be recorded.

TIME: The stream record starts at an absolute time. When you select this
option, spin boxes to set date and time become available.
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Recording Time: Specifies the recording time for the stream.

Stop Time: Specifies the time at which a stream will stop recording. When
you click the down arrow (▼) to the right side of the date spin box, a calendar
allows you to set a date.

Help Menu The About Scheduler command displays information including the Scheduler
software version number and the copyright information.

Status/Control Panel
The status/control panel appears when you select the Execute command from the
Schedule menu or click the Execute button on the toolbar. (See Figure 58.) This
panel allows you to set properties for the whole schedule list. You can start and
stop the stream playing and recording.

Figure 58: Status/control panel (schedule play mode)

1. Control buttons. Controls the schedule play, schedule record, and application
window display.

Button Description
Play button: Starts the schedule playing. This button is displayed in the
schedule play mode.

Record button: Starts the schedule recording. This button is displayed in the
schedule record mode.

Stop button: Stops the schedule playing or recording.

Schedule list button: Closes the status control panel.

2. Stream information. Shows the file name, bit rate, and packet size of the
stream currently being played or recorded.
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3. Playout or record status. Shows the following time information:

Current: Shows the current date and time.

Elapsed: Shows the elapsed time from the start of the stream being
played or recorded.

4. Property button. Displays the Schedule Property dialog box. (See Figure 59.)

Figure 59: Schedule Property dialog box

Activate Schedule: Sets the way in which the schedule is activated. The
setting in this field affects the Start Time setting of a stream at the top of
the schedule list.

Immediate: In the schedule play mode, the schedule playing starts as
soon as you click the Play button in the status/control panel. In the
schedule record mode, the schedule recording starts as soon as you click
the Record button in the status/control panel.

Trigger Rise: The schedule playing or recording starts on the rising edge
(low to high transition) of the trigger signal applied to the Trig In/Out
connector. When you select this option, spin boxes to set date and time
become available.

Trigger Fall: The schedule playing or recording starts on the falling edge
(high to low transition) of the trigger signal applied to the Trig In/Out
connector. When you select this option, spin boxes to set date and time
become available.

NOTE. If the trigger does not occur within a specified time, the subsequent
stream will be played out or recorded.

TIME: The schedule playing or recording starts by an absolute starting
time. When you select this option, spin boxes to set date and time become
available.
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Start Options: Set the actual time when the schedule starts.

Top of Schedule: The schedule playing or recording starts with the first
stream in the schedule list.

Skip to Selection: The schedule playing or recording starts at the
currently highlighted stream. If no stream is highlighted, the schedule will
start at the top of the schedule list. This option is available only when you
select Immediate in the Active Schedule field.

Resynchronize Start: The start time of the first stream is adjusted to
equal to the current time (the first stream must have an absolute Start
Time specified). This option is available only when you select Immediate
in the Active Schedule field.

Stop Time: Set the way in which the schedule stops playing or recording.

NONE: The schedule plays or records according to the start and stop
times of each stream.

Schedule: The schedule playing or recording stops at the specified date
and time but not until the current (schedule) pass is completed. When you
select this option, the spin boxes used to set date and time are available.

Stream: The schedule playing or recording stops at the specified date and
time but not until the current stream is completed. When you select this
option, the spin boxes used to set date and time are available.

Absolute: The schedule playing or recording stops immediately at the
specified date and time. When you select this option, the spin boxes used
to set date and time are available.

Scheduler Tutorials
This section describes the basics of operating the Scheduler application. The
application has the following two operating modes:

Schedule play mode

Schedule record mode

Schedule Play Mode The schedule play mode allows you to create a schedule list of streams (defined
playout properties) and playout up to 256 streams continuously. You can set the
start and stop positions, absolute start time, bit rate, and packet size as playout
properties for each stream.
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In the schedule play mode, you can play five kinds of stream files:

Transport stream (188/204/208) file

S-TMCC file

M-TMCC file

ISDB-T file

Non-TS file

Creating a Schedule List. Perform the following procedure to create a schedule
list and play streams:

1. Select Schedule > Play or click the Play button on the toolbar to set Scheduler
to the schedule play mode.

2. Select Schedule > Settings to open the Scheduler Settings dialog box. (See
Figure 54.)

3. In the New Schedule tab, set parameters to be updated, playout packet size,
and playout bit rate. You can also set whether or not the streams in the
schedule list are played continuously.

4. Click the Add Stream tab.

5. In the Add Stream tab, set the playout properties used when a stream is
added to the schedule.

6. Click theMiscellaneous tab.

7. In theMiscellaneous tab, set the loop mode, the local lock out status, and
the port number. The port number needs to be the same port number as the
generator.

8. Click the OK button to confirm the changes and close the dialog box.

9. Select Stream > Add or click the Add button on the toolbar to open the Open
dialog box.

10. In the Open dialog box, select a file to be added to the schedule list and click
the Open button.
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11. Repeat steps 9 and 10 until all the stream files you want to play are added to
the schedule list. You can add up to 256 files in a single schedule.

12. Select Schedule > Execute or click the Execute button on the toolbar to
open the status/control panel.

13. Click the Property button on the panel to open the Schedule Property dialog
box. (See Figure 59.)

14. In the Schedule Property dialog box, set conditions to activate, start, and
stop the schedule.

15. If you want to set properties for an individual stream, use the following
methods to open the Play Properties dialog box. (See Figure 55.)

Highlight the stream name you want to set (by clicking the name on the
schedule list), and then select Properties from the Stream menu.

Double-click the stream name you want to set.

Right-click the stream name you want to set, and select Properties from
the pop-up menu.

16. In the Play Properties dialog box, set the start/stop positions, start time,
and playout properties for the stream.

Schedule Playout Timing Schedule playout timing is determined by the Active Schedule setting in the
Schedule Property dialog box and the Start Time setting in the Play Properties
dialog box.

When you add a stream to a new schedule list with no Active Schedule
date/time set, the Start Time is set to the current date/time. The start times of
streams subsequently added to the schedule list are cumulative.

If you set an Active Schedule date/time (for example, 2005/2/12 12:00:00) in
the Schedule Property dialog box, this is applied to all streams.
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If you set a Start Time (for example, 2005/2/10 15:00:00) in the Play
Properties dialog box for an individual stream, the start date/time of all
subsequent streams are changed. This does not affect the preceding streams.

NOTE. If there is an inconsistent time setting between the Schedule Property and
Play Properties dialog boxes or between two streams, an error message appears.

Saving a Schedule List. Perform either of the following methods to save the
schedule list:

Select >Save > File menu to save a new schedule list or save an existing
schedule list.

Select > Save As > File menu to save a schedule list under a different name.

Playing Streams. Click the Play button (►) on the status/control panel to start
the schedule.

Schedule Record Mode The schedule record mode allows you to create a schedule list for stream files to
be recorded and to record an input stream continuously on the hard disk drive of
the generator. You can set record properties for each stream, and record up to
256 stream files.
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Creating a Schedule List. Perform the following procedure to create a schedule
list and record streams.

1. Select Schedule > Record or click the Record button on the toolbar to set the
schedule record mode.

2. Select Stream > Add or click the Add button on the toolbar to open the Save
as dialog box. (See Figure 56 on page 159.)

3. In the Save as dialog box, specify the appropriate drive, directory, and file
name for the stream file to be recorded. You can use the default file name that
is automatically displayed in the file name text box.

4. Click the Save button to open the Record Properties dialog box. (See
Figure 57 on page 160.)

5. In the Record Properties dialog box, set the start time and stop time (or
recording time) for the stream.

6. Repeat steps 2 through 5 for all the files that you want to record.

7. Select Schedule > Execute or click the Execute button on the toolbar to
open the status/control panel.

8. Click the Property button on the panel to open the Schedule Property dialog
box. (See Figure 59 on page 162.)

9. In the Schedule Property dialog box, set conditions to activate, start, and
stop the schedule.

Schedule Record Timing. Schedule record timing is determined by the Active
Schedule setting in the Schedule Property dialog box and the Start Time setting
in the Record Properties dialog box. Set the timing using the same method as
described in Schedule Playout Timing. (See page 165.)

Recording Streams. Click the Record button (●) on the status/control panel to
start the schedule.
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NOTE. You cannot change a property in the schedule while a schedule is running.

If you try to run a schedule after the assigned time, an error message appears. If
this happens, change the Start Time setting of the corresponding stream(s).

If you continuously output streams that have different bit rates, the instrument
requires the start and end times to accumulate a certain amount of data in FIFO
and output the last data from FIFO to output each stream in a specific bit rate.
Therefore, the actual start and end times of streams are slightly different from the
displayed Start and End times in a schedule list.

Any discontinuity may be caused by streams that have different playout properties.

If you output streams from the SMPTE 310 interface (Option 07), set the bit rate
to 19.392658 Mbps and set the packet size to 188 bytes.

In the schedule record mode, the Without Limit feature of the generator is
automatically set to On.
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The generator displays the following messages when fragmentation occurs and
data output or data record rate is slower than the specified characteristics.

FIFO is underflow (when data is being output)

FIFO is overflow (when data is being acquired)

If this condition happens, you need to optimize the hard disk drive by performing
the Disk Defragmenter of Windows XP. This appendix provides instructions on
how to defragment the hard disk drive.

Procedure
Perform the following procedure to defragment the hard disk drive:

1. Connect the keyboard and mouse provided with the instrument to the USB
port on the front panel.

2. Select File > Exit in the Play or Record screen to exit the generator
application.

3. Select Programs > Accessories > System Tools > Disk Defragmenter from
the Start menu. The Disk Defragmenter window appears. (See Figure 60.)

Figure 60: Disk Defragmenter window

4. Click Local Disk (D:).
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5. Click the Defragment button to start the defragmentation. When the
defragmentation is completed, the Defragmentation Complete dialog box
appears. (See Figure 61.)

Figure 61: Defragmentation Complete dialog box

6. Click the Close button.

7. Click the Close button at the upper right of the screen to close the Disk
Defragmenter window.
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If the generator does not start or is corrupted, you can recover the system software
by using this recovery procedure.

CAUTION. Running the recovery procedure overwrites all the contents of the hard
disk drive and resets the system to the factory defaults.

The recovery can be performed in two ways:

Recover Boot Partition: This permanently overwrites the contents of your
boot partition. This mode of recovery is preferred if you want to keep your
old data files on the D drive.

Recover Entire Disk: This permanently overwrites the contents of your entire
hard disk drive and resets the system to the factory defaults.

Recovery Procedure
Perform the following procedure to recover the Windows XP and generator
application software:

1. Restart your system and press the F5 key as soon as the BIOS tests are
complete. This opens the Acronis image tool screen with the following
options:

Restore

Windows

2. Click Restore System > Yes. ClickWindows if you want to keep your
current configuration intact.

The “skipped probe” messages are normal and can be ignored. Acronis is
gathering information on your hardware.

CAUTION. Do not power off the system after the recovery process is initiated.
Cancelling the process will leave your hard disk drive in a partially recovered,
unstable state. Immediately after the data is recovered, the system will let you
know that the recovery was successful. On selecting OK, the instrument restarts
and the Windows XP setup wizard is displayed. You will need to install the latest
version of the software that is available for your instrument.

NOTE. The software that is already in the instrument must be reinstalled after
the Operating System is restored, because the software is no longer available
in the system.
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ACTS (Advanced Communications Technologies and Services)

A set of telecommunication research projects financed by the European Union.

ARIB

Association of Radio Industries and Businesses.

ATSC

Advanced Television Systems Committee.

BAT (Bouquet Association Table)

One of the tables defined by DVB-SI. The BAT provides information
regarding bouquets (collections of services marketed as a single entity). DVB
only.

CAT (Conditional Access Table)

One of the PSI tables described by the MPEG-2 standard. The CAT provides
the association between one or more CA systems, their EMM (Entitlement
Management Message) streams, and any special parameters associated with
them.

CRC (Cyclic Redundancy Check)

One of the fields described in the MPEG-2 standard. CRC is used to verify
the correctness of data in PSI and SI tables.

Defragmentation

The process of rewriting parts of a file to contiguous sectors on a hard disk
to increase the speed of access and retrieval. When files are updated, the
computer tends to save these updates on the largest continuous space on the
hard disk, which is often on a different sector than the other parts of the
file. When files are thus “fragmented,” the computer must search the hard
disk each time the file is accessed to find all of the file’s parts, which slows
down response time.

DVB (Digital Video Broadcast)

A project group of the European Broadcasting Union (EBU).

DVB-MG

Digital Video Broadcasting - Measurement Guidelines.
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DVB-SI (Digital Video Broadcast Service Information)

The DVB-SI adds the information that enables DVB IRDs to automatically
tune to particular services and allows services to be grouped into categories
with relevant schedule information. It has several tables, including: NIT,
SDT, BAT, and EIT. (NIT is also required for MPEG-2.)

DTS (Decoding Time-Stamp)

One of the fields described in the MPEG-2 standard. The DTS may be present
in a PES packet header that indicates the time that an access unit is decoded in
the T-STD.

ECM (Entitlement Control Message)

Private conditional access information that specifies control words and
possibly other, typically stream-specific, scrambling and/or control
parameters.

EISA (Extended Industry Standard Architecture)

The PC bus used to communicate with the CARB and PIA boards.

EIT (Event Information Table)

One of the tables defined by DVB-SI. The EIT contains data concerning
events (a grouping of elementary broadcast data streams with a defined start
and end time belonging to a common service) and programs (a concatenation
of one or more events under the control of a broadcaster, such as event name,
start time, and duration).

EMM (Entitlement Management Message)

Private conditional access information that identifies the authorization levels
or the services of specific decoders.

ETS (European Telecommunication Standard)

One of the types of documents released by ETSI.

ETSI

European Telecommunications Standards Institute.

ETR (ETSI Technical Report)

One of the types of documents released by ETSI.

IP

Internet Protocol.
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IRD (Integrated Receiver/Decoder)

A receiving decoder that can automatically configure itself using the MPEG-2
Program Specific Information (PSI).

ISDB-T (Integrated Services Digital Broadcasting-Terrestrial)

The Japanese broadcasting standard developed by ARIB. In ISDB-T, the
television, radio, and data services are covered by one standard.

ISO (International Standard Organization)

Organization responsible for establishing standards at the world-wide level.

MPEG-2

A standard developed by MPEG (Moving Picture Experts Group) for the
compression of digital video.

NIT (Network Information Table)

One of the PSI tables described by the MPEG-2 standard and also one
of the tables defined by DVB-SI. The NIT conveys information relating
to the physical organization of the multiplex; that is, transport streams
carried through a given network and the characteristics of the network itself.
Transport streams are identified by the combination of an original network ID
and a transport stream ID in the NIT.

PAT (Program Association Table)

One of the PSI tables described in the MPEG-2 standard. The PAT provides
information about the structure of a transport stream.

PCR (Program Clock Reference)

One of the fields defined in the MPEG-2 standard. A time stamp in the
transport stream from which decoder timing is derived.

PES (Packetized Elementary Stream)

A structure defined in the MPEG-2 standard used to carry elementary stream
data.

PID (Packet IDentifier)

One of the fields described in the MPEG-2 standard. A unique integer value
used to identify elementary streams of a program in a single or multiprogram
TS.

PMT (Program Map Table)

One of the PSI tables described by the MPEG-2 standard. The PMT identifies
and indicates the locations of the streams that make up each service and the
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location of the Program Clock Reference (PCR) fields for a service. This
table is transmitted in sections.

PSI (Program Specific Information)

A set of tables described by the MPEG-2 standard. The PSI contains all of the
tables that define the MPEG-2 transport stream. It consists of the PAT, PMT,
CAT, and NIT tables. (NIT is also used for DVB-SI).

PSIP

Program and System Information Protocol.

PTS (Presentation Time Stamp)

One of the fields described in the MPEG-2 standard. The PTS may be present
in a PES packet header that indicates the time that a presentation unit is
presented in the T-STD.

RST (Running Status Table)

One of the tables defined by DVB-SI. The RST gives a quick updating
mechanism for the status information carried in the EIT.

SDT (Service Description Table)

One of the tables defined by DVB-SI. The SDT contains data describing the
services in the system. Examples include names of services and the service
provider.

SI (Service Information)

Set of tables defined by DVB-SI. The SI provides information on services
and events carried by different Multiplexes, and even other networks. SI is
structured as six tables (PAT, NIT, CAT, SDT, EIT, and BAT). The applications
are only concerned with NIT, BAT, SDT, and EIT.

ST (Stuffing Table)

One of the tables defined by DVB-SI. The ST provides stuffing sections.

TDT (Time & Date Table)

One of the tables defined by DVB-SI. The TDT carries the current time and
date information.

TOT (Time Offset Table)

One of the tables defined by DVB-SI. The TOT gives information about a
local time offset in a given area.
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TS (Transport Stream)

A bit stream that contains 0 or more elementary streams combined in a
manner that conforms to the MPEG-2 standard.

T-STD (Transport Stream System Target Decoder)

Described by the MPEG-2 standard, the T-STD is a hypothetical reference
model of a decoding process used to define the semantics of a TS.

VLAN

Virtual Local Area Network.
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